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0003 1. Übersicht

Leistungsmerkmale
Neuer CMOS-Bildsensor für 
36×24 mm Vollformat

Unterstützt Bilderfassung mit Auflösungen bis zu 
6048 × 4032 Pixel.* Durch Wechseln des Imager-
Modus kann das Gerät viele Aufzeichnungsformate 
nativ unterstützen, darunter Super 35 24,3 × 
12,8 mm, Auflösung 4096 × 2160 Pixel (äquivalent 
zu 3-Loch-Film) und 4:3 anamorphotisches* 
Super 35 24,3 × 18,3 mm, Auflösung 4096 × 3024 
(äquivalent zu 4-Loch-Film).
*	 Vollformat- und anamorphotischer Modus erfordern 

separat erhältliche Lizenzen.

Großer Dynamikumfang

Das Gerät unterstützt 15+ Stopps im 
Dynamikumfang. Hierzu gehören Einstellungen 
mit sehr geringem Rauschen für überwältigende 
Bilder bei Bedingungen von sengendem 
Sonnenlicht bis hin zu fast völliger Dunkelheit, 
wodurch eine kreative Freiheit bei der Abstufung 
wie nie zuvor ermöglicht wird.

Erfassung mit großem Farbraum

Es können Bilder in einem Farbraum erfasst 
werden, der über DCI-P3 hinausgeht. Bei der 
Verwendung der Farbräume S-Gamut und 
S-Gamut3.Cine von Sony zusammen mit S-Log3 
wird der Freiheitsgrad bei der Abstufung 
bedeutend verbessert.

Dualbasis-ISO

Das Gerät unterstützt zwei auswählbare eigene 
ISO-Einstellungen (ISO500 und ISO2500). Indem 
Sie bei normalen Beleuchtungsbedingungen 
Base ISO500 und unter schlechten 
Beleuchtungsbedingungen Base ISO2500 
verwenden, können Sie einen ausgewogenen 
Belichtungsspielraum zwischen hellen und 
dunklen Bedingungen ohne Granulierung 
(Rauschen) beim Aufnehmen beibehalten.

PL-Objektivfassung

Das Gerät ist mit der PL-Objektivfassung 
nach Industriestandard ausgestattet. Die 
Objektivfassung unterstützt Cooke /i-Technologie, 
und die Objektivdaten werden als Metadaten für 
jedes Einzelbild aufgezeichnet.

Objektiv mit E-Fassung

Objektive mit E-Fassung werden unterstützt, indem 
der PL-Objektivadapter entfernt wird. Objektive mit 
E-Fassung sind kleiner und leichter als PL-Objektive. 
Sie sind vielfältig für erweiterte Möglichkeiten der 
Bildreproduktion erhältlich.

Kompaktes Gehäuse und intuitive 
Bedienung

Obwohl das Gerät mit einem großen Vollformat-
Bildsensor ausgestattet ist, bleibt das Design 
dank der Miniaturisierungstechnik von Sony 

vergleichsweise kompakt, wodurch Aufnahmen 
bei begrenztem Platzangebot oder an Bord von 
Drohnen erleichtert werden.
Lage, Form und Größe der Steuerungstasten 
sind an den Bedürfnissen von Kamerabedienern 
orientiert und ermöglichen intuitive Bedienung. 
Zur besseren Bedienbarkeit in dunklen Situationen 
sind sie zudem hinterleuchtet.

Auf Langlebigkeit hin entwickelt

Das Chassis aus legiertem Magnesium zeichnet 
sich durch hohe Stabilität und Langlebigkeit 
aus. Das Lüftungssystem ist vollständig von den 
elektronischen Komponenten getrennt. Das 
Eindringen von Staub, Sand und Flüssigkeiten wird 
somit verhindert.*
Der leise Lüfter kann am Set schnell und einfach 
entfernt und gereinigt werden, um eine hohe 
Verfügbarkeit aufrechtzuerhalten.
*	 Die Konstruktion schützt vor Staub und Regen, kann 

jedoch das Eindringen von Staub und Flüssigkeiten nicht 
vollständig verhindern.

Modulares Design

Dank des modularen Designs können Sie je nach 
Aufnahmeanwendung flexibel verschiedene 
Aufbauten und Peripheriegeräte verwenden. 
Der obere Griff und der Sucher sind einfach 
anpassbar, um die ergonomische Balance und 
die Bedienerfreundlichkeit mit Objektiven zu 
gewährleisten. Die Höhe der optischen Achse ist 
die gleiche wie beim PMW-F55, wodurch die mit 
dem PMW-F55 verwendeten Peripheriegeräte 
genutzt werden können. Zudem kann ein optionales 
tragbares Speichergerät AXS-R7 fest mithilfe von vier 
Sechskantschrauben an der Rückseite des Geräts 
angebracht werden.

Optischer ND-Filter mit acht 
Positionen

Das Gerät verfügt über einen optischen ND-Filter 
mit acht Positionen. Dieser bietet einen weiten ND-
Bereich von 0.3ND (1/2 = 1 Stopp) bis 2.4ND (1/256 
= 8 Stopps) und erspart am Set den Zeitaufwand 
für das Wechseln externer ND-Filter. Der ND-
Filtermechanismus ist servosteuerbar.

Intuitive und vertraute Bedienung am 
Set

Der Menübildschirm ist von beiden Seiten der 
Kamera aus verfügbar. Das Hauptdisplay an 
der Assistentenseite der Kamera bietet dem 
Kameraassistenten während der Aufnahme 
schnellen Zugriff auf die Kameraeinstellungen.
Der Bediener kann mithilfe eines OLED-
Minidisplays an der Bedienerseite der Kamera 
auf die gebräuchlichsten Funktionen wie 
ND-Filterposition, Verschluss, Weißabgleich, 
Belichtungsindex (EI) und Bildrate (FPS) zugreifen 
und den Status des Geräts bequem überprüfen.

Farbregulierung durch RM/RCP-
Einheiten

Das Gerät unterstützt Steuerung durch ein RM/
RCP-Panel, das mit Rundfunk-Camcordern 
und Systemkameras verwendet werden 
kann. Bei dessen Anschluss sind Farbraum 
nach ITU-R-Empfehlung 2020 und HLG 
auswählbar, und die Einstellung verschiedener 
Farbregulierungsparameter wird unterstützt.
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Aufnahme mit High Frame Rate 
(HFR)

Bei Verwendung des Geräts zusammen mit einem 
AXS-R7 wird 4K RAW-Aufnahme mit Bildraten von 
bis zu 120 fps unterstützt.

Unterstützung von Fernbedienungen

Wenn Sie eine RM-B170 oder eine andere 
Fernbedienung anschließen, können Sie einige 
der Gerätefunktionen über die Fernbedienung 
steuern, selbst dann, wenn Technical > System 
Configuration > RM/RCP Paint Control (Seite 68) 
in Full Menu auf Off gestellt ist.

Verschiedene Aufzeichnungsformate

Das Gerät unterstützt Aufzeichnungen auf SxS-
Speicherkarten in den Formaten XAVC 4K/QFHD, 
MPEG HD sowie HD ProRes 422. Zusätzlich sind 
Aufzeichnungen in 16-Bit-RAW oder X-OCN auf 
AXS-Speicherkarten möglich, wenn das optionale 
tragbare Speichergerät AXS-R7 verwendet wird.

Imagerblock-Verlängerung

Der Imagerblock kann durch Anschließen des 
Kamera-Erweiterungssystems CBK-3610XS* um 
2,7 m oder 5,5 m vom Kameragehäuse entfernt 
werden.
*	 Firmware auf Version 3.0 oder später aktualisieren.

Effektive Bildgröße

Das Gerät unterstützt Aufnahmen in den folgenden effektiven Bildgrößen.

[Hinweis]
Für Aufnahmen in 6K 17:9, 6K 1.85:1, 6K 2.39:1, 6K 3:2, 5.7K 16:9, 4K 4:3, 4K 6:5 und 4K 2.39:1 ist eine Softwarelizenz erforderlich.

6K 3:2

6K 1.85:1

6K 17:9

4K 6:5

4K 4:3

6K 2.39:1

4K 2.39:1

4K 17:9
(DCI 4K)

3.8K 16:9
(Ultra HD)

5.7K 16:9
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Softwarelizenzen

Sie können je nach beabsichtigter Verwendung des Geräts Softwarelizenzen (optional) auswählen.
Softwarelizenzen werden im vollständigen Menü über Maintenance > License Options (Seite 72) 
installiert.

Softwarelizenz Imager-Modus Effektive 
Pixelanzahl
(Bildpixel)

B × H (mm) Projektbildrate

Keine Lizenz erforderlich 1) 3.8K 16:9 3840 × 2160 22,8 × 12,8 23, 24, 25, 29, 50, 59

3.8K 16:9 
Surround View

3840 × 2160
(4268 × 2400)

22,8 × 12,8
(25,4 × 14,3)

23, 24, 25, 29

4K 17:9 4096 × 2160 24,3 × 12,8 23, 24, 25, 29, 47, 50, 59

4K 17:9 
Surround View

4096 × 2160
(4552 × 2400)

24,3 × 12,8
(27,0 × 14,3)

23, 24, 25, 29

Anamorphotische Lizenz 4K 4:3 4096 × 3024 24,3 × 18,0 23, 24, 25, 29, 47, 50 2), 59 2) 3)

4K 4:3 Surround 
View

4096 × 3024
(4552 × 3360)

24,3 × 18,0
(27,0 × 20,0)

23, 24, 25, 29

4K 6:5 4096 × 3432 24,3 × 20,4 23, 24, 25, 29

Vollformatlizenz 1) 5.7K 16:9 5674 × 3192 33,7 × 18,9 23, 24, 25, 29

6K 2.39:1 6048 × 2534 35,9 × 15,0 23, 24, 25, 29

6K 17:9 6054 × 3192 36,0 × 19,0 23, 24, 25, 29

6K 1.85:1	 6054 × 3272 36,0 × 19,4 23, 24, 25, 29

6K 3:2 6048 × 4032 35,9 × 24,0 23, 24, 25, 29 2), 50 2) 3), 59 2) 3)

High Frame Rate-Lizenz 4K 2.39:1 2) 4096 × 1716 24,3 × 10,3 23, 24, 25, 29, 50, 59

1)	 Die anamorphotische Lizenz wird benötigt, um andere Einstellungen des Seitenverhältnisses als Off(1.0×) für die 
Entzerrungsfunktion zu ermöglichen.

2)	 Wenn eine High Frame Rate-Lizenz aktiviert ist.
3)	 AXS-Aufnahme wird unterstützt, AXS-Wiedergabe wird jedoch am Gerät nicht unterstützt.

Unterstützte Aufnahmebildraten und Entzerrungswerte

Die folgende Tabelle zeigt die unterstützten Aufnahmebildraten und Entzerrungswerte (Seite 59) im 
jeweiligen Imager-Modus.

Vollformatlizenz Anamorphotische Lizenz High Frame Rate-Lizenz

Imager-Modus Aufnahmebildrate Entzerrung 

Standard Erweiterungsbildraten Off (1.0×) 1.25× 1.3× 1.5× 1.8× 2.0×

6K 3:2 1 bis 25 Bis zu 60 Ja Ja Ja Ja Ja Ja

6K 1.85:1 1 bis 30 – Ja – – – – –

6K 17:9 1 bis 30 – Ja Ja Ja – – Ja

6K 2.39:1 1 bis 30 – Ja – – – – –

5.7K 16:9 1 bis 30 – Ja – – – – –

4K 6:5 1 bis 30 – Ja – – – – Ja

4K 4:3 Surround 1 bis 30 – Ja – Ja – – Ja

4K 4:3 1 bis 48 Bis zu 60, 66, 72, 75 Ja – Ja – – Ja

4K 17:9 Surround 1 bis 48 – Ja Ja Ja – – Ja

4K 17:9 1 bis 60 66, 72, 75, 88, 90, 96, 
100, 110

Ja Ja Ja – – Ja

4K 2.39:1 – 120 Ja – – – – –

3.8K 16:9 Surround 1 bis 48 – Ja – – – – –

3.8K 16:9 1 bis 60 – Ja – – – – –
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Surround View

Surround View ist ein Modus, der in den nachfolgend aufgeführten Imager-Modi verfügbar ist. Bei diesem 
wird ein Bildbereich im Sucher und im SDI-Monitor-Ausgang angezeigt, der einen äußeren Bereich von 
5% über die effektive Bildgröße hinaus umfasst (oben/unten/links/rechts). Hierdurch können Sie beim 
Aufnehmen einen größeren Bildbereich sehen. Der aufgenommene Bildbereich enthält die äußere Region 
nicht.
3.8K 16:9
4K 17:9
4K 4:3

[Hinweise]
ˎˎ In diesem Modus können Beschränkungen hinsichtlich der Einstellung der maximalen Projektbildrate bestehen.
ˎˎ Im 4K 4:3-Modus mit einem Entzerrungsverhältnis von 2.0× enthält der Bildbereich nur 5% der oberen und unteren 

Randbereiche.
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Systemkonfiguration

MPC-3610

Schulteraufsatz 
VCT-FSA5

Sucher 
DVF-L700 
(Sucherkabel (A-2201-632-A 
oder A-2201-633-A) 
erforderlich)

Sucher 
DVF-EL200
(Sucherkabel A-2203-
745-A (zum Gerät 
mitgeliefert) oder 
1-912-598-21 
erforderlich)

Mikrofon 
ECM-680S, ECM-678, 
ECM-674 
(EC-0.5X3F5M erforderlich)

Mikrofonhalter-Basisbaugruppe (A-2182-620-A) 
Stangenklemme (A-2182-621-A) 
Stange (4-684-612-01)
Mikrofonhalter-Baugruppe (X-2596-733-2)
Schrauben P2,6×8 (2) (7-627-556-98)

SxS-Speicherkarte 
SBP-64/128/256E, SBS-32/64/128G1C 
 
XQD-Speicherkarte 
QD-G32E/G64E/G120F/G240F 
(XQD-ExpressCard-Adapter QDA-EX1 ist erforderlich)

USB-Kartenlesegerät 
SBAC-US30/UT100

Netzteil 
AC-DN2B, AC-DN10A

AXS-Speicherkartenlesegerät 
AXS-AR1

Akku 
BP-FL75, BP-FLX75

S35-PL-Objektiv 
SCL-PK6, 
SCL-P11X15

Anamorphotische 
Lizenz 
CBKZ-3610A, 
CBKZ-3610AM, 
CBKZ-3610AW

Vollformatlizenz 
CBKZ-3610F, 
CBKZ-3610FM, 
CBKZ-3610FW

Anamorphotisches 
Objektiv
(PL-Fassung / E-Fassung)

Kamera-
Erweiterungssystem 
CBK-3610XS

Vollformatobjektiv
(PL-Fassung / E-Fassung)

Objektiv mit E-Fassung 
SELP28135G, SEL1635GM, SEL2470GM, SEL70200GM, SEL100400GM, 
SEL1224G, SEL35F14Z, SEL50F14Z, SEL85F14GM, SEL90M28G, 
SEL100F28GM

Tragbares 
Speichergerät 
AXS-R7

AXS-Speicherkarte 
AXS-A256S24, AXS-A512S48, 
AXS-A512S24, AXS-A1TS48, 
AXS-A1TS24

AXS-Speicherkartenlesegerät 
AXS-AR1, AXS-CR1

Fernbedienung 
RM-B170/B750 
RCP-1000/1500/1530 
RCP-1001/1501

High Frame Rate-
Lizenz 
CBKZ-3610H 
CBKZ-3610HM 
CBKZ-3610HW
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Position und Funktion der Teile
Bedienerseite

4

678910111213
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16

14

1 2 3

5

Lufteinlass
SxS-Speicherkarten-
Einschubblock (Seite 9)

1.	 Tasten ASSIGN 1/2 (frei belegbare 
Funktionstasten) (Seite 39)
Weist Funktionen mithilfe der Seite EDIT des 
Bildschirms User Functions (Seite 39) zu.
Die zugewiesene Funktion wechselt zwischen 
Ein/Aus (Aktiviert/Deaktiviert) oder wird durch 
jeden Druck aktiviert.

2.	 Anzeigeleuchten ASSIGN 1/2 (frei belegbar) 
(Seite 39)
Die jeweilige Leuchte leuchtet orange, wenn 
die zugewiesene Funktion eingeschaltet 
(aktiviert) ist. Die Leuchte ist erloschen, wenn 
die Funktion ausgeschaltet (deaktiviert) ist.

3.	 Tasten ITEM 1 bis 3 des Minidisplays
Zur Bedienung von Funktionen auf dem 
Minidisplay (Seite 76).

4.	 Minidisplay
Zeigt verschiedene Einrichtungsoptionen wie 
z. B. Verschlusswinkel an, die Sie prüfen oder 
ändern können (Seite 76).

5.	 Anzeigeleuchten ACCESS (SLOT A/B)
Die jeweilige Anzeigeleuchte leuchtet, wenn 
das Aufzeichnungsmedium im SxS-
Karteneinschub A/B das Ziel für Aufnahme/
Wiedergabe ist und wenn Daten auf das 
Aufzeichnungsmedium im SxS-Karteneinschub 
A/B geschrieben oder von diesem gelesen 
wird (Seite 24).

6.	 Netzwerkanschluss (RJ-45)
Verbinden Sie zum Fernsteuern des Geräts 
diesen Anschluss über ein LAN-Kabel (nicht 
mitgeliefert) mit einem verkabelten Netzwerk 
(Seite 79).

7.	 Taste CLIPS
Zum Anzeigen des Clip-Bildschirms auf dem 
Minidisplay drücken, um Clipfunktionen zu 
ermöglichen (Seite 78).
Gleichzeitig wird der Cliplistenbildschirm auf 
dem Subdisplay angezeigt und kann ebenfalls 
für Clipfunktionen verwendet werden.
Um vom Wiedergabe- in den Aufnahmemodus 
zu wechseln, drücken Sie die Taste HOME.

8.	 Netzschalter
Zum Einschalten in die Einschaltstellung () 
bringen. Zum Ausschalten in die 
Ausschaltstellung () bringen.

	 [Hinweise]
ˎˎ Auch wenn sich der Netzschalter in Ausschaltstellung 

befindet, verbraucht das Gerät eine geringe Menge 
Strom. Wenn das Gerät für eine längere Zeit außer 
Betrieb genommen wird, entfernen Sie den Akku.
ˎˎ Vor dem Entfernen von Akku oder Netzspannung 

muss zunächst der Netzschalter in die Position OFF 
gestellt werden. Wenn während der Aufnahme oder 
beim Zugriff auf Speicherkarten die Stromversorgung 
unterbrochen wird, kann dies eine Fehlfunktion 
verursachen.

9.	 Taste HOME
Zum Löschen der Optionsauswahlanzeige und 
zur Rückkehr zum Bildschirm Home des 
Minidisplays drücken.
Wenn die Taste im Wiedergabemodus des 
Geräts gedrückt wird, wechselt das Gerät in 
den Aufnahmemodus (Seite 76).

10.	 LOCK-Schalter
Sperrt die Bedienung der Tasten auf der 
Bedienerseite. Im gesperrten Zustand leuchtet 
die Hintergrund-LED des Schalters orange.

11.	 Kopfhöreranschluss (Mini-Stereobuchse)
Zum Anschließen von Ohrhörern zur 
Audioüberwachung. Sie können während der 
Aufnahme die Toneingabe und während der 

Wiedergabe die Tonwiedergabe überwachen 
(Seite 75).

12.	 Integrierter Lautsprecher
Sie können während der Aufnahme die 
Toneingabe und während der Wiedergabe die 
Tonwiedergabe überwachen. Der Lautsprecher 
gibt auch Alarme aus, um die visuellen 
Warnungen zu unterstreichen (Seite 75).
Wenn Sie Ohrhörer an die Kopfhörerbuchse 
anschließen, wird der Lautsprecherausgang 
automatisch unterdrückt.

13.	 Leuchte REC ACTIVE
Diese Leuchte leuchtet grün, wenn die Taste 
REC aktiviert ist.

14.	 Leuchte ASSIGN 3 (frei belegbar) (Seite 39)
Die Leuchte leuchtet orange, wenn die 
zugewiesene Funktion eingeschaltet (aktiviert) 
ist. Die Leuchte ist erloschen, wenn die 
Funktion ausgeschaltet (deaktiviert) ist.

15.	 Taste/Leuchte REC (Aufzeichnung starten/
anhalten)
Zum Starten der Aufzeichnung drücken – die 
Leuchte REC wird eingeschaltet. Zum Anhalten 
der Aufzeichnung erneut drücken – die 
Leuchte REC wird ausgeschaltet (Seite 84).
Wenn ein Gerätefehler oder eine Warnung 
auftritt, blinkt die Leuchte REC.

16.	  Markierung f
Die Markierung f befindet sich auf der 
gleichen Ebene wie der Bildsensor.
Verwenden Sie die Markierung f als 
Bezugspunkt, um den genauen Abstand 
zwischen dem Gerät und dem Motiv zu 
messen.
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SxS-Speicherkarten-Einschubblock (Seite 24)

Die Einschübe für die SxS-Speicherkarten befinden 
sich hinter der Abdeckung.

1

3

2

1.	 Einschübe für SxS-Speicherkarten A/B

2.	 Anschluss für herstellerseitige Kalibrierung
Dieser Anschluss dient der Kalibrierung und 
Wartung durch den Hersteller (kann nicht von 
Benutzern verwendet werden).

3.	 Taste SLOT SELECT (Auswahl der SxS-
Speicherkarte)
Zum Wechseln des aktiven Einschubs drücken.

Assistentenseite

1 2 3 4

6

5

7

8

9

1011
12

13
14

15
16

17

18
1 2 3

4 5 6

1.	 Taste ASSIGN 4 (frei belegbare 
Funktionstaste) (Seite 39)
Weist Funktionen mithilfe der Seite EDIT des 
Bildschirms User Functions (Seite 39) zu.
Die zugewiesene Funktion wechselt zwischen 
Ein/Aus (Aktiviert/Deaktiviert) oder wird durch 
jeden Druck aktiviert.

2.	 Anzeigeleuchte ASSIGN 4 (frei belegbar) 
(Seite 39)
Die Leuchte leuchtet orange, wenn die 
zugewiesene Funktion eingeschaltet (aktiviert) 
ist. Die Leuchte ist erloschen, wenn die 
Funktion ausgeschaltet (deaktiviert) ist.

3.	 Subdisplay
Zum Prüfen des Betriebsstatus des Geräts und 
zum Vornehmen verschiedener Einstellungen 
(Seite 31).
Halten Sie bei angezeigtem Bildschirm Home 
die Taste BACK (Seite 10) gedrückt, und 
stellen Sie die Helligkeit des Subdisplays und 
des Minidisplays ein, indem Sie den Regler 
SEL/SET drehen.
Die Helligkeit kann auch mithilfe von Technical 
> Control Display > Brightness level 
(Seite 71) im vollständigen Menü angepasst 
werden.

4.	 Tasten ITEM 1 bis 6 des Subdisplays
Zur Bedienung von Funktionen auf dem 
Subdisplay (Seite 43).

5.	 Messbandhaken
Der Messbandhaken befindet sich auf der 
gleichen Ebene wie der Bildsensor. Verwenden 
Sie den Messbandhaken als Bezugspunkt, um 
den genauen Abstand zwischen dem Gerät 
und dem Motiv zu messen. Sie können das 
Ende des Messbands am Haken befestigen 
und so die Entfernung vom Motiv messen.

6.	 Taste HOME
Zum Löschen der Anzeige und zur Rückkehr 
zum Bildschirm Home des Subdisplays 
(Seite 33) drücken.
Wenn die Taste im Wiedergabemodus des 
Geräts gedrückt wird, wechselt das Gerät in 
den Aufnahmemodus.

7.	 Taste MENU (Menüanzeige ein/aus) 
(Seiten 43, 54)
Drücken Sie die Taste MENU, um den 
Menübildschirm auf dem Subdisplay 
aufzurufen. Halten Sie die Taste MENU 
mindestens zwei Sekunden gedrückt, um den 
vollständigen Menübildschirm auf dem 
Subdisplay aufzurufen. Drücken Sie die Taste 
während der Anzeige des Menübildschirms 
oder vollständigen Menübildschirms, um zur 
vorhergehenden Bildschirmanzeige 
zurückzukehren.

8.	 Regler SEL/SET (Wählen/Einstellen) (Regler 
MENU)
Zum Ändern der Optionsauswahl oder einer 
Einstellung im Menü (Seiten 33, 43, 54).

9.	 +48-V-Leuchte
Leuchtet grün, wenn der Schalter AUDIO IN in 
Stellung MIC ist und am Anschluss AUDIO IN 
eine Phantomspeisung mit +48 V bereitgestellt 
wird. Ist die Leuchte erloschen, findet keine 
Phantomspeisung statt.
Sie können die Phantomspeisung mit +48 V 
mithilfe der Audio-Kategorie > Audio Details > 
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Audio Configuration > Phantom Power +48V 
im Menü ein-/ausschalten (Seite 67).

10.	 Schalter AUDIO IN (Audioauswahl)
Wählen Sie den Typ des Eingangssignals der 
mit dem Anschluss AUDIO IN verbundenen 
Tonquelle entsprechend aus.
LINE: Beim Anschließen einer externen 

analogen Audiosignalquelle 
AES/EBU: Beim Anschließen einer externen 

digitalen Audiosignalquelle
MIC: Beim Anschließen eines Mikrofons

11.	 Anschluss AUDIO IN (XLR 5-polig)
Zur Signaleingabe von externem Mikrofon 
oder Audioausrüstung.
Wenn die Tonquelle mithilfe des Schalters 
AUDIO IN auf LINE oder MIC eingestellt ist, 
fungiert dieser Anschluss als AUDIO IN CH-1 
und AUDIO IN CH-2.
Wenn die Tonquelle mithilfe des Schalters 
AUDIO IN auf AES/EBU eingestellt ist, fungiert 
dieser Anschluss als AUDIO IN CH-1/2 und 
AUDIO IN CH-3/4.

12.	 Taste BACK
Verwirft die Menüeinstellung und wechselt 
während der Menüanzeige in der 
Menühierarchie auf eine Ebene höher. Verwirft 
den Ausführungsvorgang oder wartenden 
Vorgang bei der Anzeige der Ausführung/der 
wartenden Vorgänge (Seiten 33, 43, 54).

13.	 LOCK-Schalter
Sperrt die Bedienung der Tasten auf der 
Assistentenseite. Im gesperrten Zustand 
leuchtet die Hintergrund-LED des Schalters 
orange.

14.	 Leuchte ACCESS (SD-Kartenzugriff ) 
(Seite 26)

15.	 Leuchte REC ACTIVE
Diese Leuchte leuchtet grün, wenn die Taste 
REC aktiviert ist.

16.	 Taste/Leuchte REC (Aufzeichnung starten/
anhalten)
Zum Starten der Aufzeichnung drücken – die 
Leuchte REC wird eingeschaltet. Zum Anhalten 
der Aufzeichnung erneut drücken – die 
Leuchte REC wird ausgeschaltet (Seite 84).
Wenn ein Gerätefehler oder eine Warnung 
auftritt, blinkt die Leuchte REC.

17.	 Taste CLIPS
Zum Anzeigen des Bildschirms Clip List auf 
dem Subdisplay drücken, um Clipfunktionen 
zu ermöglichen (Seite 73).
Gleichzeitig wird der Clip-Bildschirm auf dem 
Minidisplay angezeigt.
Um vom Wiedergabe- in den Aufnahmemodus 
zu wechseln, drücken Sie die Taste HOME.

18.	 Taste USER
Zum Anzeigen der Liste der 
Benutzerfunktionen auf dem Subdisplay und 
zum Bedienen der Tasten ITEM 1 bis 5 als 
Benutzerfunktionstasten drücken.
Taste ITEM 6 ist die Taste EDIT der Liste der 
Benutzerfunktionen. Drücken Sie diese Taste, 
um den Bildschirm zur Funktionsauswahl der 
Benutzerfunktionstasten und der belegbaren 
Funktionstasten anzuzeigen. Wenn der 
Bildschirms User Functions angezeigt wird, 
können Sie durch Drücken dieser Taste zurück 
zur vorhergehenden Anzeige wechseln 
(Seite 39).

Vorderseite

1

23

4

5

1.	 Taste ASSIGN 3 (frei belegbare 
Funktionstaste) (Seite 39)
Weist Funktionen mithilfe der Seite EDIT des 
Bildschirms User Functions (Seite 39) zu.
Die zugewiesene Funktion wechselt zwischen 
Ein/Aus (Aktiviert/Deaktiviert) oder wird durch 
jeden Druck aktiviert.

2.	 PL-Objektivfassungsadapter (Seite 19)

3.	 Anschluss VF (Sucherausgang) (Seite 22)

4.	 Anschluss LENS (12-polig)
Unterstützt Blenden-, Fokus- und Zoom-
Steuerung von vernetzten Computern, 
Smartphones oder Tablets aus ab Firmware-
Version 4.0.

5.	 Anschluss 24V OUT 
(Gleichspannungsausgang 24 V, 3-polig, 
Fischer)
Stromversorgungsausgang 24 V DC 
(Seite 91).
Ausgangsspannung und maximaler 
Ausgangsstrom dieses Anschlusses variieren je 
nach Eingangsspannung des Geräts. Der 
maximale Strom umfasst den Ausgangsstrom 
des Anschlusses 24V OUT an der Rückseite 
(Seite 11).

Eingang 11 V bis 17 V
Ausgangsspannung: 24 V
maximaler Ausgangsstrom: 1,0 A

Eingang 22 V bis 32 V
Ausgangsspannung: wie 
Eingangsspannung
maximaler Ausgangsstrom: 2,0 A
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Rückseite

2
1

3
4
5
6

7

8

9

10
11
12
13

1.	 Anschluss 24V OUT 
(Gleichspannungsausgang 24 V, 3-polig, 
Fischer)
Stromversorgungsausgang 24 V DC 
(Seite 91).
Ausgangsspannung und maximaler 
Ausgangsstrom dieses Anschlusses variieren je 
nach Eingangsspannung des Geräts. Der 
maximale Strom umfasst den Ausgangsstrom 
des Anschlusses 24V OUT an der Vorderseite 
(Seite 10).

Eingang 11 V bis 17 V
Ausgangsspannung: 24 V
maximaler Ausgangsstrom: 1,0 A

Eingang 22 V bis 32 V
Ausgangsspannung: wie 
Eingangsspannung
maximaler Ausgangsstrom: 2,0 A

2.	 Anschluss 12V OUT (Gleichspannungsausgang 
12 V, 4-polig, Hirose)
Stromversorgungsausgang 12 V DC 

(Seite 91).
Ausgangsspannung und maximaler 
Ausgangsstrom dieses Anschlusses variieren je 
nach Eingangsspannung des Geräts.

Eingang 11 V bis 17 V
Ausgangsspannung: wie 
Eingangsspannung
maximaler Ausgangsstrom: 1,0 A

Eingang 22 V bis 32 V
Ausgangsspannung: 15 V
maximaler Ausgangsstrom: 0,8 A

3.	 Anschluss MONITOR OUT (Typ BNC)
Ausgangsanschluss für das HD-SDI-
Monitorsignal (Seite 91).

4.	 Anschluss GENLOCK (Genlock-Eingang) (Typ 
BNC)
Speisen Sie ein externes Referenzsignal ein, um 
das Gerät oder dessen Zeitcode mit einer 
externen Quelle zu synchronisieren.
Es werden digitale und analoge 
Signaleinspeisungen unterstützt.

Digitales Signal: 1,5G HDSDI-Signal, interlaced
Analoges Signal: HD sync, analog

5.	 Anschluss TC IN (Zeitcode-Eingang) (Typ 
BNC)
Speisen Sie ein Zeitcode-Referenzsignal ein, 
um den Zeitcode des Geräts an eine externe 
Quelle zu binden.

6.	 Anschluss AUX (5-polig, LEMO)
Gibt das Zeitcodesignal aus (Seite 92).

7.	 Anschluss REMOTE (Fernbedienung) 
(8-polig)
Dient zum Anschließen einer Fernbedienung 
oder eines anderen externen Steuergeräts.

8.	 Anschluss 12 V/24 V 
(Gleichspannungseingang) (Seite 16)
Eingang für externe 
Gleichspannungsversorgung des Geräts. Es 
werden Eingangsspannungen von 12 V und 
24 V unterstützt.

Nr. Signal

1 GND

2 NC

3 NC

4 DC IN (11 V bis 17 V oder 22 V bis 32 V)

9.	 Akkuanschluss (Seite 16)

10.	 Anschlüsse SDI OUT 1 bis 4 (serieller digitaler 
Ausgang) (Typ BNC) (Seite 91)

11.	 Akkuaufnahme (Seite 16)

12.	 Akkufreigabehebel (Seite 16)

13.	 Anschluss HDMI OUT (Seite 91)
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Oberseite

1 2 3 4

1.	 Anschluss für externe Geräte
Zum Aktualisieren eines AXS-Recorders AXS-R7 
(Option), wenn der AXS-R7 an das Gerät 
angeschlossen ist (Seite 29) oder zur 
Verwendung der kabellosen Fernbedienung 
der Kamera (Seite 79) durch den Anschluss 
eines WLAN-Adapters CBK-WA02 (Option).

2.	 Freigabetaste (Seite 18)

3.	 Aufnahme für Griff/Sucheraufsatz 
(Seite 18)

4.	 Zubehörbefestigungsschrauböffnungen
Art der Schraube: 1/4-20UNC (8)
Art der Schraube: 3/8-16UNC (10)
Einschraubtiefe: 10 mm oder weniger

Unterseite

3

1 2

Luftauslass

1.	 Befestigungslöcher für Stativplatte
Art der Schraube: 1/4-20UNC (2)
Art der Schraube: 3/8-16UNC (4)
Einschraubtiefe: 9 mm oder weniger

2.	 Untere Abdeckung
Entfernen Sie die vier Sechskantschrauben, um 
die Abdeckung zu entfernen.

3.	 SD-Karteneinschub (Seite 26)
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Sucher/Monitorbildschirm

Während der Aufnahme (bei Aufzeichnung oder im Standby) sowie während der Wiedergabe werden die 
unter Monitoring > OSD Appearance > Status Info A/B Setup ausgewählten Informationen (Seite 63) im 
vollständigen Menü angezeigt.

Während der Aufnahme auf dem Bildschirm gezeigte Informationen

27
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1.	 Anzeige der Aufzeichnungsbildrate
Zeigt die Aufzeichnungsbildrate und die 
Projektbildrate an.

2.	 Anzeige von Verschlusswinkel/
Verschlussgeschwindigkeit
Zeigt den Verschlusswinkel oder die 
Geschwindigkeit des elektronischen 
Verschlusses entsprechend der Einstellung 
Technical > System Configuration im 
vollständigen Menü an.

3.	 ND-Filteranzeige
Zeigt die Dichte des ND-Filters an. Der 
angezeigte Wert ist logarithmisch (Basis 10) 
(Seite 55).

CLEAR
0.3 (1/2)
0.6 (1/4)
0.9 (1/8)
1.2 (1/16)
1.5 (1/32)
1.8 (1/64)
2.1 (1/128)
2.4 (1/256)

4.	 Thermometersymbol
Wird angezeigt, wenn eine Warnmeldung zu 
hoher Temperatur ausgegeben wird.
Die Beschreibung wird in der Info-Kategorie im 
Menü angezeigt.

5.	 Warnsymbol
Wird angezeigt, wenn eine Warnmeldung 
(ausgenommen Warnmeldungen zu hoher 
Temperatur) ausgegeben wird.
Die Beschreibung wird in der Info-Kategorie im 
Menü angezeigt.

6.	 Anzeige von Belichtungsindex (EI)/
Verstärkung
Zeigt den EI-Wert oder den von einer RM-B170 
oder einer anderen Fernbedienung 
eingestellten Verstärkungswert (dB-Einheiten) 
an.

[Hinweis]
Der Verstärkungswert wird nur angezeigt, wenn im 
vollständigen Menü Technical > System Configuration > 
RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

7.	 Farbtemperaturanzeige
Zeigt die Farbtemperatur und den Tonwert des 
Weißwerts an.

8.	 Look-Informationsanzeige
Zeigt den ausgewählten Look an (Seite 57).

9.	 Anzeige der Akkuladung/Spannung
Liefert je nach Art der Akkustromquelle die 
folgenden Anzeigen.

Akkutyp Display

InfoLithium-
Akku

verbleibende Akkuladung 
und verbleibende 
Aufnahmedauer

Anton/Bauer-
Akku

verbleibende Akkuladung 
(%-Anzeige)

andere Akkus Eingangsspannung

10.	 VF LUT-Anzeige
Zeigt die Sucher-LUT an (Seite 56).

11.	 Double Speed Scan-Anzeige Sucher
Zeigt den Ein-/Ausschaltzustand der Funktion 
zum Verdoppeln der Einzelbildrate der 
Sucheranzeige an.

12.	 Peaking-Anzeige Sucher
Zeigt den Ein-/Ausschaltzustand der Peaking-

Funktion der Sucheranzeige an.

13.	 Zebra-Anzeige Sucher
Zeigt den Ein-/Ausschaltzustand der Zebra-
Funktion der Sucheranzeige an (Seite 41).

14.	 LUT-Anzeige für Anschluss SDI OUT 1/2
Zeigt die LUT-Einstellung der Anschlüsse SDI 
OUT 1/2 an (Seite 56).

15.	 LUT-Anzeige für Anschluss SDI OUT 3/4
Zeigt die LUT-Einstellung der Anschlüsse SDI 
OUT 3/4 an (Seite 56).

16.	 LUT-Anzeige für Monitor
Zeigt die LUT-Einstellung des Monitor-
Ausgangs an (Seite 56).

17.	 HDMI LUT-Anzeige
Zeigt die LUT-Einstellung des HDMI-Ausgangs 
an (Seite 56).
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18.	 REC TRIGGER-Anzeige des SDI-Ausgangs
Zeigt den REC TRIGGER-Status des SDI-Ausgangs an.

Status Display

Technical > System Configuration > SDI Rec Remote 
Trigger im vollständigen Menü

Auf SDI-Ausgang 
überlagerter 
Aufnahmebefehl

Off – (leer)

HD SDI Remote I/F Befehl Stop oben: SDI
unten: Stop

Befehl Rec oben: SDI
unten: REC

Parallel Rec Befehl Stop oben: SDI-P
unten: Stop

Befehl Rec oben: SDI-P
unten: REC

19.	 Statusanzeige der Netzwerkverbindung
Zeigt den Status der Netzwerkverbindung 
(LAN oder WLAN) an.

Status Display

Getrennt oder anderer Fehler 
(Netzwerkverbindungseinstellungen 
gültig)

Blinkt

Verbunden 
(Netzwerkverbindungseinstellungen 
gültig)

Ein

Netzwerkverbindungsfunktion nicht 
verwendet

Leer

20.	 Anzeige der Tonpegelmesser
Zeigt die Pegel der Audiokanäle 1 und 2 
während der Aufnahme an.

21.	 Anzeige für Status des 
Aufzeichnungsmediums/verbleibende 
Kapazität jedes Medieneinschubs
Zeigt den Status und die verbleibende 
Kapazität der Medien in den SxS-
Speicherkarteneinschüben A/B sowie AXS-
Speicherkarteneinschüben A/B an.
Eine Markierung  links von „AXS“ oder „SxS“ 

zeigt das Zielaufzeichnungsmedium an.
Die Anzeige  oben rechts am Symbol für 
den Einschub A/B rechts von „AXS“ oder „SxS“ 
kennzeichnet das Wiedergabezielmedium 
(grüne Anzeige gibt an, dass das Medium 
wiedergegeben wird).
Ein Symbol  wird für das Medium angezeigt, 
falls ein Zustand eintritt, der die Aufzeichnung 
beeinträchtigen könnte.

22.	 Anzeige High Key/Low Key (Monitor-
Ausgang)
Wird angezeigt, wenn der Monitor-Ausgang 
High Key (Bildschirm zum Prüfen von 
überbelichteten Spitzlichtern) oder Low Key 
zeigt (Bildschirm zum Prüfen von 
ausgeblendeten Schatten) (wird für Ausgang 
Monitor Out angezeigt).

23.	 Anzeige des Aufzeichnungsmedium-Formats 
(Codec)
Zeigt das Format der Aufzeichnung auf einer 
AXS-Speicherkarte oder einer SxS-
Speicherkarte an.

24.	 Anzeige des Aufnahmestatus
Zeigt die folgenden Aufnahmestatus des 
Geräts an.

Display Beschreibung

 Rec Aufnahme

 Stby Aufnahme-Standby

 Cache Aufnahme-Standby mit 
Bildpuffer

25.	 Clipnamenanzeige
Zeigt im Aufnahme-Standby-Modus die ersten 
acht Zeichen des Namens vom nächsten 
aufzunehmenden Clip an.
Zeigt während der Aufnahme die ersten acht 
Zeichen des Namens des Clips an, der gerade 
aufgenommen wird.

26.	 Zeitdatenanzeige
Zeigt je nach Einstellung der TC/Media-
Kategorie > TC Display im Menü (Seite 44) 
die Dauer oder den Zeitcode an.

27.	 Blendenpositionsanzeige
Zeigt die Blendenposition an (nur wenn ein 
Objektiv angebracht ist, das mit der 
Fokuseinstellungsanzeigefunktion kompatibel 
ist).  
Die Blendenpositionsanzeige erfolgt bei 
Verwendung eines Objektivs mit E-Fassung in 
1/3-Stoppschritten.

[Hinweis]
Der F-Stoppwert wird anstelle des T-Stoppwerts 
angezeigt, falls dieser nicht ermittelt werden kann.

28.	 Anzeige der Fokusstellung
Zeigt die Fokusstellung an (nur wenn ein 
Objektiv angebracht ist, das mit der 
Fokuseinstellungsanzeigefunktion kompatibel 
ist).

29.	 Zoomstellungsanzeige
Zeigt die Brennweite des Zooms an (wird nur 
angezeigt, wenn ein Objektiv angebracht ist, 
das die Anzeige der Zoomeinstellung 
unterstützt).

30.	 Anzeige High Key/Low Key (Sucherausgang)
Wird angezeigt, wenn der Sucherausgang High Key 
(Bildschirm zum Prüfen von überbelichteten 
Spitzlichtern) oder Low Key zeigt (Bildschirm zum 

Prüfen von ausgeblendeten Schatten) (wird für 
Sucherausgang angezeigt).

31.	 Anzeige des gleichzeitigen Aufnahmestatus
Zeigt das Aufzeichnungsformat des Unterclips 
im Modus für gleichzeitige Aufnahme 1 
Einschub an (Seite 85).

32.	 SxS Sub LUT-Anzeige
Zeigt die für einen Unterclip zu registrierende 
LUT-Einstellung im Modus für gleichzeitige 
Aufnahme 1 Einschub (SxS) an.

33.	 SxS LUT-Anzeige
Zeigt die LUT-Einstellung für SxS-Aufnahme an.

34.	 Base ISO-Anzeige
Zeigt die konfigurierte eigene Empfindlichkeit 
an.

35.	 Anzeige der effektiven Bildgröße
Zeigt die effektive Bildgröße an und ob 
anamorphotische Entzerrungskonvertierung 
angewendet wird, die über Project-Kategorie > 
Imager Mode im Menü eingestellt wird. Im 
Modus Surround View wird das Symbol „Sur.V“ 
unter dem Symbol für den anamorphotischen 
Konvertierungsfaktor angezeigt (Seite 44).

Menüanzeige und Einstellungen im Sucher bzw. 
auf dem Bildschirm
Wenn ein DVF-EL200 an das Gerät angeschlossen 
ist, halten Sie die Menütaste des DVF-EL200 
gedrückt, um die Einstellungsmenüs Monitoring 
> VF Display (Seite 66) und VF Function 
(Seite 66) im Sucher bzw. auf dem Bildschirm 
anzuzeigen. Auf diese Weise können Sie diese 
Funktionen beim Blick auf den Sucher/Bildschirm 
konfigurieren.
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Auf dem Wiedergabebildschirm angezeigte Informationen

Die folgenden Informationen werden im Wiedergabebild angezeigt.
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1.	 Zeitdatenanzeige
Zeigt je nach Einstellung der TC/Media-
Kategorie > TC Display im Menü (Seite 44) 
die Dauer oder den Zeitcode an.

2.	 Anzeige des Wiedergabeclipnamens
Zeigt die ersten acht Zeichen des Namens des 
Wiedergabeclips an.

3.	 Anzeige des Wiedergabestatus
Zeigt den Wiedergabestatus an.

4.	 Anzeige des Wiedergabemedium-Formats 
(Codec)
Zeigt das Aufzeichnungsformat (den Codec) 
des Wiedergabeclips an.

5.	 Anzeige des Wiedergabemediums
Zeigt den Typ des Aufnahmemediums an, das 
gerade wiedergegeben wird.
Wird rechts das Symbol  angezeigt, ist die 
Karte schreibgeschützt.

6.	 Anzeige der Tonpegelmesser
Zeigt die Pegel der Audiokanäle 1 und 2 
während der Wiedergabe an.

7.	 Statusanzeige der Netzwerkverbindung
Zeigt den Status der Netzwerkverbindung 
(LAN oder WLAN) an.

Status Display

Getrennt oder anderer Fehler 
(Netzwerkverbindungseinstellungen 
gültig)

Blinkt

Verbunden 
(Netzwerkverbindungseinstellungen 
gültig)

Ein

Netzwerkverbindungsfunktion nicht 
verwendet

Leer

8.	 Thermometersymbol
Wird angezeigt, wenn eine Warnmeldung zu 
hoher Temperatur ausgegeben wird.

Die Beschreibung wird in der Info-Kategorie im 
Menü angezeigt.

9.	 Warnsymbol
Wird angezeigt, wenn eine Warnmeldung 
(ausgenommen Warnmeldungen zu hoher 
Temperatur) ausgegeben wird.
Die Beschreibung wird in der Info-Kategorie im 
Menü angezeigt.
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Vorbereiten einer Stromversorgung
Sie können einen Akku verwenden oder das Gerät 
über ein Netzteil an das Netz anschließen.
Verwenden Sie zur Sicherheit nur Akkus und 
Netzteile von Sony, die unten aufgelistet sind.

Lithium-Ionen-Akku
BP-FL75
BP-FLX75

Netzteil
AC-DN2B
AC-DN10A

Verwendung eines Akkus

Führen Sie den Akku in die Akkuaufnahme 
(Seite 11) des Akkuadapters ein und schieben 
Sie den Akku nach unten, um ihn zu verriegeln.
Um den Akku zu entfernen, entriegeln Sie diesen, 
indem Sie den Akkufreigabehebel (Seite 11) 
gedrückt halten und den Akku nach oben 
schieben. Nehmen Sie dann den Akku ab.

[Hinweise]
ˎˎ Laden Sie den Akku vor der Verwendung mit dem 

Akkuladegerät auf.
ˎˎ Ein erwärmter Akku lässt sich möglicherweise nicht 

vollständig aufladen.
ˎˎ Halten Sie das Gerät beim Abnehmen des Akkuadapters 

mit der Hand fest.

Prüfen der verbleibenden Akkuladung

Erfolgen Aufnahme- oder Wiedergabebetrieb 
mit Verwendung des Akkus, werden auf dem 
Subdisplay-Bildschirm (Seite 31) und im Sucher 
bzw. auf dem Monitorbildschirm (Seite 13) die 
aktuell verbleibende Akkubetriebszeit und die 
Akkuspannung angezeigt.
Die vom Gerät in Minuten angezeigte Restlaufzeit 
ist ein errechneter Wert und basiert auf der 
Annahme, dass das Gerät mit der aktuellen 
Stromaufnahme weiter betrieben wird.

Bei niedriger Restladung des Akkus

Falls die Restladung des Akkus während des 
Betriebs auf einen bestimmten Pegel fällt, blinkt 
die Anzeige der verbleibenden Akkuladung, und 
die REC-Leuchte blinkt zur Warnung.
Sinkt die Restladung weiter ab, so dass eine 
Fortsetzung des Betriebs nicht möglich ist, wird in 
einer Meldung angezeigt, dass der Akku leer ist.
Ersetzen Sie den Akku durch einen vollständig 
aufgeladenen.

Meldungen andere Ladezustände zuordnen

Ändern Sie die Ladezustände für die Meldungen 
mithilfe von Technical > Battery (Seite 70) im 
vollständigen Menü.

Netzbetrieb (Spannungsversorgung 
über DC IN) 

Das Gerät wird mit Netzspannung über die 
Netzteile AC-DN10A (optional) oder AC-DN2B 
(optional) und das Gleichspannungskabel 
CCDD-X2 (optional) betrieben.
Eingangsspannungsbereiche von 11 V bis 17 V und 
von 22 V bis 32 V werden unterstützt.

[Hinweise]
ˎˎ Verwenden Sie, wenn Sie während des Akkubetriebs 

auf die DC IN-Stromversorgung umschalten, eine 
Stromversorgung mit einer Spannung von 12 V bis 17 V.
ˎˎ Wenn Sie eine Stromversorgung mit 22 V bis 32 V 

verwenden, stellen Sie zunächst den Netzschalter in die 
Position OFF und schließen Sie dann die Stromversorgung 
an.
ˎˎ Schalten Sie nicht direkt zwischen einer Stromversorgung 

von 11 V bis 17 V und einer Stromversorgung von 22 V 
bis 32 V um. Hierdurch können Fehlfunktionen verursacht 
werden.

Verwendung eines Akkus zusammen 
mit einer Stromversorgung über DC 
IN

Wenn bei Verwendung eines Akkus und einer 
Stromversorgung über DC IN eine aktive 
Stromversorgung angeschlossen wird, erhält jene 
über DC IN Vorrang.

[Hinweis]
Wenn die Stromversorgung vom Akkubetrieb auf Versorgung 
über DC IN wechselt, kann das Gerät bei Auftreten der 
nachfolgend aufgeführten Ereignisse den Betrieb einstellen.
ˎˎ Prellen der Anschlusskontakte beim Einstecken des DC-

Steckverbinders
ˎˎ Spannungsabfall beim Umschalten zwischen 

Stromversorgungen (höhere Wahrscheinlichkeit, falls die 
externe Last größer ist)
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Einstellen der Uhr
Wenn Sie das Gerät zum ersten Mal 
verwenden, wird nach dem Einschalten der 
Ersteinrichtungsbildschirm auf dem Subdisplay 
angezeigt.
Stellen Sie Datum und Zeit der integrierten Uhr 
über diese Anzeige ein.

Zeitzone

Der Wert gibt den Unterschied zu UTC 
(Coordinated Universal Time- koordinierte Weltzeit) 
an. Verändern Sie die Einstellung bei Bedarf.

[Hinweis]
Wenn Time Zone geändert wird, ändert sich die 
Uhrzeiteinstellung gemäß der Zeitdifferenz.

Einstellen von Datum und Zeit

Drehen Sie den Regler MENU (Seite 9) um den 
Cursor zu bewegen, und bewegen Sie dann den 
Regler MENU auf die einzelnen Menüelemente. 
Wenn Sie den Regler MENU drücken, während 
sich der Cursor auf „Set“ befindet, wird die 
Einstellungsanzeige ausgeblendet, und die 
Uhreinstellung ist abgeschlossen.
Nachdem der Ersteinrichtungsbildschirm 
ausgeblendet wurde, können Sie die Einstellungen 
für Time Zone sowie Datum/Zeit mithilfe 
von Maintenance > Clock Set (Seite 71) im 
vollständigen Menü ändern.

[Hinweise]
ˎˎ Wurde die Zeiteinstellung gelöscht, weil die Pufferbatterie 

leer war und keine Betriebspannung anlag (weder über 
Akku noch über den Anschluss DC IN), erscheint der 
Ersteinrichtungsbildschirm, wenn Sie das Gerät das 
nächste Mal einschalten.
ˎˎ Solange der Ersteinrichtungsbildschirm angezeigt wird, ist 

außer dem Ausschalten des Geräts kein anderer Vorgang 
zulässig, bis Sie die Einstellungen in dieser Anzeige 
vorgenommen haben.
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Anbringen des Sucheraufsatzes

1	 Bringen Sie den Sucheraufsatz an, indem Sie 
ihn in Pfeilrichtung aufschieben.

2	 Positionieren Sie den Sucheraufsatz in der 
gewünschten vorderen/hinteren Position, und 
drehen Sie dann den Arretierungshebel, um 
ihn zu sichern.

1

2

Arretie-
rungshebel

	 [Hinweise]
ˎˎ Sie können den Sucheraufsatz auch in vorderer/

hinterer oder linker/rechter Orientierung anbringen.
ˎˎ Falls sich der Arretierungshebel schwer feststellen 

oder lösen lässt, können Sie die Schraube 
oben auf dem Arretierungshebel mit einem 
Innensechskantschlüssel (3 mm) nachjustieren.

Entfernen des Sucheraufsatzes

Drehen Sie den Arretierungshebel lose, drücken 
Sie die Freigabetaste, und schieben Sie den 
Sucheraufsatz in die Richtung herunter, die jener 
beim Anbringen entgegengesetzt ist.

Anbringen des Griffs

1	 Bringen Sie den Griff an, indem Sie ihn in 
Pfeilrichtung aufschieben.

2	 Positionieren Sie den Griff in der gewünschten 
vorderen/hinteren Position, und drehen Sie 
dann den Arretierungshebel, um ihn zu 
sichern.

2

1

Arretierungsschraube

Innensechskantschraube

Arretie-
rungshebel

	 [Hinweise]
ˎˎ Sie können ihn auch mit einer Arretierungsschraube 

und einem Innensechskantschlüssel (5 mm) in seiner 
Position sichern.
ˎˎ Falls sich der Arretierungshebel am Griff während der 

Verwendung lockert, können Sie den Griff sichern, 
indem Sie eine Innensechskantschraube (2 mm) 
neben der Arretierungsschraube festziehen.
ˎˎ Sie können den Griff auch in umgekehrter 

Orientierung anbringen.

Abnehmen des Griffs

Drehen Sie den Arretierungshebel lose, drücken 
Sie die Freigabetaste, und schieben Sie den Griff in 
die Richtung herunter, die jener beim Anbringen 
entgegengesetzt ist.

Anbringen von Sucheraufsatz und Griff
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Empfohlenes Objektiv mit PL-Fassung (Größe Super 
35 mm)
SCL-PK6/F, SCL-PK6/M (Satz mit 6 Objektiven, 
20 mm/25 mm/35 mm/50 mm/85 mm/135 mm)
SCL-PK3/F, SCL-PK3/M (Satz mit 3 Objektiven, 
20 mm/25 mm/135 mm)
SCL-P11X15

Empfohlenes Objektiv mit E-Fassung
SELP28135G, SEL1635GM, SEL2470GM, 
SEL70200GM, SEL100400GM, SEL1224G, 
SEL35F14Z, SEL50F14Z, SEL85F14GM, SEL90M28G, 
SEL100F28GM

[Hinweis]
Bei einigen Objektiven mit E-Fassung wird die Steuerung 
möglicherweise nicht unterstützt. Verwenden Sie ein 
empfohlenes Objektiv.

Einzelheiten zu den für das Gerät erhältlichen Objektiven 
erfahren Sie von einem Sony-Kundendienstmitarbeiter.

[VORSICHT]
Das Objektiv darf nicht über längere Zeit 
der Sonne zugewandt bleiben. Direkte 
Sonneneinstrahlung kann durch das Objektiv 
eindringen, im Gerät gebündelt werden und einen 
Brand verursachen.

[Hinweise]
ˎˎ Schalten Sie das Gerät aus, bevor Sie Objektiv und Adapter 

anbringen oder abnehmen.
ˎˎ Ein Objektiv ist ein Präzisionsteil. Legen Sie das Objektiv 

nicht mit der Montageseite nach unten ab. Bringen Sie 
den Deckel an, der mit dem Objektiv mitgeliefert wurde.
ˎˎ Die Objektivschnittstelle des Geräts ist werkseitig 

standardmäßig für ein SCL-P11X15 und Objektive mit 
Cooke-Anschluss konfiguriert. Um ein SCL-PK6, SCL-PK3 
oder andere Objektive zu verwenden, die nicht über einen 
Cooke-Anschluss verfügen, wählen Sie für die Option 
Technical > Lens Configuration > PL-Mt Interface Position 
(Seite 68) im vollständigen Menü die Einstellung Off 
aus. Wird diese Einstellung nicht richtig vorgenommen, 
erscheint eine Warnmeldung, wenn das Gerät nach dem 
Anbringen des Objektivs eingeschaltet wird.

Anbringen eines Objektivs mit PL-
Fassung

1	 Nehmen Sie die Fassungsabdeckung von der 
Objektivfassung ab, indem Sie den PL-
Fassungshebel gegen den Uhrzeigersinn 
drehen.

PL-Fassungshebel

	 [Hinweis]
Drehen Sie den PL-Fassungshebel gegen den 
Uhrzeigersinn bis zum Anschlag.

2	 Führen Sie das Objektiv in die Objektivfassung 
ein, indem Sie den konkaven Teil des Objektivs 
am Positionierstift oben rechts an der 
Objektivfassung ausrichten.

3	 Sichern Sie das Objektiv, indem Sie den 
PL-Fassungshebel im Uhrzeigersinn drehen 
und das Objektiv dabei festhalten.

	 [Hinweis]
Drehen Sie beim Anbringen eines Objektivs mit 
PL-Fassung nicht das Objektiv. Andernfalls kann der Hot-
Shoe-Stift beschädigt werden.

Anbringen eines Cooke /i-Objektivs
Richten Sie den Kontakt des Objektivs am 
Hot Shoe des Geräts aus. An der Seite des 
Objektivadapters befinden sich zwei Anschlüsse, 
von denen ein beliebiger verwendet werden kann.

Abnehmen des Objektivs

1	 Drehen Sie den PL-Fassungshebel gegen den 
Uhrzeigersinn und halten Sie dabei das 
Objektiv von unten fest.

2	 Ziehen Sie das Objektiv nach vorne.

	 [Hinweis]
Wenn nicht in Kürze ein anderes Objektiv 
angebracht wird, richten Sie den konkaven Teil der 
Fassungsabdeckung vorsichtig aus und sichern Sie 
diese, indem Sie den PL-Fassungshebel im Uhrzeigersinn 
drehen.

Anpassen der Flanschbrennweite
Das Gerät wird mit bereits angepasster 
Flanschbrennweite ausgeliefert. Falls Sie die 
Flanschbrennweite anpassen müssen, entfernen 
Sie die Objektivfassung und wechseln die 
Distanzstücke gegen solche der richtigen Dicke 
aus. Sie können die Dicke um ±0,1 mm in Schritten 
von 0,01 mm anpassen.

Distanzstücke
Die folgenden Distanzstücke werden mit dem 
Gerät geliefert.
0,05 mm × 1 (rund)
0,01 mm × 15 (1/3 Bogen)
1/3-Bogen-Distanzstücke sollten stets als Satz 
von drei Stück verwendet werden. Legen Sie 
Distanzstücke auf, um die Flanschbrennweite 
zu vergrößern. Das Gerät wird mit bereits 
mithilfe dreier Arten Distanzstücke angepasster 

Flanschbrennweite ausgeliefert.
0,10 mm (rund)
0,05 mm (rund)
0,01 mm (1/3 Bogen)
Bei Auslieferung ist ein Siegel angebracht, auf dem 
die Dicke der Distanzstücke verzeichnet ist.

Anpassen der Flanschbrennweite

1	 Entfernen Sie die sechs 
Innensechsrundschrauben und den PL-
Fassungsflansch.

1

PL-Fassungsflansch

2	 Lockern Sie die vier Phillips-
Kreuzschlitzschrauben auf beiden Seiten der 
PL-Anschlüsse (zwei Positionen), und 
entfernen Sie die PL-Anschlüsse und PL-
Kontaktflächen.

3	 Bringen Sie Distanzstücke am PL-
Fassungsadapter an (drei Positionen).

33

33
33

22
22

PL-Anschlüsse

PL-Kontaktflächen

Anbringen eines Objektivs und Einstellen der Flanschbrennweite
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Bei Verwendung von 1/3-Bogen-
Distanzstücken
Bringen Sie Distanzstücke so an, dass diese an 
allen drei Stellen die gleiche Dicke ergeben.

Distanzstücke

Bei Verwendung von runden 
Distanzstücken
Bringen Sie die Distanzstücke mit der 
markierten Oberfläche zur Vorderseite weisend 
an.

Markierungen

Markierungen

4	 Bringen Sie die PC-Anschlüsse wieder an ihren 
ursprünglichen Stellen an (zwei Stück), und 
ziehen Sie die vier Phillips-
Kreuzschlitzschrauben mit einem 
Anzugsmoment von 0,18 Nm fest.

5	 Bringen Sie den PL-Fassungsflansch wieder an 
seiner ursprünglichen Stelle an, und ziehen Sie 
die sechs Innensechsrundschrauben mithilfe 
eines T8-Innensechsrundschlüssels auf 
0,35 Nm an.

Reinigen des Filters

Um den Filter zu reinigen, entfernen Sie zunächst 
den Adapter. Wischen Sie den mittleren Teil des 
Adapters (schattiertes Teil) vorsichtig mit einem 
Tuch oder anderem Material ab, und achten Sie 
darauf, dass keine Fasern auf Oberflächen haften 
bleiben. Falls Fasern anhaften, wischen Sie diese 
mit einem weichen Pinsel ab.

Adapter

Entfernen des PL-Objektivadapters

Entfernen Sie den PL-Objektivadapter, wenn Sie 
ein Objektiv mit E-Fassung am Gerät anbringen 
möchten. Das Anbringen/Entfernen erfolgt mit der 
Rückseite des Geräts nach unten weisend.
Entfernen Sie die sechs Innensechskantschrauben 
(2,5 mm) und den PL-Objektivadapter.

PL-Objektivadapter 

[Hinweise]
ˎˎ Indem Sie den Akku abnehmen und das Gerät mit der 

Rückseite nach unten weisend platzieren, sorgen Sie für 
Stabilität.
ˎˎ Achten Sie beim Anbringen/Entfernen des Adapters 

darauf, die Anschlusskontakte des Geräts und des PL-
Objektivadapters nicht zu berühren.

Anbringen des PL-Objektivadapters

1	 Stellen Sie sicher, dass sich der Fassungshebel 
in der verriegelten Stellung befindet.

Fassungshebel

2	 Platzieren Sie den PL-Objektivadapter in seiner 
ursprünglichen Lage. Setzen Sie die sechs 
Innensechskantschrauben (2,5 mm) ein und 
ziehen Sie diese mit einem 
Innensechskantschlüssel (2,5 mm) auf 
0,8 ±0,12 Nm an.
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Anbringen eines Objektivs mit 
E-Fassung

1	 Entfernen Sie den PL-Objektivadapter 
(Seite 20).

2	 Drücken Sie den Verriegelungsschalter nach 
oben, und drehen Sie den Fassungshebel im 
Uhrzeigersinn, um die Verriegelung 
freizugeben.

Fassungshebel

Verriegelungsschalter

3	 Richten Sie die Montagemarkierungen (weiß) 
an Gerät und Objektivfassung aufeinander aus 
und drücken Sie das Objektiv in die Fassung.

4	 Sichern Sie das Objektiv, indem Sie den 
Fassungshebel im Uhrzeigersinn drehen und 
das Objektiv dabei festhalten.

 

Montagemarkierungen 
(weiß)

[Hinweis]
Wenn ein Objektiv mit E-Fassung angeschlossen ist, kann 
der Betrieb mit einem 12-poligen Objektivanschluss nicht 
gewährleistet werden.

Abnehmen des Objektivs

1	 Drücken Sie den Verriegelungsschalter nach 
oben, und drehen Sie den Fassungshebel im 
Uhrzeigersinn, um die Verriegelung 
freizugeben.

2	 Ziehen Sie das Objektiv nach vorne.

	 [Hinweis]
Wenn nicht in Kürze ein anderes Objektiv 
angebracht wird, richten Sie den konkaven Teil der 
Fassungsabdeckung vorsichtig aus und sichern Sie 
diese, indem Sie den Fassungshebel entgegen dem 
Uhrzeigersinn drehen.
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Anbringen eines Suchers
Für das Gerät erhältliche Sucher
DVF-EL200: OLED-Farbsucher
DVF-L700: LCD-Farbsucher

Sucher sind separat erhältlich.
In diesem Abschnitt wird als Beispiel beschrieben, 
wie der DVF-EL200 angebracht wird.

Einzelheiten zum Anbringen der Sucher finden Sie in der 
Bedienungsanleitung des Suchers.

[VORSICHT]
Lassen Sie das Gerät bei angebrachtem Sucher 
nicht so liegen, dass der Suchereinblick auf die 
Sonne gerichtet ist. Anderenfalls kann direktes 
Sonnenlicht durch den Suchereinblick eindringen, 
im Sucher fokussiert werden und einen Brand 
verursachen.

[Hinweise]
ˎˎ Das Anbringen/Abnehmen eines Suchers sollte 

stattfinden, wenn das Gerät ausgeschaltet ist.
ˎˎ Um den DVF-L700 anzubringen, ist ein Sucherkabel 

(A-2201-632 oder A-2201-633-A) erforderlich. Schalten 
Sie außerdem das Gerät ein, nachdem Sie den Schalter 
POWER des DVF-L700 in Stellung ON gebracht haben.

Anbringen eines Suchers

1	 Richten Sie den Sucherschuh an der Vertiefung 
der Sucheraufnahme am Sucheraufsatz aus, 
und bringen Sie den Sucher an.

2	 Drehen Sie den Arretierungshebel des Suchers 
in Richtung LOCK, um ihn zu sichern.

2

1

Arretierungshebel

3	 Verbinden Sie Sucher und Gerät mithilfe des 
Sucherkabels.
Sucherseite:
Richten Sie den Stecker mit der Markierung 
(rot) nach oben aus, und stecken Sie ihn 
vollständig ein.
Kameraseite:
Richten Sie die Nut des Suchersteckers an der 
Markierung (rot) des Anschlusses aus, und 
stecken Sie den Stecker vollständig ein.

Klemme

	 [Hinweis]
Sichern Sie das Kabel bei Bedarf in der Klemme.

Abnehmen des Suchers

1	 Trennen Sie das Sucherkabel von Sucher und 
Gerät.

2	 Drehen Sie den Arretierungshebel der 
Richtung LOCK entgegengesetzt. Entfernen Sie 
dann den Sucher vom Sucheraufsatz.

Anpassen der Sucherposition

Anpassen der vorderen/hinteren Position

1	 Lösen Sie einen oder beide der vorderen bzw. 
hinteren Arretierungshebel der 
Sucheraufsatzstangen.

2	 Schieben Sie zum Anpassen der 
Sucherposition den Sucheraufsatz vorwärts/
rückwärts.

11
11

22

Stangenarre-
tierungshebel

3	 Drehen Sie die Arretierungshebel der Stangen 
wieder fest.

	 [Hinweis]
Falls ein Arretierungshebel schwer zu drehen ist, ziehen 
Sie ihn an eine Position heraus, an der er einfacher zu 
bedienen ist, und drücken Sie ihn wieder hinein.
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Anpassen der linken/rechten Position und Höhe 
(Winkel)

1	 Lösen Sie den Arretierungshebel vorn am 
Sucheraufsatz.

2	 Schieben Sie die Sucheraufsatzstange nach 
links/rechts, und drehen Sie die Stange nach 
oben/unten, um die Sucherposition 
anzupassen.

11

22
22

Arretierungsschraube

Stangenarretierungshebel

3	 Drehen Sie den Arretierungshebel der Stange 
wieder fest.

	 [Hinweis]
Wenn der Arretierungshebel gelöst wird, passen Sie die 
Arretierungsschraube mithilfe eines Sechskantschlüssels 
(3 mm) an, um zu verhindern, dass der Sucher 
herunterfällt.

Anpassen des Sucherwinkels

Sie können den Winkel des Suchers während der 
Aufnahme anpassen.

1	 Lösen Sie den Arretierungshebel für die 
Rotation an der Sucheraufnahme.

2	 Drehen Sie den Sucher aufwärts/abwärts, um 
den Winkel einzustellen.

11

22

Arretierungshebel für die Rotation

3	 Drehen Sie den Arretierungshebel für die 
Rotation wieder fest.



2. Vorbereitung00024

Dieses Gerät speichert Audio- und Videodaten 
auf SxS-Speicherkarten (optional), die sich in den 
Karteneinschüben befinden.

Informationen zu SxS-Speicherkarten

Verwenden Sie die folgenden SxS-Speicherkarten 
oder XQD-Speicherkarten* von Sony.
*	 Bei Verwendung einer XQD-Speicherkarte ist der XQD-

ExpressCard-Adapter (QDA-EX1) erforderlich.

Die unterstützten Speicherkarten unterscheiden 
sich je nach Aufzeichnungsformat.

SxS PRO+
SBP-256D/E, SBP-128B/C/D/E, SBP-64B/C/D/E: Für 
alle Aufzeichnungsformate unterstützt

SxS PRO
SBP-64A, SBP-32: 
MPEG 1920×1080i, HD ProRes 422,  
HD ProRes 422 Proxy

SxS-1
SBS-128G1B/C, SBS-64G1A/B/C, SBS-32G1A/B/C:
MPEG 1920×1080i, HD ProRes 422,  
HD ProRes 422 Proxy

XQD-Speicherkarte der S-Serie und G-Serie
QD-S64E, QD-S32E, QD-G128A/E, QD-G64A/E, 
QD‑G32A/E, QD-G120F, QD-G240F: Für alle 
Aufnahmeformate unterstützt

XQD-Speicherkarte der N-Serie und M-Serie
QD-N64, QD-M128A, QD-M64A, QD-M32A: 
MPEG 1920×1080i, HD ProRes 422 Proxy

Der einwandfreie Betrieb mit anderen 
Speicherkarten kann nicht garantiert werden.
Diese Speicherkarten entsprechen dem 
ExpressCard-Standard.

Einzelheiten zur Verwendung von SxS-Speicherkarten und 
Hinweise hinsichtlich ihrer Anwendung finden Sie in der 
Bedienungsanleitung der jeweiligen SxS-Speicherkarte.

ˎˎ SxS, SxS PRO und SxS-1 sind Marken der Sony 
Corporation.
ˎˎ XQD ist eine Marke der Sony Corporation.
ˎˎ Der ExpressCard-Schriftzug und das 
ExpressCard-Logo sind Eigentum der Personal 
Computer Memory Card International 
Association (PCMCIA) und werden von der Sony 
Corporation in Lizenz verwendet.
ˎˎ ProRes ist eine registrierte Marke von Apple Inc.

Alle anderen Marken sind Eigentum der jeweiligen 
Rechteinhaber.

Einsetzen einer SxS-Speicherkarte

1	 Öffnen Sie die Abdeckung des 
Karteneinschub-Blocks (Seite 9).

2	 Führen Sie die SxS-Speicherkarte in den 
Einschub ein; dabei sollte das SxS-Etikett nach 
rechts weisen.
Die Anzeigeleuchte ACCESS (Seite 8) 
leuchtet rot auf und wechselt zu grün, sobald 
die Speicherkarte betriebsbereit ist.

3	 Schließen Sie die Abdeckung.

Status der Anzeigeleuchte ACCESS

Die Karteneinschübe A und B besitzen jeweils eine 
Anzeigeleuchte ACCESS, welche den Status des 
Einschubs anzeigt.

Leuchte Status des Einschubs

Leuchtet rot Zugriff auf die SxS-Speicherkarte 
(Daten lesen/schreiben)

Leuchtet grün Standby (betriebsbereit für 
Aufnahme oder Wiedergabe 
unter Verwendung der SxS-
Speicherkarte)

Aus ˎˎ Es ist keine SxS-Speicherkarte 
eingesetzt. 

ˎˎ Die eingesetzte Karte ist 
ungültig. 

ˎˎ Es ist eine SxS-Speicherkarte 
eingesetzt, jedoch der andere 
Einschub ausgewählt.

Entnehmen einer SxS-Speicherkarte

1	 Öffnen Sie die Abdeckung des Karten-
Einschubblocks.

2	 Ziehen Sie die SxS-Speicherkarte heraus.

[Hinweis]
Datensicherheit ist nicht gegeben, wenn während des 
Zugriffs auf die Speicherkarte die Spannungsversorgung 
ausgeschaltet oder die Karte entnommen wird. Die Daten 
auf der Karte können zerstört werden. Bevor Sie das 
Gerät ausschalten oder eine Speicherkarte entnehmen, 
vergewissern Sie sich, dass die Anzeigeleuchte ACCESS 
entweder grün leuchtet oder dunkel ist.

Umschaltung zwischen SxS-
Speicherkarten

Wenn sich sowohl im Einschub A als auch im 
Einschub B eine SxS-Speicherkarte befindet, 
können Sie zur Auswahl der zu verwendenden 
Karte die Taste SLOT SELECT drücken (Seite 9).
Wenn eine Karte voll bespielt ist, wird die 
Aufnahme durch automatisches Wechseln zur 
zweiten Karte fortgesetzt.

[Hinweis]
Bei laufender Aufnahme/Wiedergabe ist die Taste SLOT 
SELECT deaktiviert. Die Speicherkarten werden nicht 
umgeschaltet, auch wenn Sie die Taste drücken.

Umgang mit SxS-Speicherkarten
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Formatieren (Initialisieren) einer 
SxS-Speicherkarte

Wenn eine unformatierte oder mit anderer 
Spezifikation formatierte SxS-Speicherkarte 
geladen wird, erscheint eine Meldung, die Sie 
über das verschiedene Dateisystem des Mediums 
informiert. Formatieren Sie in diesem Fall die 
Speicherkarte folgendermaßen.

1	 Wählen Sie die TC/Media-Kategorie > Format 
Media im Menü aus.

2	 Wählen Sie SxS Slot A (Einschub A) oder SxS 
Slot B (Einschub B) aus, und drücken Sie den 
Regler MENU.
Ein Bestätigungsbildschirm wird angezeigt, auf 
dem Sie gefragt werden, ob Sie die Karte 
formatieren möchten.

3	 Halten Sie die Tasten ITEM 1 und ITEM 3 drei 
Sekunden lang gedrückt, um die Formatierung 
durchzuführen.
Die Formatierung beginnt, wobei während der 
Ausführung eine Meldung angezeigt wird und 
die Anzeigeleuchte ACCESS rot leuchtet.
Zum Ende der Formatierung wird eine 
Abschlussmeldung angezeigt. Drücken Sie 
den Regler MENU, um die Meldung zu 
verwerfen.

Wenn der Formatierungsvorgang fehlschlägt

Eine mit Schreibschutz versehene SxS-
Speicherkarte oder eine Speicherkarte, die 
für dieses Gerät nicht geeignet ist, wird nicht 
formatiert.
Es wird eine Warnmeldung angezeigt. Ersetzen Sie 
die Karte entsprechend den Anweisungen in der 
Meldung durch eine geeignete SxS-Speicherkarte.

[Hinweis]
Beim Formatieren einer Speicherkarte werden alle Daten 
einschließlich aufgezeichneter Bilder und Einstellungsdateien 
gelöscht.

Formatieren während der Aufnahme

Auch während der Aufnahme kann die in 
den anderen Karteneinschub geladene SxS-
Speicherkarte formatiert werden.

Prüfen der verbleibenden 
Aufnahmedauer

Während der Aufnahme (Aufzeichnung oder 
Standby) können Sie die verbleibende Kapazität 
der SxS-Speicherkarten in den einzelnen 
Steckplätzen mithilfe der Restkapazitätsanzeige für 
das Aufnahmemedium auf dem Bildschirm Home 
des Subdisplays (Seite 31) oder im Sucher/auf 
dem Monitorbildschirm überprüfen (Seite 13).
Die für die Aufzeichnung im aktuellen Videoformat 
(Aufzeichnungs-Bitrate) verbleibende Zeit wird 
entsprechend dem noch freien Speicherplatz auf 
der jeweiligen Karte berechnet und in Minuten 
angezeigt.

[Hinweis]
Wenn eine Speicherkarte schreibgeschützt ist, wird das 
Symbol  angezeigt.

Austauschen einer SxS-Speicherkarte

ˎˎ Sinkt die auf den eingesetzten Karten 
verbleibende Gesamtzeit während der 
Aufnahme auf weniger als 5 Minuten, blinken 
die Anzeige der verbleibenden Medienkapazität 
und die REC-Leuchte, und ein Warnton wird 
ausgegeben. Ersetzen Sie die Karten durch neue 
mit ausreichend Speicherplatz.
ˎˎ Wenn Sie mit dem Aufnehmen fortfahren, wird 
die Meldung „Media Full“ angezeigt, und die 
Aufzeichnung stoppt, wenn die verbleibende 

Aufnahmezeit auf 0 sinkt.

[Hinweis]
Auf einer SxS-Speicherkarte können bis zu 600 Clips 
gespeichert werden.
Die Anzeige der verbleibenden Aufnahmezeit ändert sich auf 
„0“, und die Meldung „Media Full“ wird angezeigt, wenn die 
Clipobergrenze erreicht wird.

Wiederherstellen einer SxS-
Speicherkarte

Falls an einer Speicherkarte ein Fehler auftritt, 
muss die Karte vor erneuter Verwendung 
wiederhergestellt werden.
Wird eine SxS-Speicherkarte eingesetzt, die 
wiederhergestellt werden muss, werden Sie durch 
eine Meldung auf dem Subdisplay aufgefordert, 
einen Wiederherstellungsvorgang auszuführen.
Um die Wiederherstellung zu beginnen, wählen 
Sie Execute aus, indem Sie den Regler MENU 
drehen. Drücken Sie dann den Regler MENU.
Die Wiederherstellung beginnt.
Während der Ausführung wird eine Meldung 
angezeigt, und die Anzeigeleuchte ACCESS 
leuchtet rot.
Zum Ende der Wiederherstellung wird eine 
Abschlussmeldung angezeigt. Drücken Sie den 
Regler MENU, um die Meldung zu verwerfen.

Wenn die Wiederherstellung fehlschlägt

ˎˎ Eine mit Schreibschutz versehene SxS-
Speicherkarte oder eine Speicherkarte, an 
der ein Fehler aufgetreten ist, kann nicht 
wiederhergestellt werden. In diesem Fall wird 
eine Warnmeldung angezeigt. Heben Sie 
den Schreibschutz auf oder tauschen Sie die 
Karte entsprechend den Anweisungen in der 
Meldung aus.
ˎˎ Eine fehlerhafte SxS-Speicherkarte kann durch 
erneute Formatierung ggf. wieder funktionsfähig 
werden.

ˎˎ In einigen Fällen können manche Clips 
wiederhergestellt werden, andere jedoch nicht. 
Die Wiedergabe wiederhergestellter Clips ist 
wieder möglich.
ˎˎ Wird bei dem Versuch, eine SxS-Speicherkarte 
wiederherzustellen, wiederholt die 
Meldung „Could not Restore Some Clips“ 
angezeigt, können Sie mit dem nachfolgend 
beschriebenen Verfahren die SxS-Speicherkarte 
ggf. wieder herstellen.

[1]	 Kopieren Sie die betreffenden Clips auf 
eine andere SxS-Speicherkarte.

[2]	 Formatieren Sie die unbrauchbare SxS-
Speicherkarte mit dem Gerät.

[3]	 Kopieren Sie die betreffenden Clips zurück 
auf die neu formatierte SxS-Speicherkarte.

[4]	 Aktualisieren Sie die Verwaltungsdatei wie 
nachfolgend beschrieben.

[Hinweis]
Verwenden Sie zur Wiederherstellung von Medien, die mit 
diesem Gerät aufgezeichnet wurden, auf jeden Fall dieses 
Gerät.
Medien, die mit einem anderen als diesem Gerät oder 
mit einem anderen Gerät mit einer anderen Version 
aufgezeichnet wurden (auch wenn es das gleiche Modell 
ist), werden mit diesem Gerät möglicherweise nicht 
wiederhergestellt.

Aktualisieren der Verwaltungsdatei

Wenn sich keine Clips wiedergeben lassen, kann 
die Aktualisierung der Verwaltungsdatei auf der 
Karte möglicherweise Abhilfe schaffen.
Verwenden Sie TC/Media > Update Media 
(Seite 62) im vollständigen Menü, um die 
Verwaltungsdatei zu aktualisieren.
Wenn Sie eine mit RAW Viewer V2.2 oder höher 
importierte XAVC-Datei direkt in das Verzeichnis 
„XDROOT\Clip“ einer SxS-Speicherkarte schreiben, 
wird die Datei ggf. abspielbar, indem Sie den 
Befehl Update Media ausführen.
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Sie können die Konfigurationsdatei der Kamera 
auf einer SD-Karte (optional) speichern. Die 
gespeicherte Datei kann von der SD-Karte geladen 
werden.

Unterstützte SD-Karten

SDHC-Speicherkarten* (Geschwindigkeitsklasse: 
4 bis 10, Nicht-UHS, Kapazität: 2 GB bis 32 GB)
SD-Speicherkarten* (Dateisystem: FAT 16, 
Kapazität: bis zu 2 GB)
*	 In diesem Handbuch als „SD-Karten“ bezeichnet.

Einführen einer SD-Karte

Setzen Sie einer SD-Karte in den SD-
Karteneinschub ein (Seite 12).
Die Anzeigeleuchte ACCESS (Seite 10) leuchtet 
rot auf und wechselt zu grün, sobald die 
Speicherkarte betriebsbereit ist.

Status der Anzeigeleuchte ACCESS

Leuchte Status des Einschubs

Leuchtet rot Zugriff auf die SD-Karte (Daten 
lesen/schreiben)

Aus ˎˎ Es ist keine SD-Karte eingesetzt.

ˎˎ Die eingesetzte Karte ist 
ungültig.

Entnehmen einer SD-Karte

Drücken Sie die SD-Karte etwas hinein, und 
entnehmen Sie dann die Karte.

[Hinweise]
ˎˎ Datensicherheit ist nicht gegeben, wenn während des 

Zugriffs auf die Speicherkarte die Spannungsversorgung 
ausgeschaltet oder die Karte entnommen wird. Die Daten 
auf der Karte können zerstört werden. Bevor Sie das 
Gerät ausschalten oder eine Speicherkarte entnehmen, 
vergewissern Sie sich, dass die Anzeigeleuchte ACCESS 
entweder grün leuchtet oder dunkel ist.
ˎˎ Achten Sie darauf, dass die Karte nicht herausspringt, 

wenn Sie sie einführen oder entfernen.

Formatieren (Initialisieren) einer 
SD-Karte

Bevor SD-Karten erstmalig im Gerät verwendet 
werden, müssen sie formatiert werden.
SD-Karten zur Verwendung im Gerät sollten 
mit der Formatierfunktion des Geräts formatiert 
werden. Eine SD-Speicherkarte muss auch dann 
formatiert werden, wenn beim Laden der Karte 
eine Warnmeldung erscheint.
Beim Laden einer SD-Karte ins Gerät, die mit 
einem nicht unterstützten Format formatiert 
wurde, erscheint eine Meldung darüber, dass das 
Dateisystem nicht übereinstimmt.

1	 Wählen Sie die TC/Media-Kategorie > Format 
Media > SD Card im Menü aus, und drücken 
Sie den Regler MENU.
Ein Bestätigungsbildschirm wird angezeigt, auf 
dem Sie gefragt werden, ob Sie die Karte 
formatieren möchten.

2	 Halten Sie die Tasten ITEM 1 und ITEM 3 drei 
Sekunden lang gedrückt, um die Formatierung 
durchzuführen.

Die Formatierung beginnt, wobei während der 
Ausführung eine Meldung angezeigt wird und 
die Anzeigeleuchte ACCESS rot leuchtet.
Zum Ende der Formatierung wird eine 
Abschlussmeldung angezeigt. Drücken Sie 
den Regler MENU, um die Meldung zu 
verwerfen.

[Hinweis]
Wenn eine SD-Karte formatiert wird, werden alle Daten 
gelöscht und können nicht wiederhergestellt werden.

Verwendung von Medien, die mit diesem Gerät 
formatiert wurden, in den Einschüben anderer 
Geräte

Erstellen Sie ein Backup des Mediums und 
formatieren Sie es dann mit dem anderen Gerät.

Umgang mit SD-Karten zum Speichern von Konfigurationsdaten
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Verwendung mit AXS-R7
Sie können Video/Audio als RAW oder X-OCN auf 
einem optionalen AXS-Recorder AXS-R7 (Access 
Memory Card System) aufzeichnen, indem Sie den 
Recorder am Gerät anbringen.

[Hinweis]
Um einen AXS-R7 am Gerät anzubringen, muss dessen 
Firmwareversion ggf. je nach Version des Geräts 
aktualisiert werden (Seite 29). Nachfolgend ist die 
Versionskompatibilität aufgeführt.

Version des Geräts Version des AXS-R7

1.0, 1.01 1.1

2.01 2.0

3.0 3.0

4.0 4.0

Anbringen des AXS-R7

[Hinweis]
Das Anbringen/Abnehmen des AXS-R7 sollte stattfinden, 
wenn das Gerät ausgeschaltet ist.

1	 Entfernen Sie die vier Sechskantschrauben 
(3 mm) an der Rückseite des Geräts, und 
entfernen Sie die Akkuplatte.

Akkuplatte

2	 Entfernen Sie die vier Sechskantschrauben an 
der Rückseite des AXS-R7, und entfernen Sie 
das Docking-Modul vom AXS-R7.

AXS-R7

Docking-Modul

3	 Bringen Sie den AXS-R7 am Gerät an, und 
ziehen Sie die vier Sechskantschrauben fest.

AXS-R7

Entfernen des AXS-R7

Entfernen Sie die vier Sechskantschrauben, und 
nehmen Sie den AXS-R7 ab.

Einsetzen einer AXS-Speicherkarte

1	 Drücken Sie auf die Öffnungstaste der 
Abdeckung der Speicherkarteneinschübe, um 
die Abdeckung zu öffnen.

2	 Führen Sie die AXS-Speicherkarte in den 
Karteneinschub ein; dabei sollte das Etikett in 
die unten angegebene Richtung weisen.

Etikett

3	 Schließen Sie die Abdeckung.

Umschaltung zwischen AXS-
Speicherkarten

Wenn zwei AXS-Speicherkarten eingesetzt sind, 
drücken Sie die Taste SLOT SELECT des AXS-R7, um 
den aktiven Einschub umzuschalten.

Taste SLOT SELECT

Entnehmen einer AXS-Speicherkarte

Öffnen Sie die Abdeckung des 
Speicherkarteneinschubs von AXS-R7, und ziehen 
Sie die AXS-Speicherkarte heraus.

[Hinweis]
Datensicherheit ist nicht gegeben, wenn während 
des Zugriffs auf eine AXS-Speicherkarte die 
Spannungsversorgung ausgeschaltet oder die Karte 
entnommen wird. Die Daten auf der Karte können zerstört 
werden. Bevor Sie das Gerät ausschalten oder eine 
Speicherkarte entnehmen, vergewissern Sie sich, dass die 
Anzeigeleuchte ACCESS entweder grün leuchtet oder dunkel 
ist.
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Aufzeichnen auf eine AXS-Speicherkarte

Mithilfe der Project-Kategorie > AXS Rec Format (Seite 44) im Menü können Sie das Format zum 
Aufzeichnen auf eine AXS-Speicherkarte auswählen.
Bei der AXS-Standalone-Aufnahme auf dem AXS-R7 wechselt die Aufnahme automatisch zur zweiten 
AXS-Speicherkarte, wenn die erste Karte voll ist.

Wenn Sie eine S24- oder S48-AXS-Speicherkarte verwenden, gelten je nach den Einstellungen für AXS 
Rec Format und Imager Mode die folgenden Einschränkungen. Wird eine S24 AXS-Speicherkarte bei einer 
Einstellung erkannt, in der S24 AXS-Speicherkarten nicht unterstützt werden, so wird eine Warnmeldung 
angezeigt.

AXS Rec Format Imager Mode Aufnahmebildrate und Unterstützung von S24-/S48-AXS-
Speicherkarte

24 25 30 48 50 60 75 110 120
X-OCN XT 3.8K 16:9 S24/

S48
S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – –

4K 2.39:1 – – – – – – – – S48

4K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48 –

4K 4:3 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –

4K 6:5 S24/
S48

S24/
S48

S24/
S48

– – – – – –

5.7K 16:9 S24/
S48

S24/
S48

S48 – – – – – –

6K 2.39:1 S24/
S48

S24/
S48

S24/
S48

– – – – – –

6K 17:9 S24/
S48

S24/
S48

S48 – – – – – –

6K 1.85:1 S24/
S48

S24/
S48

S48 – – – – – –

6K 3:2 S48 S48 S48 – – – – – –
RAW SQ 4K 17:9 S24/

S48
S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – – –

AXS Rec Format Imager Mode Aufnahmebildrate und Unterstützung von S24-/S48-AXS-
Speicherkarte

24 25 30 48 50 60 75 110 120
X-OCN ST 3.8K 16:9 S24/

S48
S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – –

4K 2.39:1 – – – – – – – – S48

4K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 –

4K 4:3 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 – –

4K 6:5 S24/
S48

S24/
S48

S24/
S48

– – – – – –

5.7K 16:9 S24/
S48

S24/
S48

S24/
S48

– – – – – –

6K 2.39:1 S24/
S48

S24/
S48

S24/
S48

– – – – – –

6K 17:9 S24/
S48

S24/
S48

S24/
S48

– – – – – –

6K 1.85:1 S24/
S48

S24/
S48

S24/
S48

– – – – – –

6K 3:2 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –

X-OCN LT 3.8K 16:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – –

4K 2.39:1 – – – – – – – – S24/
S48

4K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

–

4K 4:3 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– –

4K 6:5 S24/
S48

S24/
S48

S24/
S48

– – – – – –

5.7K 16:9 S24/
S48

S24/
S48

S24/
S48

– – – – – –

6K 2.39:1 S24/
S48

S24/
S48

S24/
S48

– – – – – –

6K 17:9 S24/
S48

S24/
S48

S24/
S48

– – – – – –

6K 1.85:1 S24/
S48

S24/
S48

S24/
S48

– – – – – –

6K 3:2 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 – – –
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Formatieren (Initialisieren) einer 
AXS-Speicherkarte

Bevor AXS-Speicherkarten erstmalig im am Gerät 
angebrachten AXS-R7 verwendet werden, müssen 
sie formatiert werden.
Verwenden Sie die Formatierfunktion des Geräts, 
um AXS-Speicherkarten zur Verwendung im 
AXS-R7 zu formatieren. Eine AXS-Speicherkarte 
muss auch dann formatiert werden, wenn beim 
Einschalten des Geräts mit angebrachtem AXS-R7 
eine Warnmeldung erscheint.
Beim Laden einer AXS-Speicherkarte, die mit 
einem vom AXS-R7 nicht unterstützten Format 
formatiert wurde, erscheint eine Meldung darüber, 
dass das Dateiystem nicht übereinstimmt.

1	 Wählen Sie die TC/Media-Kategorie > Format 
Media im Menü aus, und drücken Sie den 
Regler MENU.

2	 Wählen Sie AXS Slot A (Einschub A) oder AXS 
Slot B (Einschub B) aus.
Ein Bestätigungsbildschirm wird angezeigt, auf 
dem Sie gefragt werden, ob Sie die Karte 
formatieren möchten.

3	 Halten Sie die Tasten ITEM 1 und ITEM 3 drei 
Sekunden lang gedrückt, um die Formatierung 
durchzuführen.
Die Formatierung beginnt, wobei während der 
Ausführung eine Meldung angezeigt wird und 
die Anzeigeleuchte ACCESS rot leuchtet.
Zum Ende der Formatierung wird eine 
Abschlussmeldung angezeigt. Drücken Sie 
den Regler MENU, um die Meldung zu 
verwerfen.

[Hinweis]
Wenn eine Speicherkarte formatiert wird, werden alle Daten 
gelöscht und können nicht wiederhergestellt werden.

Prüfen der verbleibenden 
Aufnahmedauer

Während der Aufnahme (Aufzeichnung oder 
Standby) können Sie die verbleibende Kapazität 
einer geladenen AXS-Speicherkarte anhand der 
Anzeige für verbleibende Kapazität auf dem 
Bildschirm Home des Subdisplays (Seite 31) oder 
im Sucher/auf dem Monitorbildschirm (Seite 13) 
prüfen.
Die für die Aufzeichnung im aktuellen Videoformat 
(Aufzeichnungs-Bitrate) verbleibende Zeit wird 
entsprechend dem noch freien Speicherplatz auf 
der Karte berechnet und in Minuten angezeigt.

[Hinweis]
Wenn eine AXS-Speicherkarte schreibgeschützt ist, wird das 
Symbol  angezeigt.

Wiederherstellen einer AXS-
Speicherkarte

Falls an einer Speicherkarte ein Fehler auftritt, 
muss die Karte vor erneuter Verwendung 
wiederhergestellt werden.
Wird eine AXS-Speicherkarte geladen, die 
wiederhergestellt werden muss, werden 
Sie durch eine Meldung aufgefordert, einen 
Wiederherstellungsvorgang auszuführen.
Um die Wiederherstellung zu beginnen, wählen 
Sie Execute aus, indem Sie den Regler MENU 
drehen. Drücken Sie dann den Regler MENU.
Die Wiederherstellung beginnt.
Während der Ausführung wird eine Meldung 
angezeigt, und die Anzeigeleuchte ACCESS 
leuchtet rot.
Zum Ende der Wiederherstellung wird eine 
Abschlussmeldung angezeigt. Drücken Sie den 
Regler MENU, um die Meldung zu verwerfen.

Wenn die Wiederherstellung fehlschlägt

ˎˎ Eine mit Schreibschutz versehene AXS-
Speicherkarte oder eine Speicherkarte, an 
der ein Fehler aufgetreten ist, kann nicht 
wiederhergestellt werden. In diesem Fall wird 
eine Warnmeldung angezeigt. Heben Sie 
den Schreibschutz auf oder tauschen Sie die 
Karte entsprechend den Anweisungen in der 
Meldung aus.
ˎˎ Eine fehlerhafte AXS-Speicherkarte kann durch 
erneute Formatierung ggf. wieder funktionsfähig 
werden.
ˎˎ In einigen Fällen können manche Clips 
wiederhergestellt werden, andere jedoch nicht. 
Die Wiedergabe wiederhergestellter Clips ist 
wieder möglich.

[Hinweis]
Verwenden Sie zur Wiederherstellung von Medien, die mit 
diesem Gerät aufgezeichnet wurden, auf jeden Fall dieses 
Gerät.
Medien, die mit einem anderen als diesem Gerät oder 
mit einem anderen Gerät mit einer anderen Version 
aufgezeichnet wurden (auch wenn es das gleiche Modell 
ist), werden mit diesem Gerät möglicherweise nicht 
wiederhergestellt.

Aktualisieren der Verwaltungsdatei

Wenn sich keine Clips wiedergeben lassen, kann 
die Aktualisierung der Verwaltungsdatei auf der 
Karte möglicherweise Abhilfe schaffen.
Verwenden Sie TC/Media > Update Media 
(Seite 62) im vollständigen Menü, um die 
Verwaltungsdatei zu aktualisieren.

Aktualisieren der Firmwareversion 
des AXS-R7

Sie können die Version der Firmware des AXS-R7 
aktualisieren, während dieser am Gerät angebracht 
ist.

[Hinweise]
ˎˎ Die Firmwareversion des Geräts muss 2.0 oder höher sein, 

um diesen Vorgang durchzuführen.
ˎˎ Stellen Sie AXS Rec Format (Seite 44) auf Rec Off, bevor 

Sie diesen Vorgang durchführen.

1	 Bereiten Sie gemäß dem Aktualisierungsvorgang 
für den AXS-R7 einen USB-Massenspeicher als 
Aktualisierungsmedium vor.

2	 Stecken Sie das Aktualisierungsmedium in den 
Anschluss für externe Geräte (Seite 12).

3	 Führen Sie die Aktualisierungsfunktion für den 
AXS-R7 mithilfe von Maintenance > Firmware > 
FW Update-AXS-R7 (Seite 72) im Menü aus.
Der Vorgang zur Versionsaktualisierung dauert 
etwa 15 Minuten. Sobald die 
Versionsaktualisierung abgeschlossen ist, 
startet das Gerät automatisch neu, und es wird 
„Firmware Upgrade Done“ angezeigt.
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Subdisplay
Auf dem Subdisplay werden die Bildschirme Home, Clip List, Playback, Menu, Full Menu und User Functions angezeigt.
Sie können mithilfe der Tasten auf der Assistentenseite des Geräts zwischen den Bildschirmen des Subdisplays wechseln.

 

Bildschirm User Functions

Bildschirm Home Bildschirm Clip List

Bildschirm Menu Bildschirm Full Menu

Bildschirm Playback

Taste USER

Taste USER

Taste MENU

Taste HOME

Taste HOME

Taste HOME

Taste CLIPS

Taste CLIPS

Taste CLIPS

Taste USER

Taste MENU

Taste MENU
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Bildschirm Home

Drücken Sie die Taste HOME auf der Assistentenseite, um den Bildschirm Home anzuzeigen. Über den 
Bildschirm Home können Sie den Status des Geräts prüfen und grundlegende Einstellungen für das Gerät 
vornehmen.

Name der Option/
Einstellwert/
Funktionsanzeige-
bereich

Statusanzei-
gebereich

Name der Option/Einstellwert/
Funktionsanzeigebereich

1 2 3

4 5 6

Taste ITEM 4 Taste ITEM 5 Taste ITEM 6

Taste ITEM 3Taste ITEM 2Taste ITEM 1

[Hinweis]
Die mit 1 bis 6 beschrifteten Bereiche entsprechen den 
Tasten ITEM 1 bis 6 (Seite 39). Drücken Sie auf eine Taste 
ITEM, um die entsprechende Option auszuwählen. Die mit 
oranger Textfarbe angezeigten Tasten ITEM für Funktionen 
sind aktiviert.

1.	 FPS
Dient zum Anzeigen und Einstellen der 
Videobildrate.

2.	 Exposure Index/Gain
Dient zum Anzeigen und Einstellen des 
Belichtungsindex (Exposure Index, EI; oberes 
Symbol zeigt die ISO-Basisempfindlichkeit) 
oder des von einer RM-B170 oder einer 
anderen Fernbedienung eingestellten 
Verstärkungswerts.

	 [Hinweis]
Der Verstärkungswert wird nur angezeigt, wenn im 
vollständigen Menü Technical > System Configuration > 
RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

3.	 Shutter
Dient zum Anzeigen und Einstellen von 
Verschlusszeit/Verschlusswinkel des 
elektronischen Verschlusses.

4.	 ND Filter
Dient zum Anzeigen und Einstellen der ND-
Filterposition.

5.	 LUT
Dient zum Anzeigen und Einstellen der 
Monitor-LUT.

6.	 WB (White Balance)
Dient zum Anzeigen und Einstellen des 
Weißwerts.

Statusanzeigebereich

1

9

2 3

5

4

7 6810

13
12
11

1.	 Zeitdatenanzeige
Zeigt je nach Einstellung der TC/Media-
Kategorie > TC Display im Menü (Seite 44) 
die Dauer oder den Zeitcode an.
Der Typ der aktuell in der Zeitdatenanzeige 
eingeblendeten Daten wird wie folgt 
angezeigt.
TCG: Aufgenommener Zeitcode
TCR: Wiedergabe-Zeitcode
Dur: Dauer

2.	 Einzelbildratenanzeige
Zeigt den Wert der Einstellung der Project-
Kategorie > Project Frame Rate im Menü an 
(Seite 44).

3.	 Imager Mode-Anzeige
Zeigt die Einstellung der Project-Kategorie > 
Imager Mode im Menü sowie 
Entzerrungsinformationen an.

4.	 Clipnamenanzeige
Zeigt „Reel: Camera ID + Reel Number“ und 
„ShotNumber“ an.

5.	 Tonpegelmesser
Zeigt die Pegel der Tonaufzeichnung oder 
-wiedergabe an. Die Ziffern 1 und 2 stehen für 
die Kanäle 1 und 2.

6.	 Anzeige für gleichzeitige Aufzeichnung
Wenn gleichzeitige Aufnahme 1 Einschub für 
das angezeigte Medium konfiguriert wurde, 
erscheint rechts vom angezeigten 
Hauptaufnahmeformat ein Symbol „Sub“.

7.	 Anzeige des Aufzeichnungsformats (Codec)
Zeigt das Format der Aufzeichnung auf einer 
AXS-Speicherkarte oder einer SxS-
Speicherkarte an (Seite 48).

8.	 Spannung der Stromversorgung/Anzeige 
der verbleibenden Akkuladung
Zeigt die Spannung der Stromversorgung oder 
die verbleibende Akkuladung an.

9.	 Anzeige der verbleibenden Medienkapazität
Zeigt das Symbol des aktiven Mediums, den 
Medientyp, den Einschubtyp (A/B) sowie die 
verbleibende Aufnahmedauer (bei Aufnahme 
im aktuellen Aufzeichnungsformat) an.
Es wird außerdem während der Wiedergabe 
der Clipname angezeigt.

10.	 Anzeige des Aufnahmestatus
Zeigt die folgenden Aufnahmestatus des 
Geräts an.

Display Beschreibung

Stby Aufnahme-Standby

 Rec Aufnahme

 Cache Aufnahme-Standby mit 
Bildpuffer

11.	 Thermometersymbol
Wird angezeigt, wenn eine Warnmeldung zu 
hoher Temperatur ausgegeben wird.
Die Beschreibung wird in der Info-Kategorie im 
Menü angezeigt.
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12.	 Warnsymbol
Wird angezeigt, wenn eine Warnmeldung 
(ausgenommen Warnmeldungen zu hoher 
Temperatur) ausgegeben wird.
Die Beschreibung wird in der Info-Kategorie im 
Menü angezeigt.

13.	 Symbol Ext-LK
Wird angezeigt, wenn der interne 
Zeitcodegenerator mit einem am Anschluss TC 
IN (Zeitcode-Eingang) eingespeisten externen 
Signal synchronisiert ist.
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Funktionen auf dem Bildschirm Home des Subdisplays
Basisfunktionen

1	 Drücken Sie die Taste HOME.
Der Bildschirm Home wird angezeigt.

2	 Wählen Sie mithilfe der Tasten ITEM 1 bis 6 die 
einzustellende Option.
Der Einstellwert für änderbare Optionen wird 
orange angezeigt.
Die nachfolgende Abbildung zeigt ein Beispiel, 
wenn die Taste ITEM 3 gedrückt wird.

3	 Bewegen Sie den Cursor mithilfe der Taste  
(Taste ITEM 2), der Taste  (Taste ITEM 5) oder 
des Reglers MENU auf die auszuwählende 
Optionen oder den Einstellwert.

4	 Drücken Sie den Regler MENU oder die Taste 
Set (Taste ITEM 3), um die Einstellung zu 
übernehmen.

Ändern der Helligkeit des Subdisplays

Sie können die Helligkeit des Subdisplays mithilfe 
von Technical > Control Display > Brightness level 
(Seite 71) im vollständigen Menü ändern.
Auf dem Bildschirm Home können Sie auch die 
Taste BACK gedrückt halten und den Regler MENU 
im Uhrzeigersinn drehen, um die Helligkeit des 
Subdisplays in der Reihenfolge Minimum  Low 
 Mid  High ausgehend von der aktuellen 
Einstellung zu ändern.
Sie können ebenso die Taste BACK gedrückt 
halten und den Regler MENU entgegen dem 
Uhrzeigersinn drehen, um die Helligkeit des 
Subdisplays in der Reihenfolge High  Mid  
Low  Minimum ausgehend von der aktuellen 
Einstellung zu ändern.

[Hinweis]
Die Einstellung der Anzeigehelligkeit ist für das Subdisplay 
und das Minidisplay gleich. Sie wird auf beiden Displays 
umgesetzt.

Anzeige und Betrieb, wenn RM/RCP Paint Control 
aktiviert ist

ˎˎ Wenn im vollständigen Menü Technical > 
System Configuration > RM/RCP Paint Control 
(Seite 68) auf On eingestellt ist, wird im EI-
Anzeigebereich der von einer RM-B170 oder 
einer anderen Fernbedienung eingestellte 
Verstärkungswert angezeigt. In diesem Modus 
wird der EI-Anzeigebereich abgeblendet und 
die EI- und Verstärkungswerte können nicht 
geändert werden. Die Einstellung ISO Base kann 
jedoch umgeschaltet werden.  
Auch in diesem Fall wird der LUT-Anzeigebereich 
abgeblendet und kann nicht geändert werden.
ˎˎ Die folgenden Anzeigebereiche sind 
abgeblendet und können nicht bedient 
werden, wenn eine RM-B170 oder andere 
Fernbedienung angeschlossen ist und im 
vollständigen Menü Technical > System 
Configuration > RM/RCP Paint Control 
(Seite 68) auf On eingestellt ist. Nehmen Sie 

diese Einstellungen mit der Fernbedienung vor 
(Seite 87).
ˎˎ Anzeigebereich für Verschluss
ˎˎ Anzeigebereich für Weißabgleich

Step Edit-Bedienung

Sie können die zur Auswahl verfügbaren 
Einstellungen ändern, wenn in Schritt 2 der 
Basisfunktionen „Step Edit“ für die Taste ITEM 
4 angezeigt wird. Auf dem Bildschirm zur 
Bearbeitung von Einstellungen können Sie 
Einstellungen hinzufügen oder löschen. Bewegen 
Sie auf dem Bildschirm zur Auswahl von 
Einstellungen den Cursor auf die zu ändernde oder 
zu löschende Einstellung.

1	 Drücken Sie dann auf die Taste Step Edit (Taste 
ITEM 4).
Der Bildschirm zur Bearbeitung von 
Einstellungen wird angezeigt.

2	 Um eine Einstellung zu löschen, drücken Sie die 
Taste Delete (Taste ITEM 4).

	 [Hinweis]
Die ausgewählte Einstellung kann gelöscht werden, 
wenn das Wort „Delete“ orange angezeigt wird.

3	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um die Einstellung zu ändern.

4	 Drücken Sie abschließend die Taste Add (Taste 
ITEM 4).
Die Einstellung wird hinzugefügt und es wird 
wieder der Bildschirm zur Auswahl von 
Einstellungen angezeigt.

	 [Hinweis]
Eine Einstellung kann hinzugefügt werden, wenn das 

Wort „Add“ orange angezeigt wird.

Beim Einstellen von White Balance

Auf dem Bildschirm zum Einstellen von White 
Balance können Sie die Taste Coarse/Fine (Taste 
ITEM 1) drücken, um das Inkrement für eine 
Stufe auf grob oder fein festzulegen. Sie können 
außerdem die Taste Temp/Tint (Taste ITEM 3) 
drücken, um den Wert zwischen Farbtemperatur 
(Temp) und Farbton (Tint) umzuschalten.

FPS-Betrieb

Drücken Sie auf dem Bildschirm Home die 
Taste ITEM 1, um den Bildschirm für FPS-Betrieb 
aufzurufen. Sie können die Taste Variable/Fixed 
(Taste ITEM 4) drücken, um zwischen „Fixed“ für 
Aufnahme mit konstanter Geschwindigkeit und 
„Variable (Select FPS)“ für Aufnahme mit variabler 
Geschwindigkeit umzuschalten.
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[Hinweis]
Im Modus „Select FPS“ wird kein Ton aufgezeichnet.

EI-Betrieb

Ändern des EI-Werts

Mithilfe der Taste ITEM 2 auf dem Bildschirm Home 
können Sie den EI-Wert ändern.

1	 Drücken Sie auf dem Bildschirm Home die 
Taste ITEM 2.
Der Bildschirm für die EI-Konfiguration wird 
angezeigt.

2	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um die Einstellung zu ändern.

3	 Drücken Sie den Regler MENU oder die Taste 
Set (Taste ITEM 3), um die Einstellung zu 
übernehmen.

Umschalten von Base ISO

Durch Drücken der Taste ITEM 4 auf dem 
Bildschirm für die EI-Konfiguration können Sie die 
ISO-Basisempfindlichkeit umschalten.

1	 Drücken Sie auf dem Bildschirm für die EI-
Konfiguration die Taste ITEM 4.
Der Bildschirm zum Umschalten von Base ISO 
wird angezeigt.

2	 Drücken Sie gleichzeitig die zwei Change-
Tasten (Taste ITEM 1 und Taste ITEM 3).

Die ISO-Basisempfindlichkeit wird geändert.
(Seite 38)

AWB-Betrieb

Drücken Sie auf dem Bildschirm Home die Taste 
ITEM 6, um den Bildschirm für Weißabgleich-
Betrieb aufzurufen. Drücken Sie die Taste Auto 
White Bal. (Taste ITEM 1), um den Weißabgleich 
durchzuführen. Sie können auch Temp/
Tint (Taste ITEM 3) drücken, um den Wert 
zwischen Farbtemperatur (Temp) und Farbton 
(Tint) umzuschalten und per Feineinstellung 
anzupassen. Drücken Sie zum Abschluss Add 
(Taste ITEM 4), um die Einstellung zu den Stufen 
hinzuzufügen.

[Hinweis]
Nehmen Sie während des AWB-Betriebs eine weiße Karte bei 
gleichmäßigen Beleuchtungsbedingungen auf.

LUT-Funktionen

Festlegen einer LUT

Mithilfe der Taste ITEM 5 auf dem Bildschirm Home 
können Sie für jedes Ausgabesystem eine LUT 
festlegen.

1	 Drücken Sie auf dem Bildschirm Home die 
Taste ITEM 5.
Der LUT-Auswahlbildschirm wird angezeigt.

Der LUT-Auswahlbildschirm besitzt zwei 
Seiten, zwischen denen Sie wechseln können, 
indem sie die Taste ITEM 1 drücken.
Auf Seite 1 können Sie die LUT-Einstellungen 
für SDI 1/2 (nur Anzeige), SDI 3/4, Monitor und 
HDMI festlegen.
Auf Seite 2 können Sie die LUT-Einstellungen 
für den Sucher, SxS Rec und Sub Rec festlegen.

2	 Wählen Sie mithilfe der Tasten ITEM 2, 3, 5 und 
6 den gewünschten Ausgang aus.
Der Bildschirm zur Bearbeitung von 
Einstellungen wird angezeigt.

3	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um die Einstellung zu ändern.

4	 Drücken Sie den Regler MENU oder die Taste 
Set (Taste ITEM 3), um die Einstellung zu 
übernehmen.

Ändern des Preset Look

Sie können eine LUT festlegen, wenn Sie Look auf 
dem LUT-Auswahlbildschirm mithilfe der Taste Edit 
Look (Taste ITEM 4) auf Seite 1 oder 2 ausgewählt 
haben.

1	 Drücken Sie auf dem LUT-Auswahlbildschirm 
die Taste Edit Look (Taste ITEM 4).
Der Look-Auswahlbildschirm wird angezeigt.
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2	 Drücken Sie die Taste Select (Taste ITEM 3).
Die auswählbaren Optionen werden 
angezeigt.

3	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um die Einstellung zu ändern.

4	 Drücken Sie den Regler MENU oder die Taste 
Set (Taste ITEM 3), um die Einstellung zu 
übernehmen.

Ändern der LUT-Kategorie

Sie können die Zielkategorie für LUT-Funktionen 
auf User 3D LUT oder Preset Look ändern.

1	 Drücken Sie auf dem LUT-Auswahlbildschirm 
die Taste Edit Look (Taste ITEM 4).
Der Look-Auswahlbildschirm wird angezeigt.

2	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um die Auswahl der Kategorie zu aktivieren.

3	 Drücken Sie den Regler MENU oder die Taste 
Select (Taste ITEM 3).

4	 Drücken Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um eine Kategorie auszuwählen (User 3D LUT 
oder Preset Look).

5	 Drücken Sie den Regler MENU oder die Taste 
Set (Taste ITEM 3), um die Einstellung zu 
übernehmen.

Laden einer User 3D LUT-Datei

Sie können eine auf einer SD-Karte gespeicherte 
User 3D LUT-Datei ins Gerät laden.

[Hinweis]
Speichern Sie die User 3D LUT-Datei auf der SD-Karte in dem 
folgenden Verzeichnis (Seite 86).
PRIVATE\SONY\PRO\LUT\

1	 Setzen Sie eine SD-Karte in den SD-
Karteneinschub ein (Seite 12).

2	 Drücken Sie auf dem LUT-Auswahlbildschirm 
die Taste Edit Look (Taste ITEM 4).
Der Look-Auswahlbildschirm wird angezeigt.

3	 Drücken Sie die Taste Load File (Taste ITEM 4).

4	 Drücken Sie den Regler MENU oder die Taste 
Select (Taste ITEM 3).
Die Ladezielnummern (01 bis 16) werden 
angezeigt.
Für geladene Nummern wird ein Dateiname 
angezeigt.

5	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um eine Ladezielnummer auszuwählen.

6	 Drücken Sie den Regler MENU oder die Taste 
Select (Taste ITEM 3).
Der Name der auf der SD-Karte gespeicherten 
User 3D LUT-Datei wird angezeigt.

7	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um eine Datei auszuwählen.

8	 Drücken Sie den Regler MENU oder die Taste 
Load (Taste ITEM 3).
Nachdem die Datei erfolgreich geladen wurde, 
wird „Successfully loaded“ angezeigt.

9	 Drücken Sie die Taste OK (Taste ITEM 6).

Laden einer ASC-CDL-Datei

Sie können eine auf einer SD-Karte gespeicherte 
ASC-CDL-Datei ins Gerät laden.

[Hinweis]
Speichern Sie die ASC-CDL-Datei auf der SD-Karte in dem 
folgenden Verzeichnis (Seite 86).
PRIVATE\SONY\PRO\CDL\

1	 Setzen Sie eine SD-Karte in den SD-
Karteneinschub ein (Seite 12).

2	 Drücken Sie auf dem LUT-Auswahlbildschirm 
die Taste Edit Look (Taste ITEM 4).
Der Look-Auswahlbildschirm wird angezeigt.

3	 Drücken Sie die Taste Load File (Taste ITEM 4).

4	 Wählen Sie Load ASC CDL File und drücken Sie 
den Regler MENU oder die Taste Select (Taste 
ITEM 3).
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Der Name der auf der SD-Karte gespeicherten 
ASC-CDL-Datei wird angezeigt.

5	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um eine Datei auszuwählen.

6	 Drücken Sie den Regler MENU oder die Taste 
Load (Taste ITEM 3).
Sie können die Taste Load All Files drücken 
(Taste ITEM 1), um alle Dateien zu laden.
Nachdem die Datei erfolgreich geladen wurde, 
wird „Successfully loaded“ angezeigt.

7	 Drücken Sie die Taste OK (Taste ITEM 6).

8	 Legen Sie die in ASC CDL Process die ASC-CDL-
Verarbeitungssequenz fest.

Wechseln der User 3D LUT-Datei

Sie können die gegenwärtig ausgewählte User 3D 
LUT-Datei wechseln.

1	 Drücken Sie auf dem LUT-Auswahlbildschirm 
die Taste Edit Look (Taste ITEM 4).
Der Look-Auswahlbildschirm wird angezeigt.

2	 Drücken Sie den Regler MENU oder die Taste 
Select (Taste ITEM 3).

3	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um die User 3D LUT-Datei zu wechseln.

4	 Drücken Sie den Regler MENU oder die Taste 
Set (Taste ITEM 3), um die Einstellung zu 
übernehmen.

Wechseln der ASC-CDL-Datei

Sie können die aktuell ausgewählte ASC-CDL-Datei 
wechseln.

1	 Drücken Sie auf dem LUT-Auswahlbildschirm 
die Taste Edit Look (Taste ITEM 4).
Der Look-Auswahlbildschirm wird angezeigt.

2	 Wählen Sie ASC CDL Select und drücken Sie 
den Regler MENU oder die Taste Select (Taste 
ITEM 3).

3	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um die ASC-CDL-Datei zu wechseln.

4	 Drücken Sie den Regler MENU oder die Taste 
Set (Taste ITEM 3), um die Einstellung zu 
übernehmen.

Anzeigen der ASC-CDL-Informationen

Sie können Informationen zur aktuell 
ausgewählten ASC-CDL-Datei anzeigen.

1	 Drücken Sie auf dem LUT-Auswahlbildschirm 
die Taste Edit Look (Taste ITEM 4).
Der Look-Auswahlbildschirm wird angezeigt.

2	 Wählen Sie ASC CDL Select und drücken Sie 
die Taste ASC CDL Info (Taste ITEM 1).

Die ASC-CDL-Informationen werden angezeigt.

Hinweise zu den Einstellbereichen in ASC CDL-
Dateien

Die Einstellbereiche der ASC CDL-Datei sind 
nachfolgend aufgeführt. Dateien, in denen die 
Bereiche überschritten werden, können nicht 
geladen werden.
Slope: 0.000 bis 3.999
Offset: –1.000 bis 1.000
Power: 0.400 bis 4.000
Saturation: 0.000 bis 3.999
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Optionen des Bildschirms Home auf dem Subdisplay

Die Namen von Optionen und entsprechenden Einstellwerten werden nachfolgend aufgeführt.
Die Voreinstellungswerte sind unterstrichen und in Fettdruck.

[Hinweis]
Der Maximalwert der Aufnahmebildrate variiert je nach Aufzeichnungsformat. Der Maximalwert der Aufnahmebildrate ist 
während SxS-Alleinaufnahme und gleichzeitiger AXS/SxS-Aufnahme wie folgt beschränkt.
4K/QFHD XAVC Intra Class 480: max. 30 fps
4K/QFHD XAVC Intra Class 300: max. 60 fps
MPEG HD 422 Codec: max. 30 fps
ProRes Codec: max. 60 fps

Option Beschreibung

FPS Legt die Aufnahmebildrate fest.
Variable/Fixed: Umschalten zwischen Aufnahme mit variabler und konstanter 
Geschwindigkeit.
Wenn „Fixed“ ausgewählt ist, wird die Einstellung von der Einstellung für Kategorie 
Project > Project Frame Rate (Seite 44) im Menü bestimmt.

Project Frame Rate Display

23.98 Fixed-24

24 Fixed-24

25 Fixed-25

29.97 Fixed-30

47.95 Fixed-48

50 Fixed-50

59.94 Fixed-60

Wenn „Variable“ ausgewählt ist, wechselt die Einstellung abhängig von der 
Einstellung für Kategorie Project > Imager Mode (Seite 58) im Menü wie folgt.

Imager Mode Einstellung

3.8K 16:9
4K 17:9

1 bis 60 FPS

4K 17:9 1) 1 bis 60, 66, 72, 75, 88, 90, 96, 
100, 110 FPS

3.8K 16:9 Surround View
4K 17:9 Surround View
4K 4:3

1 bis 48 FPS

4K 4:3 1) 1 bis 60, 66, 72, 75 FPS

4K 2.39:1 1) 120 FPS

4K 4:3 Surround View
4K 6:5
5.7K 16:9
6K 2.39:1
6K 17:9
6K 1.85:1

1 bis 30 FPS

6K 3:2 1 bis 25 FPS

6K 3:2 1) 1 bis 60 FPS
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Option Beschreibung

Exposure Index Stellt den EI-Wert ein. Sie können die Einstellung Base ISO ändern, indem Sie die 
Taste Change Base (Taste ITEM 4) und dann auf dem folgenden Bildschirm 
gleichzeitig die beiden Change-Tasten (Taste ITEM 1 und Taste ITEM 3) drücken. 
Die verfügbaren Einstellungen variieren je nach der Einstellung Base ISO 
folgendermaßen.
Base ISO 500:

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/1250EI/ 
1600EI/2000EI

Base ISO 2500:
640EI/800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/5000EI/ 
6400EI/8000EI/10000EI

Shutter Stellt den Verschlusswinkel/die Verschlussgeschwindigkeit des elektronischen 
Verschlusses ein.
Drücken Sie die Taste Step/Cont. (Taste ITEM 1), um zwischen Stufen- und 
kontinuierlicher Auswahlmethode zu wechseln.
Step: Wählen Sie aus bis zu 16 registrierten Voreinstellungswerten für den 
Verschluss. Sie können nach der Auswahl jeden Wert vom Voreinstellungswert 
ändern, indem Sie die Taste Step Edit (Taste ITEM 4) drücken.

Zeigt je nach Einstellung für Technical > System Configuration > Shutter 
Mode (Seite 68) im vollständigen Menü die folgenden Auswahloptionen 
an.

Angle: Anzeige des Verschlusswinkels

Voreingestellte Auswahloptionen
360/180/172.8/144/90/45/22.5/11.2/5.6

Speed: Anzeige der Verschlussgeschwindigkeit

Voreingestellte Auswahloptionen
1/24, 1/25, 1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000 2)

[Hinweis]
Die voreingestellten Geschwindigkeitswerte für unterschiedliche Einstellungen des 
Werts Project Frame Rate (Seite 44) sind nachfolgend aufgeführt.
23.98/24: 1/24, 25: 1/25, 29.97: 1/30, 47.95: 1/48, 50: 1/50, 59.94: 1/60

Cont.: Wählen Sie innerhalb des unterstützten Bereichs einen Winkel/eine 
Geschwindigkeit aus.

ND Filter Legt die ND-Filterposition fest. Die folgenden Einstellungen sind verfügbar.
Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

Option Beschreibung

LUT Einstellungen bezüglich der auf das Ausgangsvideo anzuwendenden LUT.

Page 1

SDI 1/2 (Taste ITEM 2): Log
Nur Anzeige, da die LUT nicht auf das SDI 1/2-Ausgangsbild angewendet 
werden kann.

SDI 3/4 (Taste ITEM 3): Log/Look
Wählt die auf das SDI 3/4-Ausgangsbild anzuwendende LUT aus.
Deaktiviert, wenn im Menü die Monitoring-Kategorie > Output Format > SDI 
1/2 auf 4K/QFHD eingestellt ist.

Monitor (Taste ITEM 5): Log/s709/R709(800%)
Auswahl wird zu Log/Look, wenn im Menü die Monitoring-Kategorie > 
Output Format > SDI 1/2 auf 4K/QFHD eingestellt ist.

HDMI (Taste ITEM 6): Log/s709/R709(800%)
Auf Log festgelegt, wenn im Menü die Monitoring-Kategorie > Output Format 
> SDI 1/2 auf 4K/QFHD und HDMI auf 4K/QFHD eingestellt ist. In allen 
anderen Fällen sind die Optionen die gleichen wie für Monitor.

Page 2

Viewfinder (Taste ITEM 2): Log/s709/R709(800%)
Wählt die auf das Ausgangsbild des Suchers/Monitorbildschirms 
anzuwendende LUT aus.

SxS Rec (Taste ITEM 5): Log/Look
Deaktiviert bei Einstellung der Project-Kategorie > SxS Rec Format auf Rec Off 
im Menü; auf Log festgelegt bei Einstellung auf XAVC.

Sub Rec (Taste ITEM 6): Log/Look
Deaktiviert bei Einstellung der Project-Kategorie > SxS Rec Format auf Rec Off 
im Menü.

Gemeinsame Optionen Page 1/2

Edit Look: Legt eine als Look anzuwendende LUT fest.
s709 / R709(800%) / S-Gamut3.Cine/SLog3 / S-Gamut3/SLog3 / User 3D LUT

WB (White Balance) Stellt die Farbtemperatur/den Farbton des Weißwerts ein.
Voreingestellte Auswahloptionen

3200K+00/4300K+00/5500K+00
Sie können den voreingestellten Weißwert ändern, indem Sie die Taste Step Edit 
(Taste ITEM 4) drücken.
Auto White Bal.: Automatischen Weißabgleich durchführen.

1)	 Nur wenn eine High Frame Rate-Lizenz aktiviert ist.
2)	 Die Optionen lauten 1/60 und nachfolgende Werte bei einer Projektbildrate von 59.94, 1/50 und nachfolgende Werte bei 

50.0, 1/30 und nachfolgende Werte bei 29.97 sowie 1/25 und nachfolgende Werte bei 25.0.
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Bildschirm User Functions
Sie können die Taste USER (Seite 10) zum 
Anzeigen der Bildschirms User Functions auf dem 
Subdisplay drücken und die Tasten ITEM 1 bis 5 
als belegbare Funktionstasten verwenden (User 1 
bis 5).
Außerdem gibt es am Gerät vier belegbare 
Funktionstasten (1 bis 4) (Seiten 8, 9, 
10) und am Sucher (DVF-EL200) drei belegbare 
Funktionstasten (A bis C), denen Sie verschiedene 
Funktionen zuweisen können.
Zusätzlich zur Verwendung von Project > 
Assignable Button im vollständigen Menu können 
diesen Tasten mithilfe des Bildschirms User 
Functions Funktionen zugewiesen werden.

 Taste ITEM 4 Taste ITEM 5 Taste ITEM 6

Taste ITEM 3Taste ITEM 2Taste ITEM 1

[Hinweis]
Wenn ein Objektiv angebracht ist, das die Funktion zur 
Anzeige der Blendeneinstellung unterstützt, wird die 
Blendenposition mittig links im Bildschirm User Functions 
angezeigt.

Ändern der Tastenfunktionen
Den Auswahlbildschirm für Benutzerfunktionen 
rufen Sie auf, indem Sie die Taste Edit (Taste ITEM 
6) auf dem Bildschirm User Functions drücken. Auf 
dem Auswahlbildschirm für Benutzerfunktionen 
können Sie die Funktionen der Tasten User 1 bis 5, 
der belegbaren Funktionstasten 1 bis 4 sowie der 
belegbaren Funktionstasten A bis C am Sucher 
festlegen.

1	 Bewegen Sie auf dem Auswahlbildschirm für 
Benutzerfunktionen den Cursor auf die zu 
ändernde Taste. Drücken Sie dann auf die Taste 
Select (Taste ITEM 3).
Die auswählbaren Funktionen werden 
angezeigt.

2	 Verwenden Sie die Taste  (Taste ITEM 2), die 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um die Einstellung zu ändern.

3	 Drücken Sie abschließend die Taste Set (Taste 
ITEM 3).
Auf dem Display wird wieder der Bildschirm 
User Functions mit der geänderten Funktion 
angezeigt.

In den nachfolgenden Tabellen sind die werkseitig bei Auslieferung zugewiesenen Funktionen aufgeführt.

Taste Funktion Einstellung der belegbaren 
Funktionstaste

Funktionstaste 1 Zeigt beschränkte Spitzlichtbereiche im Sucher rot an. VF Highlight Clip Ind

Funktionstaste 2 Keine Zuweisung Not Assigned

Funktionstaste 3 Keine Zuweisung Not Assigned

Funktionstaste 4 Keine Zuweisung Not Assigned

Taste ITEM 1 Keine Zuweisung Not Assigned

Taste ITEM 2 Keine Zuweisung Not Assigned

Taste ITEM 3 Keine Zuweisung Not Assigned

Taste ITEM 4 Zeigt beschränkte Spitzlichtbereiche in der 
Monitor-Ausgabe rot an.

Monitor Highlight Clip Ind

Taste ITEM 5 Legt den Gebläsesteuermodus fest. Fan Mode

Sucherfunktionstaste A Schaltet die Fokusvergrößerung des Suchers ein/
aus.

VF Focus Magnifier

Sucherfunktionstaste B Schaltet die Falschfarben-Funktionsanzeige in 
einem Sucher ein/aus.

VF False Color

Sucherfunktionstaste C Schaltet die Funktion zum Überlagern des 
Ausgangsbilds des Suchers/Monitorbildschirms 
mit Informationen ein/aus.

VF Status Info

Funktionen, die den Tasten ITEM 1 bis 5 zugewiesen werden können

Einstellung der 
belegbaren 
Funktionstaste

Funktion Zustand beim Einschalten 
des Geräts

No Assign Keine Zuweisung –

SDI Frame Line Schaltet die Überlagerung des SDI 
3/4-Ausgangssignals mit Rahmenlinien ein/aus.

Einstellung wird beibehalten

SDI Status Info Schaltet die Überlagerung des SDI 
3/4-Ausgangssignals mit Informationen ein/aus.

Einstellung wird beibehalten

Press & Hold for SDI Log 1) Deaktiviert die auf das SDI 3/4-Ausgangssignal 
angewendete LUT, während die Taste gedrückt ist 
und legt die Log-Bildqualität fest, ohne eine LUT 
anzuwenden.

Einstellung wird nicht 
beibehalten

Monitor Frame Line Schaltet die Überlagerung des Monitor-
Ausgangssignals mit Rahmenlinien ein/aus.

Einstellung wird beibehalten

Monitor Status Info Schaltet die Überlagerung des Monitor-
Ausgangssignals mit Informationen ein/aus.

Einstellung wird beibehalten
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Einstellung der 
belegbaren 
Funktionstaste

Funktion Zustand beim Einschalten 
des Geräts

Press & Hold for Monitor 
Log 1)

Deaktiviert die auf das Monitor-Ausgangssignal 
angewendete LUT, während die Taste gedrückt ist 
und legt die Log-Bildqualität fest, ohne eine LUT 
anzuwenden.

Einstellung wird nicht 
beibehalten

Monitor Highlight Clip 
Ind 1)

Schaltet die Funktion zum Anzeigen beschränkter 
Spitzlichtbereiche in Rot auf dem Monitor-
Ausgangsbild ein/aus.

Einstellung wird beibehalten

Monitor False Color 1) Schaltet die Falschfarben-Funktionsanzeige auf 
einem Monitor ein/aus.

Einstellung wird beibehalten

Color Bars 2) Schaltet Farbbalken ein/aus. Einstellung wird beibehalten

AXS Slot Change Wechselt den aktiven Einschub, wenn zwei 
AXS-Speicherkarten eingesetzt sind.
Wechselt bei jedem Tastendruck zwischen A und B.

Einstellung wird beibehalten

SxS Slot Change Wechselt den aktiven Einschub, wenn zwei 
SxS-Speicherkarten eingesetzt sind.
Wechselt bei jedem Tastendruck zwischen A und B.

Einstellung wird beibehalten

Fan Mode Legt den Gebläsesteuermodus fest.
Schaltet bei jedem Tastendruck zwischen Auto  
Max  Off in Rec/Auto  Off in Rec/Max um.

Einstellung wird beibehalten

Format Media AXS Slot A Formatiert das Medium im AXS-Einschub A. –

Format Media AXS Slot B Formatiert das Medium im AXS-Einschub B. –

Format Media SxS Slot A Formatiert das Medium im SxS-Einschub A. –

Format Media SxS Slot B Formatiert das Medium im SxS-Einschub B. –

APR Führt die APR-Funktion aus. –

PL-Mt Interface Position Legt die Position der Schnittstelle des Objektivs 
mit PL-Fassung fest.
Schaltet bei jedem Tastendruck zwischen Top  
Side  Off um.

Einstellung wird beibehalten

VF Highlight Clip Ind 1) Schaltet die Funktion zum Anzeigen beschränkter 
Spitzlichtbereiche in Rot auf dem Sucherbild ein/aus.

Einstellung wird beibehalten

VF False Color 1) Schaltet die Falschfarben-Funktionsanzeige in 
einem Sucher ein/aus.

Einstellung wird beibehalten

Auto White Balance 2) Führt den automatischen Weißabgleich durch. –

Picture Cache Rec Schaltet die Bildpuffer-Aufnahmefunktion ein/aus. Einstellung wird beibehalten

Iris Open (1/16 stop) 3) Öffnet die Objektivblende.
Gedrückt halten, um die Blende vollständig zu 
öffnen.
Diese Funktion ist verfügbar, wenn ein Objektiv 
mit E-Fassung und motorisierter Blende 
angebracht ist.
Die Einstellung erfolgt in 1/16-Stoppschritten, 
wohingegen die Blendenanzeige in 
1/3-Stoppschritten erfolgt.

–

Einstellung der 
belegbaren 
Funktionstaste

Funktion Zustand beim Einschalten 
des Geräts

Iris Close (1/16 stop) 3) Schließt die Objektivblende.
Gedrückt halten, um die Blende vollständig zu 
schließen.
Diese Funktion ist verfügbar, wenn ein Objektiv 
mit E-Fassung und motorisierter Blende 
angebracht ist.
Die Einstellung erfolgt in 1/16-Stoppschritten, 
wohingegen die Blendenanzeige in 
1/3-Stoppschritten erfolgt.

–

1)	 Funktioniert auf Tastendruck nicht, wenn im vollständigen Menü Technical > System Configuration > RM/RCP Paint Control 
(Seite 68) auf On eingestellt ist.

2)	 Funktioniert auf Tastendruck nicht, wenn eine RM-B170 oder andere Fernbedienung angeschlossen ist und im vollständigen 
Menü Technical > System Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

3)	 Funktioniert auf Tastendruck nicht, wenn eine RM-B170 oder andere Fernbedienung angeschlossen ist.

Funktionen, die den belegbaren Funktionstasten 1 bis 4 zugewiesen werden 
können

Einstellung der belegbaren 
Funktionstaste

Funktion Zustand beim Einschalten 
des Geräts

No Assign Keine Zuweisung –

SDI Frame Line Schaltet die Überlagerung des SDI 
3/4-Ausgangssignals mit Rahmenlinien ein/aus.

Einstellung wird 
beibehalten

SDI Status Info Schaltet die Überlagerung des SDI 
3/4-Ausgangssignals mit Informationen ein/
aus.

Einstellung wird 
beibehalten

Press & Hold for SDI Log 1) Deaktiviert die auf das SDI 3/4-Ausgangssignal 
angewendete LUT, während die Taste gedrückt 
ist und legt die Log-Bildqualität fest, ohne eine 
LUT anzuwenden.

Einstellung wird nicht 
beibehalten

Monitor Frame Line Schaltet die Überlagerung des Monitor-
Ausgangssignals mit Rahmenlinien ein/aus.

Einstellung wird 
beibehalten

Monitor Status Info Schaltet die Überlagerung des Monitor-
Ausgangssignals mit Informationen ein/aus.

Einstellung wird 
beibehalten

Press & Hold for Monitor Log 1) Deaktiviert die auf das Monitor-Ausgangssignal 
angewendete LUT, während die Taste gedrückt 
ist und legt die Log-Bildqualität fest, ohne eine 
LUT anzuwenden.

Einstellung wird nicht 
beibehalten
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Einstellung der belegbaren 
Funktionstaste

Funktion Zustand beim Einschalten 
des Geräts

Monitor Highlight Clip Ind 1) Schaltet die Funktion zum Anzeigen 
beschränkter Spitzlichtbereiche in Rot auf dem 
Monitor-Ausgangsbild ein/aus.

Einstellung wird 
beibehalten

Monitor High/Low Key 1) Wählt den Monitor-Ausgabemodus aus.
Wechselt bei Drücken der Taste zwischen High 
Key (Bildschirm zum Prüfen auf überbelichtete 
Spitzlichter)  Low Key (Bildschirm zum 
Prüfen auf ausgeblendete Schatten)  Off 
(normale Anzeige).

Einstellung wird nicht 
beibehalten

Monitor False Color 1) Schaltet die Falschfarben-Funktionsanzeige auf 
einem Monitor ein/aus.

Einstellung wird 
beibehalten

Color Bars 2) Schaltet Farbbalken ein/aus. Einstellung wird 
beibehalten

AXS Slot Change Wechselt den aktiven Einschub, wenn zwei 
AXS-Speicherkarten eingesetzt sind.
Wechselt bei jedem Tastendruck zwischen A 
und B.

–

SxS Slot Change Wechselt den aktiven Einschub, wenn zwei 
SxS-Speicherkarten eingesetzt sind.
Wechselt bei jedem Tastendruck zwischen A 
und B.

–

Rec Review Führt die Funktion zum Prüfen der Aufnahme 
aus.

Einstellung wird nicht 
beibehalten

VF Frame Line Schaltet die Überlagerung des Ausgangsbilds 
des Suchers/Monitorbildschirms mit 
Rahmenlinien ein/aus.

Einstellung wird 
beibehalten

VF Zebra Schaltet die Funktion zum Überlagern des 
Ausgangsbilds des Suchers/Monitorbildschirms 
mit Zebramustern ein/aus.

Einstellung wird 
beibehalten

VF Status Info Schaltet die Funktion zum Überlagern des 
Ausgangsbilds des Suchers/Monitorbildschirms 
mit Informationen ein/aus.

Einstellung wird 
beibehalten

VF Focus Magnifier Schaltet die Fokusvergrößerung des Suchers 
ein/aus.

Einstellung wird nicht 
beibehalten

Press & Hold for VF Log 1) Deaktiviert die auf das Ausgangsbild des 
Suchers/Monitorbildschirms angewendete LUT, 
während die Taste gedrückt ist und legt die 
Log-Bildqualität fest, ohne eine LUT 
anzuwenden.

Einstellung wird nicht 
beibehalten

Einstellung der belegbaren 
Funktionstaste

Funktion Zustand beim Einschalten 
des Geräts

VF Highlight Clip Ind 1) Schaltet die Funktion zum Anzeigen 
beschränkter Spitzlichtbereiche in Rot auf dem 
Sucherbild ein/aus.

Einstellung wird 
beibehalten

VF High/Low Key 1) Wählt den Sucher-Ausgabemodus aus.
Wechselt bei Drücken der Taste zwischen High 
Key (Bildschirm zum Prüfen auf überbelichtete 
Spitzlichter)  Low Key (Bildschirm zum 
Prüfen auf ausgeblendete Schatten)  Off 
(normale Anzeige).

Einstellung wird nicht 
beibehalten

VF False Color 1) Schaltet die Falschfarben-Funktionsanzeige in 
einem Sucher ein/aus.

Einstellung wird 
beibehalten

Auto White Balance 2) Führt den automatischen Weißabgleich durch. 
Stoppt während des automatischen 
Weißabgleichs dessen Ausführung.

–

Picture Cache Rec Schaltet die Bildpuffer-Aufnahmefunktion ein/
aus.

Einstellung wird 
beibehalten

Iris Open (1/16 stop) 3) Öffnet die Objektivblende.
Gedrückt halten, um die Blende vollständig zu 
öffnen.
Diese Funktion ist verfügbar, wenn ein Objektiv 
mit E-Fassung und motorisierter Blende 
angebracht ist.
Die Einstellung erfolgt in 1/16-Stoppschritten, 
wohingegen die Blendenanzeige in 
1/3-Stoppschritten erfolgt.

–

Iris Close (1/16 stop) 3) Schließt die Objektivblende.
Gedrückt halten, um die Blende vollständig zu 
schließen.
Diese Funktion ist verfügbar, wenn ein Objektiv 
mit E-Fassung und motorisierter Blende 
angebracht ist.
Die Einstellung erfolgt in 1/16-Stoppschritten, 
wohingegen die Blendenanzeige in 
1/3-Stoppschritten erfolgt.

–

Rec Startet/stoppt die Aufnahme. –

1)	 Funktioniert auf Tastendruck nicht, wenn im vollständigen Menü Technical > System Configuration > RM/RCP Paint Control 
(Seite 68) auf On eingestellt ist.

2)	 Funktioniert auf Tastendruck nicht, wenn eine RM-B170 oder andere Fernbedienung angeschlossen ist und im vollständigen 
Menü Technical > System Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

3)	 Funktioniert auf Tastendruck nicht, wenn eine RM-B170 oder andere Fernbedienung angeschlossen ist.
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Funktionen, die den belegbaren Funktionstasten A bis C am Sucher (DVF-EL200) 
zugewiesen werden können

Einstellung der belegbaren 
Funktionstaste

Funktion Zustand beim Einschalten 
des Geräts

No Assign Keine Zuweisung –

Color Bars 1) Schaltet Farbbalken ein/aus. Einstellung wird 
beibehalten

AXS Slot Change Wechselt den aktiven Einschub, wenn zwei 
AXS-Speicherkarten eingesetzt sind.
Wechselt bei jedem Tastendruck zwischen A 
und B.

–

SxS Slot Change Wechselt den aktiven Einschub, wenn zwei 
SxS-Speicherkarten eingesetzt sind.
Wechselt bei jedem Tastendruck zwischen A 
und B.

–

Rec Review Führt die Funktion zum Prüfen der Aufnahme 
aus.

Einstellung wird nicht 
beibehalten

VF Frame Line Schaltet die Überlagerung des Ausgangsbilds 
des Suchers/Monitorbildschirms mit 
Rahmenlinien ein/aus.

Einstellung wird 
beibehalten

VF Zebra Schaltet die Funktion zum Überlagern des 
Ausgangsbilds des Suchers/
Monitorbildschirms mit Zebramustern ein/aus.

Einstellung wird 
beibehalten

VF Status Info Schaltet die Funktion zum Überlagern des 
Ausgangsbilds des Suchers/
Monitorbildschirms mit Informationen ein/aus.

Einstellung wird 
beibehalten

VF Focus Magnifier Schaltet die Fokusvergrößerung des Suchers 
ein/aus.

Einstellung wird nicht 
beibehalten

Press & Hold for VF Log 2) Deaktiviert die auf das Ausgangsbild des 
Suchers/Monitorbildschirms angewendete 
LUT, während die Taste gedrückt ist und legt 
die Log-Bildqualität fest, ohne eine LUT 
anzuwenden.

Einstellung wird nicht 
beibehalten

VF Highlight Clip Ind 2) Schaltet die Funktion zum Anzeigen 
beschränkter Spitzlichtbereiche in Rot auf dem 
Sucherbild ein/aus.

Einstellung wird 
beibehalten

Einstellung der belegbaren 
Funktionstaste

Funktion Zustand beim Einschalten 
des Geräts

VF High/Low Key 2) Wählt den Sucher-Ausgabemodus aus.
Wechselt bei Drücken der Taste zwischen High 
Key (Bildschirm zum Prüfen auf überbelichtete 
Spitzlichter)  Low Key (Bildschirm zum 
Prüfen auf ausgeblendete Schatten)  Off 
(normale Anzeige).

Einstellung wird nicht 
beibehalten

VF False Color 2) Schaltet die Falschfarben-Funktionsanzeige in 
einem Sucher ein/aus.

Einstellung wird 
beibehalten

Picture Cache Rec Schaltet die Bildpuffer-Aufnahmefunktion ein/
aus.

Einstellung wird 
beibehalten

Iris Open (1/16 stop) 3) Öffnet die Objektivblende.
Gedrückt halten, um die Blende vollständig zu 
öffnen.
Diese Funktion ist verfügbar, wenn ein 
Objektiv mit E-Fassung und motorisierter 
Blende angebracht ist.
Die Einstellung erfolgt in 1/16-Stoppschritten, 
wohingegen die Blendenanzeige in 
1/3-Stoppschritten erfolgt.

–

Iris Close (1/16 stop) 3) Schließt die Objektivblende.
Gedrückt halten, um die Blende vollständig zu 
schließen.
Diese Funktion ist verfügbar, wenn ein 
Objektiv mit E-Fassung und motorisierter 
Blende angebracht ist.
Die Einstellung erfolgt in 1/16-Stoppschritten, 
wohingegen die Blendenanzeige in 
1/3-Stoppschritten erfolgt.

–

Rec Startet/stoppt die Aufnahme. –

1)	 Funktioniert auf Tastendruck nicht, wenn eine RM-B170 oder andere Fernbedienung angeschlossen ist und im vollständigen 
Menü Technical > System Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

2)	 Funktioniert auf Tastendruck nicht, wenn im vollständigen Menü Technical > System Configuration > RM/RCP Paint Control 
(Seite 68) auf On eingestellt ist.

3)	 Funktioniert auf Tastendruck nicht, wenn eine RM-B170 oder andere Fernbedienung angeschlossen ist.
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Menüfunktionen
Wenn Sie während der Aufzeichnung (bei der 
Aufnahme oder im Aufnahme-Standby) oder der 
Wiedergabe die Taste MENU drücken, können Sie 
den Menübildschirm im Subdisplay aufrufen und 
bedienen.
ˎˎ Project-Kategorie: grundlegende Einstellungen 
und Aufzeichnungsformateinstellungen
ˎˎ TC/Media-Kategorie: Zeitcode-Wert und TC 
Formateinstellungen
ˎˎ Monitoring-Kategorie: Ausgangsformat 
des externen Signals für SDI/HDMI/
Monitor, OSD sowie Statuseinstellungen für 
Markierungsüberlagerung
ˎˎ Audio-Kategorie: Einstellungen zu Audioquelle 
und Audiopegel
ˎˎ Info-Kategorie: Informationen zu Kamera, 
Medium und Akkustatus

Bedienelemente

Taste MENU (Seite 9)
Zum Aufrufen des Menüs im Subdisplay drücken.

Tasten ITEM 1 bis 6 (Seite 9)
Dient zum Auswählen der Kategorie im Menü.

Regler SEL/SET (Regler MENU) (Seite 9)
Drehen Sie den Regler, um den Cursor in die 
entsprechende Richtung zu bewegen, sodass 
Sie Menüoptionen oder Einstellwerte auswählen 
können.
Drücken Sie den Regler MENU, um die 
ausgewählte Option zu übernehmen.

Taste BACK (Seite 10)
Zur Rückkehr zum vorhergehenden Menü 
drücken. Unbestätigte Änderungen werden 
verworfen.

Basisfunktionen

1	 Drücken Sie die Taste MENU.
Der Menübildschirm wird angezeigt.

2	 Wählen Sie mithilfe der Tasten ITEM 1 bis 6 die 
Kategorie aus.

3	 Drehen Sie den Regler MENU, um den Cursor 
auf die auszuwählende Einstelloption zu 
stellen.
Für jede Einstelloption wird der Einstellwert 
angezeigt.

„Liste der Menüoptionen“ (Seite 44)

4	 Drücken Sie den Regler MENU.
Neben der ausgewählten Option wird der 
Bildschirm zum Auswählen des Einstellwerts 
angezeigt.

5	 Drehen Sie den Regler MENU, um den Cursor 
auf den Einstellwert zu stellen.

6	 Drücken Sie den Regler MENU, um die 
Einstellung zu übernehmen.
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Liste der Menüoptionen

Die in den jeweiligen Kategorien verfügbaren Optionen sind nachstehend aufgeführt.

Project-Kategorie

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.

Option Einstellungen Beschreibung

Imager Mode 6K 3:2/6K 1.85:1/6K 17:9/ 
6K 2.39:1/5.7K 16:9/4K 6:5/ 
4K 4:3/4K 4:3 Surround View/ 
4K 17:9/ 
4K 17:9 Surround View/ 
4K 2.39:1/3.8K 16:9/ 
3.8K 16:9 Surround View

Legt die effektive Bildgröße fest.

[Hinweise]
ˎˎ 6K 3:2/6K 1.85:1/6K 17:9 werden nur angezeigt, 

wenn eine Vollformatlizenz installiert ist.
ˎˎ 4K 6:5/4K 4:3/4K 4:3 Surround View werden nur 

angezeigt, wenn eine Anamorphotische Lizenz 
installiert ist.
ˎˎ 4K 2.39:1 wird nur angezeigt, wenn eine High Frame 

Rate-Lizenz installiert ist.

Project Frame Rate 23.98/24/25/29.97/47.95/ 
50/59.94

Legt die Projektbildrate fest.

Input Color Space S-Gamut3.Cine/SLog3 /  
S-Gamut3/SLog3 /  
Rec.2020/HLG_Rec.2100

Stellt den Farbraum ein.

[Hinweis]
Rec.2020/HLG_Rec.2100 kann nur ausgewählt werden, 
wenn im vollständigen Menü Technical > System 
Configuration > RM/RCP Paint Control (Seite 68) auf 
On eingestellt ist.

AXS Rec Format 1)

(nur wenn ein AXS-R7 
angeschlossen ist)

Rec Off/X-OCN XT/ 
RAW SQ/X-OCN ST/ 
X-OCN LT

Legt das Aufzeichnungsformat für AXS-
Speicherkarten fest, wenn ein AXS-R7 
angeschlossen ist.

SxS Rec Format 1) Rec Off/XAVC 4K Class480/ 
XAVC 4K Class300/ 
XAVC QFHD Class480/ 
XAVC QFHD Class300/ 
MPEG HD P/MPEG HD i/ 
ProRes 422 HQ HD P/ 
ProRes 422 HQ HD i/ 
ProRes 422 HD P/ 
ProRes 422 HD i/ 
ProRes Proxy HD P/ 
ProRes Proxy HD i

Legt das Hauptaufzeichnungsformat für SxS-
Speicherkarten fest.

Sub Rec Format 1) Rec Off/MPEG HD P/ 
MPEG HD i/ 
ProRes 422 Proxy HD P/ 
ProRes 422 Proxy HD i

Legt das Unteraufzeichnungsformat für SxS-
Speicherkarten fest.

Option Einstellungen Beschreibung

Project Details
(Taste ITEM 6)

Zeigt den Inhalt des Project-Menüs (Seite 58) 
im vollständigen Menü an.

1)	 Die verfügbaren Aufzeichnungsformate variieren je nach Kombination der Einstellungen der effektiven Bildgröße und der 
Projektbildrate. Einzelheiten zu Einstellungen siehe „Aufzeichnungsformateinstellungen“ (Seite 48).

TC/Media-Kategorie

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.

Option Einstellungen Beschreibung

TC Mode Preset F-Run (Ext-Lk)/Preset 
R-Run/Int Regen

Stellt den Zeitcode-Modus ein.
Preset F-Run (Ext-Lk): Zeitcode schreitet 
unabhängig davon, ob aufgezeichnet 
wird oder nicht, kontinuierlich ab dem 
angegebenen Wert fort.
Preset R-Run: Zeitcode schreitet nur 
dann, wenn aufgezeichnet wird, ab dem 
angegebenen Wert fort.
Int Regen: Der Zeitcode des 
vorhergehenden Clips wird fortgesetzt.

TC Display Timecode/Duration Schaltet die Zeitdatenanzeige um.

TC Setting
(wird beim 
Umschalten auf 
einen anderen 
Bildschirm 
eingestellt)

Setting 
(H, M, S, F)

Stellt den Zeitcode auf einen 
gewünschten Wert ein.

Reset Stellt den Zeitcode zurück auf 
00:00:00:00.

TC Format DF/NDF Legt das Zeitcode-Format fest.
DF: Drop-Frame
NDF: Non-Drop-Frame

TC Source Internal/External Nur Anzeige.

Cam ID A bis Z Legt die zur Bildung von Clipnamen 
verwendete Kamera-ID fest.
Clipname: Camera ID + Reel Number + 
Shot Number + Datum + beliebige 
Zeichenfolge

Reel# 001 bis 999 Legt den zur Bildung von Clipnamen 
verwendeten numerischen Teil von Reel 
Number fest.
Clipname: Camera ID + Reel Number + 
Shot Number + Datum + beliebige 
Zeichenfolge
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Option Einstellungen Beschreibung

Camera Position C/L/R Legt das zur Bildung von Clipnamen 
verwendete erste Zeichen von Shot 
Number fest.
Clipname: Camera ID + Reel Number + 
Shot Number + Datum + beliebige 
Zeichenfolge

Format Media
(wird beim 
Umschalten auf 
einen anderen 
Bildschirm 
ausgeführt)

AXS Slot A Formatiert die AXS-Speicherkarte in 
Einschub A.

AXS Slot B Formatiert die AXS-Speicherkarte in 
Einschub B.

SxS Slot A Formatiert die SxS-Speicherkarte in 
Einschub A.

SxS Slot B Formatiert die SxS-Speicherkarte in 
Einschub B.

SD Card Formatiert die SD-Karte.

Media Details
(Taste ITEM 6)

Zeigt den Inhalt des TC/Media-Menüs 
(Seite 61) im vollständigen Menü an.

Monitoring-Kategorie

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.

[Hinweise]
ˎˎ Das Gerät unterstützt die unabhängige Konfiguration von Status Info und Frame Line für jedes System. Die Display-

Informationen für die Ausgabebilder A und B werden mithilfe des Monitoring-Menüs (Seite 63) konfiguriert.
ˎˎ Je nach Einstellung für Output Format werden Info und Frame Line ggf. nicht angezeigt. In diesem Fall wird „–“ angezeigt 

und die Einstellung kann nicht geändert werden.

Option Einstellungen Beschreibung

VF Status Info Info A/Info B/Off Wählt die dem Sucherbild zu 
überlagernden Informationen aus.

Frame Line Line A/Line B/Off Wählt die dem Sucherbild zu 
überlagernden Rahmenlinien aus.

Option Einstellungen Beschreibung

SDI 1/2 Output 
Format

Die verfügbaren Einstellun-
gen variieren je nach Imager-
Modus, Projektbildrate und 
SxS-Aufzeichnungsformatein-
stellungen.

Wählt das SDI 1/2-Ausgangsformat aus.1)

Status Info – Dem Ausgang SDI 1/2 wird keine 
Informationsanzeige überlagert.

Frame Line Line A/Line B/Off Wählt die dem Ausgang SDI 1/2 zu 
überlagernden Rahmenlinien aus.

[Hinweis]
Rahmenlinien werden nur überlagert, wenn 
das Ausgangsformat 4K/QFHD ist.

SDI 3/4

[Hinweis]
Je nach Einstellung 
von Output Format 
für SDI 1/2 sind die 
Einstellungen Output 
Format, Info, Frame 
Line von SDI 3/4 leer 
und können nicht 
geändert werden.

Output 
Format

Die verfügbaren 
Einstellungen variieren je 
nach Einstellung für SDI 1/2.

Wählt das SDI 3/4-Ausgangsformat aus.1)

Status Info Info A/Info B/Off Wählt die dem Ausgang SDI 3/4 zu 
überlagernden Informationen aus.

Frame Line Line A/Line B/Off Wählt die dem Ausgang SDI 3/4 zu 
überlagernden Rahmenlinien aus.

Monitor Output 
Format

Die verfügbaren 
Einstellungen variieren je 
nach Einstellung für SDI 1/2.

Wählt das Monitor-Ausgangsformat 
aus.2)

Status Info Info A/Info B/Off Wählt die dem Ausgang Monitor zu 
überlagernden Informationen aus.

Frame Line Line A/Line B/Off Wählt die dem Ausgang Monitor zu 
überlagernden Rahmenlinien aus.

HDMI Output 
Format

Die verfügbaren 
Einstellungen variieren je 
nach Einstellung für SDI 1/2.

Wählt das HDMI-Ausgangsformat.2)

Moni. Details
(Taste ITEM 6)

Zeigt den Inhalt des Monitoring-Menüs 
(Seite 63) im vollständigen Menü an.

1)	 Einzelheiten zu den zur Auswahl stehenden Formaten siehe „Ausgangsformate am Anschluss SDI OUT“ (Seite 97).
2)	 Einzelheiten zu den zur Auswahl stehenden Formaten siehe „Ausgangsformate an den Anschlüssen MONITOR OUT/HDMI 

OUT“ (Seite 101).
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Audio-Kategorie

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.

Option Einstellungen Beschreibung

Source Switch LINE / AES/EBU / MIC Zeigt die Stellung des Schalters AUDIO IN 
(Seite 10) an, mit dem die Eingangsquelle für 
CH1 und CH2 festgelegt wird.

CH-1 Audio Level Auto/Manual
–99 bis ±0 bis +99

Der Audio-Aufzeichnungspegel wird bei 
Einstellung auf Auto automatisch eingestellt.
Der Audio-Aufzeichnungspegel wird bei 
Einstellung auf Manual manuell eingestellt.

CH-2 Audio Level Auto/Manual
–99 bis ±0 bis +99

Der Audio-Aufzeichnungspegel wird bei 
Einstellung auf Auto automatisch eingestellt.
Der Audio-Aufzeichnungspegel wird bei 
Einstellung auf Manual manuell eingestellt.

MIC Reference –60dB/–50dB/–40dB Wählt den Referenzeingangspegel des Mikrofons 
aus.

Monitor CH Wenn Monitor Output CH Pair 
auf CH-1/CH-2 gesetzt ist

CH-1/CH-2, CH-1, CH-2
Wenn Monitor Output CH Pair 
auf CH-3/CH-4 gesetzt ist

CH-3/CH-4, CH-3, CH-4

Zum Auswählen des an die Kopfhörer und den 
Lautsprecher ausgegebenen Audiokanals.

Monitor Level 0 bis 99 Passt den Monitortonpegel an.

CH1 Level Meter – Zeigt den Pegelmesser für CH1 an.

CH2 Level Meter – Zeigt den Pegelmesser für CH2 an.

CH3 Level Meter – Zeigt den Pegelmesser für CH3 an.

CH4 Level Meter – Zeigt den Pegelmesser für CH4 an.

Audio Details
(Taste ITEM 6)

Zeigt den Inhalt des Audio-Menüs (Seite 67) im 
vollständigen Menü an.

Prüfen des Status mithilfe der Info-Kategorie

Sie können den Status von Medien und Akku sowie den Inhalt von Warnungen und Fehlermeldungen 
prüfen, die mithilfe der Info-Kategorie ausgegeben werden. Die Anzeige wird in Echtzeit aktualisiert, wenn 
sich der Status des Geräts ändert.
Die Info-Kategorie besteht aus den folgenden sieben Informationsseiten. Drehen Sie den Regler MENU, 
um die Seiten zu durchblättern.

Nr. Seite Beschreibung

1 Camera Condition Zeigt Warn- und Fehlermeldungen an. Wenn keine Meldungen 
vorliegen, wird „All Systems are OK“ oben im Anzeigebereich 
angezeigt.

2 Firmware Zeigt die Seriennummer und Firmwareversion des Geräts sowie 
des am Gerät angebrachten AXS-R7 an.

3 License Zeigt den Namen und den Installationsstatus/die Gültigkeit von 
optional Softwarelizenzen an. Fall eine Option nicht hinzugefügt 
wurde, wird „Not Installed“ bzw. „Expired“ als Installationsstatus 
angezeigt.

4 System Zeigt die folgenden Systeminformationen an.
ˎˎ Datum und Zeit

ˎˎ Lüfterdrehzahl

ˎˎ vom Sensor gemeldete Temperatur

ˎˎ Betriebsstundenzähler

ˎˎ IP Address

[Hinweise]
ˎˎ Wenn die vom Sensor gemeldete Temperatur 65 °C erreicht, wird eine 

Warnmeldung ausgegeben.
ˎˎ „0.0.0.0“ wird angezeigt, wenn die IP-Adresse nicht bezogen werden 

kann.

5 Battery Zeigt die folgenden Akkuinformationen an.
ˎˎ Typ und Name des erkannten Akkus

ˎˎ Restkapazität (%)

ˎˎ ungefähr verbleibende Zeit

ˎˎ Restkapazität (Ah)

ˎˎ Spannung (V)

ˎˎ Anzahl der durchgeführten Aufladevorgänge des Akkus

ˎˎ Stromquelle

ˎˎ Spannung der Stromversorgung

6 Media Zeigt die Restkapazität, verbleibende Aufzeichnungsdauer und 
Lebensdauerdaten von SxS-Speicherkarten, AXS-Speicherkarten 
(wenn AXS-R7 angebracht ist) und SD-Karten an.
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Nr. Seite Beschreibung

7 Lens Zeigt die folgenden Informationen zu dem am Gerät 
angebrachten Objektiv an.
ˎˎ Name des Objektivmodells

ˎˎ T-Wert der Blende
	 [Hinweis]

Der F-Stoppwert wird anstelle des T-Stoppwerts angezeigt, falls 
dieser nicht ermittelt werden kann.

ˎˎ Brennweite

ˎˎ Fokaldistanz

ˎˎ Schärfentiefe

ˎˎ Seriennummer

8 Network Zeigt die Konfigurationsdaten der Netzwerkverbindung an.
ˎˎ Status (LAN/Wireless Access Point/Wireless Station/Off )

ˎˎ IP Address

ˎˎ SSID

ˎˎ MAC Address

[Hinweis]
„0.0.0.0“ wird angezeigt, wenn die IP-Adresse nicht bezogen werden kann.
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Aufzeichnungsformateinstellungen

Die folgenden Aufzeichnungsformate können für verschiedene Kombinationen von effektiver Bildgröße und Projektbildrate ausgewählt werden.
Falls ein unterstrichener und fettgedruckter Wert ausgewählt wird, kann eine Log- oder LUT-Einstellung auf das aufgezeichnete Videosignal angewendet werden.

Kombinationen von AXS Rec Format und SxS Rec Format

Effektive Bildgröße (Imager Mode) Hauptaufzeichnungsformat Project Frame Rate

AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

6K 3:2
(6048×4032)

X-OCN XT
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – Ja Ja

4K XAVC-I Class480 Ja Ja Ja Ja – – –

4K XAVC-I Class300 Ja Ja Ja Ja – Ja Ja

MPEG HD422 P Ja – Ja Ja – – –

MPEG HD422 i – – – – – Ja Ja

FHD ProRes 422 HQ P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 Proxy P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 Proxy i – – – – – Ja Ja

6K 1.85:1
(6054×3272)

X-OCN XT
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – – –

4K XAVC-I Class480 Ja Ja Ja Ja – – –

4K XAVC-I Class300 Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

FHD ProRes 422 HQ P Ja Ja Ja Ja – – –

FHD ProRes 422 P Ja Ja Ja Ja – – –

FHD ProRes 422 Proxy P Ja Ja Ja Ja – – –

6K 17:9
(6054×3192)

X-OCN XT
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – – –

4K XAVC-I Class480 Ja Ja Ja Ja – – –

4K XAVC-I Class300 Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

FHD ProRes 422 HQ P Ja Ja Ja Ja – – –

FHD ProRes 422 P Ja Ja Ja Ja – – –

FHD ProRes 422 Proxy P Ja Ja Ja Ja – – –
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Effektive Bildgröße (Imager Mode) Hauptaufzeichnungsformat Project Frame Rate

AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

6K 2.39:1
(6048×2534)

X-OCN XT
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – – –

4K XAVC-I Class480 Ja Ja Ja Ja – – –

4K XAVC-I Class300 Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

FHD ProRes 422 HQ P Ja Ja Ja Ja – – –

FHD ProRes 422 P Ja Ja Ja Ja – – –

FHD ProRes 422 Proxy P Ja Ja Ja Ja – – –

5.7K 16:9
(5674×3192)

X-OCN XT
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – – –

QFHD XAVC-I Class480 Ja – Ja Ja – – –

QFHD XAVC-I Class300 Ja – Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

FHD ProRes 422 HQ P Ja Ja Ja Ja – – –

FHD ProRes 422 P Ja Ja Ja Ja – – –

FHD ProRes 422 Proxy P Ja Ja Ja Ja – – –

4K 6:5
(4096×3432)

X-OCN XT
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – – –

4K XAVC-I Class480 Ja Ja Ja Ja – – –

4K XAVC-I Class300 Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

FHD ProRes 422 HQ P Ja Ja Ja Ja – – –

FHD ProRes 422 P Ja Ja Ja Ja – – –

FHD ProRes 422 Proxy P Ja Ja Ja Ja – – –

4K 4:3
(4096×3024)

X-OCN XT
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja Ja Ja Ja

4K XAVC-I Class480 Ja Ja Ja Ja – – –

4K XAVC-I Class300 Ja Ja Ja Ja – Ja Ja

MPEG HD422 P Ja – Ja Ja – – –

MPEG HD422 i – – – – – Ja Ja

FHD ProRes 422 HQ P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 Proxy P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 Proxy i – – – – – Ja Ja

4K 4:3 Surround
(4096×3024)
Bildgröße
(4552×3360)

X-OCN XT
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

FHD ProRes 422 HQ P Ja Ja Ja Ja – – –

FHD ProRes 422 P Ja Ja Ja Ja – – –

FHD ProRes 422 Proxy P Ja Ja Ja Ja – – –
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Effektive Bildgröße (Imager Mode) Hauptaufzeichnungsformat Project Frame Rate

AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

4K 17:9
(4096×2160)

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja Ja Ja Ja

4K XAVC-I Class480 Ja Ja Ja Ja – – –

4K XAVC-I Class300 Ja Ja Ja Ja – Ja Ja

MPEG HD422 P Ja – Ja Ja – – –

MPEG HD422 i – – – – – Ja Ja

FHD ProRes 422 HQ P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 HQ i – – – – – Ja Ja

FHD ProRes 422 P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 i – – – – – Ja Ja

FHD ProRes 422 Proxy P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 Proxy i – – – – – Ja Ja

4K 17:9 Surround
(4096×2160)
Bildgröße
(4552×2400)

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

FHD ProRes 422 HQ P Ja Ja Ja Ja – – –

FHD ProRes 422 P Ja Ja Ja Ja – – –

FHD ProRes 422 Proxy P Ja Ja Ja Ja – – –

4K 4096×1716 2.39:1 X-OCN XT
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – Ja Ja

3.8K (QFHD) 16:9
(3840×2160)

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – Ja Ja

QFHD XAVC-I Class480 Ja – Ja Ja – – –

QFHD XAVC-I Class300 Ja – Ja Ja – Ja Ja

MPEG HD422 P Ja – Ja Ja – – –

MPEG HD422 i – – – – – Ja Ja

FHD ProRes 422 HQ P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 HQ i – – – – – Ja Ja

FHD ProRes 422 P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 i – – – – – Ja Ja

FHD ProRes 422 Proxy P Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 Proxy i – – – – – Ja Ja

3.8K (QFHD) 16:9 Surround
(3840×2160)
Bildgröße
(4268×2400)

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

FHD ProRes 422 HQ P Ja Ja Ja Ja – – –

FHD ProRes 422 P Ja Ja Ja Ja – – –

FHD ProRes 422 Proxy P Ja Ja Ja Ja – – –
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Kombinationen von SxS Rec Format und Sub Rec-Format

Effektive Bildgröße (Imager Mode) Aufzeichnungsformat Project Frame Rate

SxS-Hauptaufzeichnungsformat 
(SxS Rec Format) 1)

SxS-Unteraufzeichnungsformat 
(Sub Rec Format) 2)

23.98 24.00 25.00 29.97 47.95 50.00 59.94

6K 3:2
(6048×4032)

4K XAVC-I Class480 None – – – – – – –

4K XAVC-I Class300 None – – – – – – –

FHD XAVC-I None – – – – – – –

MPEG HD422 P None – – – – – – –

FHD ProRes 422 HQ P None – – – – – – –

FHD ProRes 422 P None – – – – – – –

FHD ProRes 422 Proxy P None – – – – – – –

6K 1.85:1
(6054×3272)

4K XAVC-I Class480 None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja Ja Ja Ja – – –

4K XAVC-I Class300 None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja Ja Ja Ja – – –

MPEG HD422 P None Ja – Ja Ja – – –

FHD ProRes 422 HQ P None Ja Ja Ja Ja – – –

FHD ProRes 422 P None Ja Ja Ja Ja – – –

6K 17:9
(6054×3192)

4K XAVC-I Class480 None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja Ja Ja Ja – – –

4K XAVC-I Class300 None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja Ja Ja Ja – – –

6K 2.39:1
(6048×2534)

4K XAVC-I Class480 None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja Ja Ja Ja – – –

4K XAVC-I Class300 None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja Ja Ja Ja – – –

MPEG HD422 P None Ja – Ja Ja – – –

FHD ProRes 422 HQ P None Ja Ja Ja Ja – – –

FHD ProRes 422 P None Ja Ja Ja Ja – – –
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Effektive Bildgröße (Imager Mode) Aufzeichnungsformat Project Frame Rate

SxS-Hauptaufzeichnungsformat 
(SxS Rec Format) 1)

SxS-Unteraufzeichnungsformat 
(Sub Rec Format) 2)

23.98 24.00 25.00 29.97 47.95 50.00 59.94

5.7K 16:9
(5674×3192)

QFHD XAVC-I Class480 None Ja – Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja – Ja Ja – – –

QFHD XAVC-I Class300 None Ja – Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja – Ja Ja – – –

MPEG HD422 P None Ja – Ja Ja – – –

FHD ProRes 422 HQ P None Ja Ja Ja Ja – – –

FHD ProRes 422 P None Ja Ja Ja Ja – – –

4K 6:5
(4096×3432)

4K XAVC-I Class480 None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja Ja Ja Ja – – –

4K XAVC-I Class300 None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja Ja Ja Ja – – –

MPEG HD422 P None Ja – Ja Ja – – –

FHD ProRes 422 HQ P None Ja Ja Ja Ja – – –

FHD ProRes 422 P None Ja Ja Ja Ja – – –

4K 4:3
(4096×3024)

4K XAVC-I Class480 None Ja Ja Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja Ja Ja Ja – – –

4K XAVC-I Class300 None Ja Ja Ja Ja – Ja Ja

MPEG HD422 P Ja – Ja Ja – – –

MPEG HD422 i – – – – – Ja Ja

ProRes 422 Proxy P Ja Ja Ja Ja – – –

ProRes 422 Proxy i – – – – – Ja Ja

MPEG HD422 P None Ja – Ja Ja – – –

MPEG HD422 i None – – – – – Ja Ja

FHD ProRes 422 HQ P None Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 P None Ja Ja Ja Ja – Ja Ja

4K 4:3 Surround
(4096×3024)
Bildgröße
(4552×3360)

MPEG HD422 P None Ja – Ja Ja – – –

FHD ProRes 422 HQ P None Ja Ja Ja Ja – – –

FHD ProRes 422 P None Ja Ja Ja Ja – – –
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Effektive Bildgröße (Imager Mode) Aufzeichnungsformat Project Frame Rate

SxS-Hauptaufzeichnungsformat 
(SxS Rec Format) 1)

SxS-Unteraufzeichnungsformat 
(Sub Rec Format) 2)

23.98 24.00 25.00 29.97 47.95 50.00 59.94

4K 17:9
(4096×2160)

4K XAVC-I Class480 None Ja Ja Ja Ja – – –

MPEG HD422 Ja – Ja Ja – – –

ProRes 422 Proxy P Ja Ja Ja Ja – – –

4K XAVC-I Class300 None Ja Ja Ja Ja – Ja Ja

MPEG HD422 P Ja – Ja Ja – – –

MPEG HD422 i – – – – – Ja Ja

ProRes 422 Proxy P Ja Ja Ja Ja – – –

ProRes 422 Proxy i – – – – – Ja Ja

3.8K (QFHD) 16:9
(3840×2160)

QFHD XAVC-I Class480 None Ja – Ja Ja – – –

MPEG HD422 P Ja – Ja Ja – – –

ProRes 422 Proxy P Ja – Ja Ja – – –

QFHD XAVC-I Class300 None Ja – Ja Ja – Ja Ja

MPEG HD422 P Ja – Ja Ja – – –

MPEG HD422 i – – – – – Ja Ja

ProRes 422 Proxy P Ja – Ja Ja – – –

ProRes 422 Proxy i – – – – – Ja Ja

MPEG HD422 P None Ja – Ja Ja – – –

MPEG HD422 i None – – – – – Ja Ja

FHD ProRes 422 HQ P None Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 HQ i None – – – – – Ja Ja

FHD ProRes 422 P None Ja Ja Ja Ja – Ja Ja

FHD ProRes 422 i None – – – – – Ja Ja

3.8K (QFHD) 16:9 Surround 
(3840×2160)
Bildgröße 
(4268×2400)

MPEG HD422 P None Ja – Ja Ja – – –

FHD ProRes 422 HQ P None Ja Ja Ja Ja – – –

FHD ProRes 422 P None Ja Ja Ja Ja – – –

1)	 Wenn das SxS-Hauptaufnahmeformat auf XAVC eingestellt ist, ist die LUT für die XAVC-Aufnahme (unveränderbar) deaktiviert.
2)	 Wenn das SxS-Aufnahmeformat auf MPEG oder ProRes eingestellt ist, kann Log oder Look ausgewählt werden (nur FHD).
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Vollständige Menüfunktionen
Das vollständige Menü zum Konfigurieren der 
für Aufnahme und Wiedergabe erforderlichen 
Einstellungen rufen Sie auf dem Subdisplay auf, 
indem Sie die Taste MENU mindestens zwei 
Sekunden lang gedrückt halten.

Menüstruktur

Shooting-Menü

Menü für aufnahmebezogene Einstellungen.

Project-Menü

Menü für grundlegende Einstellungen eines 
Projekts.

TC/Media-Menü

Menü für Einstellungen in Bezug auf Zeitcode und 
Aufzeichnungsmedien.

Monitoring-Menü

Menü für Einstellungen in Bezug auf Videoausgang 
und Sucherausgang.

Audio-Menü

Menü für audiobezogene Einstellungen.

Technical-Menü

Menü für technische Einstellungen.

Maintenance-Menü

Menü für Geräteeinstellungen wie Uhrzeit und 
Sprache.

Bedienelemente

Taste MENU (Seite 9)
Halten Sie diese Taste mindestens zwei Sekunden 
gedrückt, um das vollständige Menü auf dem 
Subdisplay aufzurufen.

Regler SEL/SET (Regler MENU) (Seite 9)
Drehen Sie den Regler, um den Cursor in die 
entsprechende Richtung zu bewegen, sodass 
Sie Menüoptionen oder Einstellwerte auswählen 
können.
Drücken Sie den Regler MENU, um die 
ausgewählte Option zu übernehmen.

Taste BACK (Seite 10)
Zur Rückkehr zum vorhergehenden Menü 
drücken. Unbestätigte Änderungen werden 
verworfen.

Einstellen von Menüoptionen

Drehen Sie den Regler MENU, um den Cursor 
auf die einzustellende Menüoption zu bewegen. 
Drücken Sie dann zur Auswahl der Option den 
Regler MENU.
ˎˎ Im Auswahlbereich für Menüoptionen werden 
maximal neun Zeilen angezeigt. Wenn nicht alle 
auswählbaren Optionen auf einmal angezeigt 
werden können, können Sie mit dem Cursor die 
Anzeige nach oben oder unten durchlaufen.
ˎˎ Bei Menüoptionen mit einem großen 
Einstellbereich (z. B.: –99 bis +99) wird der 
Auswahlbereich nicht angezeigt. Die aktuelle 
Einstellung wird hervorgehoben und damit 
angezeigt, dass der Wert verändert werden 
kann.
ˎˎ Wenn Sie Execute für eine ausführbare Option 
auswählen, wird die entsprechende Funktion 
ausgeführt.
ˎˎ Wenn Sie eine Menüoption auswählen, deren 
Ausführung Sie zunächst bestätigen müssen, 
wird eine Bestätigungsmeldung angezeigt. 
Gehen Sie nach den Anweisungen in der 
Meldung vor, um die Funktion auszuführen oder 
abzubrechen.
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Vollständige Menüliste
Die nachfolgende Liste enthält die Funktionen und verfügbaren Einstellungen jeder Menüoption.

Shooting-Menü

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.
Shooting > FPS

Legt die Aufnahmebildrate fest.

[Hinweis]
FPS kann nicht konfiguriert werden, wenn Project > Basic Setting > SxS Rec Format im vollständigen Menü auf Interlaced-
Aufnahme eingestellt ist. In diesem Fall wechselt die Einstellung Fixed/Variable Select zu Fixed.

Menüoption Einstellungen Beschreibung

Fixed/Variable Select Fixed/Variable Wählt aus, ob die Einstellung FPS auf Aufnahme 
mit konstanter oder variabler Geschwindigkeit 
eingestellt ist.

[Hinweis]
Fest auf Variable eingestellt, wenn im vollständigen 
Menü Project > Basic Setting > Imager Mode (Seite 58) 
auf 4K 2.39:1 eingestellt ist.

FPS Select Wenn Fixed/Variable Select auf 
Fixed eingestellt ist, wird einer 
der folgenden Werte angezeigt.

Fixed 24/Fixed 25/Fixed 30/
Fixed 48/Fixed 50/Fixed 60

Wählt die Aufnahmebildrate aus.
Die voreingestellten Werte variieren wie unten 
gezeigt in Abhängigkeit von der Einstellung für 
Project Frame Rate.

Project 
Frame 
Rate

Voreinstellung 
wenn Fixed/
Variable Select 
auf Variable 
eingestellt ist

Anzeigewert, 
wenn Fixed/
Variable Select 
auf Fixed 
eingestellt ist

59.94 60 Fixed 60

50 50 Fixed 50

47.95 48 Fixed 48

29.97 30 Fixed 30

25 25 Fixed 25

24 24 Fixed 24

23.97 24 Fixed 24

[Hinweis]
Fest auf 120 eingestellt, wenn im vollständigen Menü 
Project > Basic Setting > Imager Mode (Seite 58) auf 
4K 2.39:1 eingestellt ist.

Shooting > Shutter
Einstellungen in Bezug auf den elektronischen Verschluss.

[Hinweis]
Shutter ist abgeblendet und kann nicht bedient werden, wenn eine RM-B170 oder andere Fernbedienung angeschlossen ist 
und im vollständigen Menü Technical > System Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

Menüoption Einstellungen Beschreibung

Shutter Select Wenn Shutter Mode (Seite 68) 
auf Speed gesetzt ist
Voreingestellte Auswahloptionen

1/24, 1/25, 1/30, 1/48, 1/50, 
1/60,  
1/100, 1/120, 1/250, 1/500,  
1/1000, 1/2000 1)

Wenn Shutter Mode (Seite 68) 
auf Angle gesetzt ist
Voreingestellte Auswahloptionen

360.0/180.0/172.8/144.0/ 
90.0/45.0/22.5/11.2/5.6

Falls Step/Cont. Select auf 
Continuous eingestellt ist, lautet 
der Auswahlbereich 360.0 bis 4.2 
(Angle) oder 1/241) bis 1/80002) 
(Speed).

Zum Auswählen von Verschlusswinkel oder 
Geschwindigkeit des elektronischen Verschlusses.
Die voreingestellten Geschwindigkeitswerte für 
unterschiedliche Einstellungen des Werts Project 
Frame Rate (Seite 58) sind nachfolgend 
aufgeführt.

23.98/24: 1/24
25: 1/25
29.97: 1/30
47.95: 1/48
50: 1/50
59.94: 1/60

Step/Cont. Select Step/Continuous Zum Auswählen, ob die Werte des elektronischen 
Verschlusses abgestuft oder kontinuierlich sein 
sollen.

Add/Change Step Zum Hinzufügen oder Bearbeiten einer in Shutter 
Select im Step-Modus verfügbaren Option.
Es können bis zu 16 Auswahloptionen 
hinzugefügt werden.

Delete Step Zum Löschen einer in Shutter Select im Step-
Modus verfügbaren Option.

Shooting > ND
Legt die ND-Filterposition fest.

Menüoption Einstellungen Beschreibung

ND Position Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/ 
2.4

Wählt die Dichte des ND-Filters aus.
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Shooting > Exposure Index
Stellt den EI-Wert ein.

[Hinweis]
Exposure Index ist abgeblendet und kann nicht verändert werden, wenn im vollständigen Menü Technical > System 
Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

Menüoption Einstellungen Beschreibung

EI Select Die Einstellung wechselt 
abhängig von der Einstellung für 
Project > Basic Setting > Base ISO 
(Seite 58) im vollständigen 
Menü wie folgt.
ISO 500:

125EI/160EI/200EI/250EI/ 
320EI/400EI/500EI/640EI/ 
800EI/1000EI/1250EI/1600EI/ 
2000EI

ISO 2500:
640EI/800EI/1000EI/1250EI/ 
1600EI/2000EI/2500EI/ 
3200EI/4000EI/5000EI/ 
6400EI/8000EI/10000EI

Wählt den EI-Wert aus.

[Hinweis]
Die Einstellungen sind auf die folgenden Werte 
festgelegt, wenn im vollständigen Menü Technical 
> System Configuration > RM/RCP Paint Control 
(Seite 68) auf On eingestellt ist.
Wenn Base ISO auf ISO500 eingestellt ist: 500EI
Wenn Base ISO auf ISO2500 eingestellt ist: 2500EI

Shooting > White Balance
Einstellungen in Bezug auf den Weißwert.

[Hinweis]
White Balance ist abgeblendet und kann nicht bedient werden, wenn eine RM-B170 oder andere Fernbedienung 
angeschlossen ist und im vollständigen Menü Technical > System Configuration > RM/RCP Paint Control (Seite 68) auf On 
eingestellt ist.

Menüoption Einstellungen Beschreibung

Color Temp. Select 3200K+00/4300K+00/ 
5500K+00
+ weitere hinzugefügte 
Optionen (bis zu 16)

Dient zum Anzeigen und Auswählen der 
Farbtemperatur/des Farbtons des Weißwerts.

Add/Change Step Zum Hinzufügen oder Bearbeiten einer 
Auswahloption durch Ändern der Farbtemperatur 
und des Tonwerts des Weißwerts.

Delete Step Zum Löschen einer hinzugefügten 
Auswahloption.

Auto White Balance Execute/Cancel Führt den automatischen Weißabgleich durch 
(Ausführen durch Auswählen von Execute).

Shooting > LUT Select
Einstellungen bezüglich der auf das Ausgangsbild anzuwendenden LUT.

[Hinweise]
ˎˎ LUT Select ist abgeblendet und kann nicht verändert werden, wenn im vollständigen Menü Technical > System 

Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist.
ˎˎ Nur fest auf HLG eingestellt, wenn im Menü Project > Basic Setting > Input Color Space (Seite 58) auf Rec.2020/HLG_

Rec.2100 eingestellt ist.

Menüoption Einstellungen Beschreibung

SDI 1/2 Log/HLG Nur Anzeige, da die LUT nicht auf das SDI 
1/2-Ausgangsbild angewendet werden kann.

SDI 3/4 Log/Look/---/HLG Wählt die auf das SDI 3/4-Ausgangsbild 
anzuwendende LUT aus.

Monitor Log/s709/R709(800%)/Look/---/
HLG
Die Voreinstellungswerte sind 
nachfolgend aufgeführt.

Wenn Output Format > SDI 
1/2 auf 2K/HD eingestellt ist: 
s709
Wenn Output Format > SDI 
1/2 auf 4K/QFHD eingestellt 
ist: Look

Wählt die auf das Monitor-Ausgangsbild 
anzuwendende LUT aus.

HDMI Log/s709/R709(800%)/Look/ 
HLG
Die Voreinstellungswerte sind 
nachfolgend aufgeführt.

Wenn Output Format > SDI 
1/2 auf 2K/HD eingestellt ist: 
s709
Wenn Output Format > SDI 
1/2 auf 4K/QFHD und HDMI 
nicht auf 4K/QFHD 
eingestellt ist: Look
Wenn Output Format > 
HDMI auf 4K/QFHD 
eingestellt ist: Log

Zeigt die auf das HDMI-Ausgangsbild 
anzuwendende LUT an.

VF LUT Log/s709/R709(800%) Wählt die auf das Ausgangsbild des Suchers/
Monitorbildschirms anzuwendende LUT aus.

[Hinweise]
ˎˎ Fest auf R709(800%) eingestellt, wenn im 

vollständigen Menü Technical > System Configuration 
> RM/RCP Paint Control (Seite 68) auf On eingestellt 
ist.
ˎˎ Auf das Sucher-/Monitorausgabebild wird ein SDR-

Verstärkungswert (–12 dB) angewendet.
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Shooting > LUT Select
Einstellungen bezüglich der auf das Ausgangsbild anzuwendenden LUT.

[Hinweise]
ˎˎ LUT Select ist abgeblendet und kann nicht verändert werden, wenn im vollständigen Menü Technical > System 

Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist.
ˎˎ Nur fest auf HLG eingestellt, wenn im Menü Project > Basic Setting > Input Color Space (Seite 58) auf Rec.2020/HLG_

Rec.2100 eingestellt ist.

Menüoption Einstellungen Beschreibung

SxS Rec Log/Look/---/HLG Wählt die auf das aufgezeichnete SDI-Hauptclip-
Video anzuwendende LUT aus.

Sub Rec Log/Look/---/HLG Wählt die auf das aufgezeichnete SDI-Unterclip-
Video anzuwendende LUT aus.

Shooting > Look
Einstellungen in Bezug auf Preset Look.

[Hinweis]
Look ist abgeblendet und kann nicht verändert werden, wenn im vollständigen Menü Technical > System Configuration > 
RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

Menüoption Einstellungen Beschreibung

Category Preset Look/User 3D LUT Wählt die LUT-Kategorie aus.

Preset Look Select s709 / R709(800%) / S-Gamut3.
Cine/SLog3 / S-Gamut3/SLog3

Wählt den Preset Look aus.
Gibt Bilder aus, die als Ausgangspunkt für die 
Farbabstufung geeignet sind oder die nahe an der 
Druckqualität sind.
s709: Kinofarben
R709(800%): Originalgetreue Farben
S-Gamut3/SLog3: Großer Farbraum
S-Gamut3.Cine/SLog3: Farbraum für Digitalkino

[Hinweise]
ˎˎ Nur konfigurierbar, wenn Category auf Preset Look 

eingestellt ist.
ˎˎ S-Gamut3/SLog3 kann nur ausgewählt werden, wenn 

im vollständigen Menü Project > Basic Setting > 
Input Color Space (Seite 58) auf S-Gamut3/SLog3 
eingestellt ist.

User 3D LUT Select Name (01 bis 16) von im internen 
Speicher abgelegten User 3D 
LUT-Dateien

Wählt die User 3D LUT-Datei aus.

[Hinweis]
Nur konfigurierbar, wenn Category auf User 3D LUT 
eingestellt ist.

Shooting > Look
Einstellungen in Bezug auf Preset Look.

[Hinweis]
Look ist abgeblendet und kann nicht verändert werden, wenn im vollständigen Menü Technical > System Configuration > 
RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

Menüoption Einstellungen Beschreibung

ASC CDL Process CDL Off/Look-> CDL/CDL -> 
Look

Legt fest, ob ASC-CDL auf das Ausgabevideo 
angewendet wird. Wenn Sie diese Funktion 
anwenden, geben Sie die ASC-CDL-
Verarbeitungsreihenfolge an.
CDL Off: ASC-CDL wird nicht auf das 

Ausgabevideo angewendet.
CDL -> Look: CDL vor Look anwenden.
Look -> CDL: CDL nach Look anwenden.

[Hinweise]
ˎˎ ASC CDL ist für Ausgänge aktiviert, für die unter 

Shooting > LUT Select (Seite 56) im vollständigen 
Menü die Option Look aktiviert ist.
ˎˎ Die Bedingungen, unter denen die Optionen für den 

ASC CDL Process aktiviert sind, werden im Folgenden 
angegeben.
Wenn keine ASC-CDL-Datei ausgewählt ist:

CDL Off
Wenn eine ASC-CDL-Datei ausgewählt und Shooting 

> Look > Category (Seite 57) auf Preset Look 
gesetzt ist:
CDL Off / Look -> CDL

Wenn eine ASC-CDL-Datei ausgewählt, Shooting > 
Look > Category auf User 3D LUT und Preset 
Look Select (Seite 57) auf s709 gesetzt ist:
CDL Off / Look -> CDL

Wenn eine ASC-CDL-Datei ausgewählt, Shooting > 
Look > Category auf User 3D LUT und Preset 
Look Select nicht auf s709 gesetzt ist:
CDL Off / Look -> CDL / CDL -> Look

ASC CDL Select No File/Not Selected Wählt die im Gerät registrierte ASC-CDL aus.

ASC CDL Information Zeigt Informationen zu der mit ASC CDL Select 
ausgewählten ASC-CDL an.
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Shooting > Look File
Lädt eine User 3D LUT-Datei ins Gerät.

[Hinweis]
Look File ist abgeblendet und kann nicht verändert werden, wenn im vollständigen Menü Technical > System Configuration 
> RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

Menüoption Einstellungen Beschreibung

Load User 3D LUT Lädt eine auf einer SD-Karte gespeicherte User 3D 
LUT-Datei ins Gerät.

Reset User 3D LUT Setzt eine User 3D LUT-Dateneinstellung zurück.

Reset All User 3D LUTs Execute/Cancel Setzt alle User 3D LUT-Dateneinstellungen zurück 
(Ausführen durch Auswählen von Execute).

Load ASC CDL Lädt ASC-CDL-Daten von einer SD-Karte.

Reset ASC CDL Setzt eine ASC-CDL-Dateneinstellung zurück.

Reset All ASC CDLs Execute/Cancel Setzt alle ASC-CDL-Dateneinstellungen zurück 
(Ausführen durch Auswählen von Execute).

1)	 Die Optionen lauten 1/60 und nachfolgende Werte bei einer Projektbildrate von 59.94, 1/50 und nachfolgende Werte bei 
50.0, 1/30 und nachfolgende Werte bei 29.97 sowie 1/25 und nachfolgende Werte bei 25.0.

2)	 Die Optionen lauten 1/7000 und vorhergehende Werte bei Projektbildraten von 50.0 oder 25.0 sowie 1/6000 und 
vorhergehende Werte bei 24.0 oder 23.98.

Project-Menü

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.
Project > Basic Setting

Einstellungen bezüglich Bildgröße und Projektbildrate.

Menüoption Einstellungen Beschreibung

Imager Mode 6K 3:2/6K 1.85:1/6K 17:9/ 
6K 2.39:1/5.7K 16:9/4K 6:5/ 
4K 4:3/4K 4:3 Surround View/ 
4K 17:9/4K 17:9 Surround View/ 
4K 2.39:1/3.8K 16:9/ 
3.8K 16:9 Surround View

Wählt die effektive Bildgröße aus.

[Hinweise]
ˎˎ 6K 3:2/6K 1.85:1/6K 17:9 werden nur angezeigt, wenn 

eine Vollformatlizenz installiert ist.
ˎˎ 4K 6:5/4K 4:3/4K 4:3 Surround View werden nur 

angezeigt, wenn eine Anamorphotische Lizenz 
installiert ist.
ˎˎ 4K 2.39:1 wird nur angezeigt, wenn eine High Frame 

Rate-Lizenz installiert ist.

Project Frame Rate 23.98/24/25/29.97/47.95/ 
50/59.94

Wählt die Projektbildrate aus.

Input Color Space S-Gamut3.Cine/SLog3 /  
S-Gamut3/SLog3 /  
Rec.2020/HLG_Rec.2100

Stellt den Farbraum ein.

[Hinweis]
Rec.2020/HLG_Rec.2100 kann nur ausgewählt werden, 
wenn im vollständigen Menü Technical > System 
Configuration > RM/RCP Paint Control (Seite 68) auf 
On eingestellt ist.

AXS Rec Format
(nur wenn ein AXS-R7 
angeschlossen ist)

Rec Off/X-OCN XT/RAW SQ/ 
X-OCN ST/X-OCN LT

Wählt das Videoformat für die Aufnahme auf einer 
AXS-Speicherkarte aus, die in einen AXS-R7 
eingesetzt ist.

SxS Rec Format Rec Off/XAVC 4K Class480/ 
XAVC 4K Class300/ 
XAVC QFHD Class480/ 
XAVC QFHD Class300/ 
MPEG HD P/MPEG HD i/ 
ProRes 422 HQ HD P/ 
ProRes 422 HQ HD i/ 
ProRes 422 HD P/ 
ProRes 422 HD i/ 
ProRes Proxy HD P/ 
ProRes Proxy HD i

Wählt das auf eine SxS-Speicherkarte 
aufzunehmende Videoformat aus.

Sub Rec Format Rec Off/MPEG HD P/ 
MPEG HD i/ 
ProRes 422 Proxy HD P/ 
ProRes 422 Proxy HD i

Wählt das Unteraufzeichnungsformat für SxS-
Speicherkarten aus.

Base ISO ISO 500/ISO 2500 Legt die ISO-Basisempfindlichkeit fest.
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Project > Basic Setting
Einstellungen bezüglich Bildgröße und Projektbildrate.

Menüoption Einstellungen Beschreibung

SxS/Output 
De‑Squeeze

Off (1.0×)/1.25×/1.3×/1.5×/ 
1.8×/2.0×

Legt die Entzerrungsverarbeitung für SxS-
Aufzeichnungssignale und Videoausgangssignale 
fest.
Diese Einstellung ist verfügbar, wenn eine 
anamorphotische Lizenz installiert und Imager 
Mode auf 4K 4:3/4K 4:3 Surround View/4K 6:5/4K 
17:9/4K 17:9 Surround View/6K 3:2/6K 17:9 
eingestellt ist, oder wenn eine anamorphotische 
Lizenz und eine Vollformatlizenz installiert sind 
und Imager Mode auf 6K 3:2/6K 17:9 eingestellt 
ist. Die Optionen hängen von der Bildgröße ab.

Imager Mode SxS/Output De-Squeeze

Off (1.0×) 1.25× 1.3× 1.5× 1.8× 2.0×

6K 6048×4032 3:2 Ja Ja Ja Ja Ja Ja

6K 6054×3192 17:9 Ja Ja Ja – – Ja

4K 4096×3432 6:5 Ja – – – – Ja

4K 4096×3024 4:3 Ja – Ja – – Ja

4K 4096×3024 4:3 Surround Ja – Ja – – Ja

4K 4096×2160 17:9 Ja Ja Ja – – Ja

4K 4096×2160 17:9 
Surround

Ja Ja Ja – – Ja

Project > Special Recording
Zum Vornehmen von Einstellungen für die Bildpuffer-Aufnahme.

Menüoption Einstellungen Beschreibung

Cache Rec Select On/Off Schaltet die Bildpuffer-Aufnahmefunktion ein/aus.
In den folgenden Fällen wird die Bildpuffer-
Aufnahme nicht unterstützt (deaktiviert und 
abgeblendet).
ˎˎ Wenn das Aufnahmeformat XAVC-I Class480 (4K, 

QFHD) ausgewählt ist

ˎˎ Bei einigen Kombinationen aus effektiver 
Bildgröße und Systemfrequenzeinstellungen

ˎˎ Wenn sowohl AXS Rec Format als auch SxS Rec 
Format auf Rec Off eingestellt sind

ˎˎ Bei gleichzeitiger AXS- und SxS-Aufnahme

Project > Special Recording
Zum Vornehmen von Einstellungen für die Bildpuffer-Aufnahme.

Menüoption Einstellungen Beschreibung

Max Cache Rec 
Duration

2sec/4sec/6sec/8sec/10sec/ 
15sec/24sec/30sec

Legt die Wiedergabedauer des Videos fest, das im 
Bildpufferspeicher zwischengespeichert werden 
soll.
Die für die einzelnen Speicherkarten einstellbaren 
Maximalwerte sind im Folgenden angegeben.

Bei Aufnahmen auf einer SxS-Speicherkarte

SxS Rec Format Project Frame Rate

23.98 24 25 29.97 47.95 50 59.94

4K/QFHD XAVC-I Class480 – – – – – – –

4K/QFHD XAVC-I Class300 2 2 2 2 – – –

2K/FHD ProRes 422 HQ P 2 2 2 2 – – –

2K/FHD ProRes 422 HQ i – – – – – 2 2

2K/FHD ProRes 422 P 6 6 6 6 – 2 2

2K/FHD ProRes 422 i – – – – – 6 6

MPEG HD422 P 15 – 15 15 – – –

MPEG HD422 i – – – – – 15 15
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Project > Special Recording
Zum Vornehmen von Einstellungen für die Bildpuffer-Aufnahme.

Menüoption Einstellungen Beschreibung

Bei Aufnahmen auf einer AXS-Speicherkarte

Imager 
Mode

AXS Rec 
Format

Project Frame Rate

23.98 24 25 29.97 47.95 50 59.94

6K 
6048×4032 
3:2

X-OCN XT 4 4 2 2 – – –

X-OCN ST 8 8 8 6 – – –

X-OCN LT 15 15 15 15 – 6 4

6K 
6054×3272 
1.85:1

X-OCN XT 6 6 6 4 – – –

X-OCN ST 10 10 10 8 – – –

X-OCN LT 24 24 24 15 – – –

6K 
6054×3192 
17:9

X-OCN XT 6 6 6 4 – – –

X-OCN ST 10 10 10 8 – – –

X-OCN LT 24 24 24 15 – – –

6K 
6048×2534 
2.39:1

X-OCN XT 10 10 10 6 – – –

X-OCN ST 15 15 15 10 – – –

X-OCN LT 30 30 30 24 – – –

5.7K 
5674×3192 
16:9

X-OCN XT 6 6 6 4 – – –

X-OCN ST 10 10 10 8 – – –

X-OCN LT 24 24 24 15 – – –

4K 
4096×3432 
6:5

X-OCN XT 10 10 10 8 – – –

X-OCN ST 15 15 15 15 – – –

X-OCN LT 30 30 30 30 – – –

4K 
4096×3024 
4:3

X-OCN XT 15 15 10 10 4 4 2

X-OCN ST 24 24 24 15 8 8 6

X-OCN LT 30 30 30 30 15 15 15

Project > Special Recording
Zum Vornehmen von Einstellungen für die Bildpuffer-Aufnahme.

Menüoption Einstellungen Beschreibung

Imager 
Mode

AXS Rec 
Format

Project Frame Rate

23.98 24 25 29.97 47.95 50 59.94

4K 
4096×3024 
4:3 Surround

X-OCN XT 15 15 10 10 – – –

X-OCN ST 24 24 24 15 – – –

X-OCN LT 30 30 30 30 – – –

4K 
4096×2160 
17:9

RAW SQ 24 24 24 15 8 8 6

X-OCN XT 24 24 24 15 8 8 6

X-OCN ST 30 30 30 30 15 15 10

X-OCN LT 30 30 30 30 30 30 24

4K 
4096×2160 
17:9 
Surround

RAW SQ 24 24 24 15 – – –

X-OCN XT 24 24 24 15 – – –

X-OCN ST 30 30 30 30 – – –

X-OCN LT 30 30 30 30 – – –

4K 
4096×1716 
2.39:1

X-OCN XT 30 30 30 24 – 10 10

X-OCN ST 30 30 30 30 – 15 15

X-OCN LT 30 30 30 30 – 30 30

3.8K(QFHD) 
3840×2160 
16:9

X-OCN XT 24 24 24 15 – 8 6

X-OCN ST 30 30 30 30 – 15 10

X-OCN LT 30 30 30 30 – 30 24

3.8K(QFHD) 
3840×2160 
16:9 
Surround

X-OCN XT 24 24 24 15 – – –

X-OCN ST 30 30 30 30 – – –

X-OCN LT 30 30 30 30 – – –
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Project > Assignable Button
Ordnet belegbare Funktionstasten Funktionen zu.

Einzelheiten zum Zuweisen von Funktionen siehe „Bildschirm User Functions“ (Seite 39).

Menüoption Einstellungen Beschreibung

<1> Seite 39 Weist der belegbaren Funktionstaste 1 eine 
Funktion zu.

<2> Seite 39 Weist der belegbaren Funktionstaste 2 eine 
Funktion zu.

<3> Seite 39 Weist der belegbaren Funktionstaste 3 eine 
Funktion zu.

<4> Seite 39 Weist der belegbaren Funktionstaste 4 eine 
Funktion zu.

<VF A> Seite 39 Weist der belegbaren Funktionstaste A am Sucher 
(DVF-EL200) eine Funktion zu.

<VF B> Seite 39 Weist der belegbaren Funktionstaste B am Sucher 
(DVF-EL200) eine Funktion zu.

<VF C> Seite 39 Weist der belegbaren Funktionstaste C am Sucher 
(DVF-EL200) eine Funktion zu.

<User 1> Seite 39 Weist der Taste ITEM 1 eine Funktion zu.

<User 2> Seite 39 Weist der Taste ITEM 2 eine Funktion zu.

<User 3> Seite 39 Weist der Taste ITEM 3 eine Funktion zu.

<User 4> Seite 39 Weist der Taste ITEM 4 eine Funktion zu.

<User 5> Seite 39 Weist der Taste ITEM 5 eine Funktion zu.

Project > All File
Einstellungen in Bezug auf All-Einstellungsdateien.

Menüoption Einstellungen Beschreibung

Load SD Card All-Einstellungsdatei von einer SD-Karte laden.

Save SD Card All-Einstellungsdatei auf einer SD-Karte speichern.

File ID Zeigt die Datei-ID der All-Einstellungsdatei zur 
Bearbeitung an.

Format SD Card Formatiert eine SD-Karte.

TC/Media-Menü

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.
TC/Media > Timecode

Einstellungen bezüglich des Zeitcodes.

Menüoption Einstellungen Beschreibung

Mode Preset F-Run (Ext-Lk)/Preset 
R-Run/Int Regen

Wählt den Zeitcode-Modus aus.
Preset F-Run (Ext-Lk): Zeitcode schreitet 

kontinuierlich ab dem angegebenen Wert 
synchronisiert mit dem extern eingespeisten 
Zeitcode fort.

Preset R-Run: Zeitcode schreitet nur dann, wenn 
aufgezeichnet wird, ab dem angegebenen 
Wert fort.

Int Regen: Der Zeitcode des vorhergehenden 
Clips wird fortgesetzt.

Manual Setting 00:00:00:00 bis 23:59:59:29 Zum Festlegen eines gewünschten 
Zeitcodewerts.

Reset Execute/Cancel Stellt den Zeitcode zurück auf 00:00:00:00 
(Ausführen durch Auswählen von Execute).

TC Format DF/NDF Wählt das Zeitcode-Format.
DF: Drop-Frame
NDF: Non-Drop-Frame

TC Source Internal/External Zeigt die TCG-Synchronisationsquelle an.

Time Data Display Timecode/Duration Wählt die anzuzeigenden Zeitdaten aus.

TC/Media > Clip Name Format
Legt Clipnamen fest. (Clipname: Camera ID + Reel Number + Shot Number + Datum + beliebige 
Zeichenfolge)

Menüoption Einstellungen Beschreibung

Camera ID A bis Z Legt die zur Bildung von Clipnamen verwendete 
Kamera-ID fest.

Reel Number 001 bis 999 Legt den zur Bildung von Clipnamen 
verwendeten numerischen Teil von Reel Number 
fest.
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TC/Media > Clip Name Format
Legt Clipnamen fest. (Clipname: Camera ID + Reel Number + Shot Number + Datum + beliebige 
Zeichenfolge)

Menüoption Einstellungen Beschreibung

Camera Position C/L/R Legt das zur Bildung von Clipnamen verwendete 
erste Zeichen von Shot Number fest.

SxS Root Folder Name XDROOT/Cam ID + Reel# Legt das Namensformat für die 
Datenträgerbezeichnung und den Namen des 
Stammverzeichnisses auf einer SxS-Karte fest.
XDROOT: Das Stammverzeichnis erhält den 

Namen „XDROOT“.
Cam ID + Reel#: Die Datenträgerbezeichnung und 

der Name des Stammverzeichnisses 
entsprechen dem Namensformat für die Cam 
ID.

[Hinweise]
ˎˎ Wenn die Einstellung geändert wird, ist die 

Wiedergabe auf anderen Sony-Camcordern und 
VTRs als MPC-3610 und PMW-PZ1 nicht möglich 
(die Einstellung muss auf dem PMW-PZ1 geändert 
werden).
ˎˎ Änderungen an der Datenträgerbezeichnung und 

dem Namen des Stammverzeichnisses werden beim 
Beginn der Aufzeichnung wirksam.
ˎˎ Bei Medien, bei denen für den Namen des 

Stammverzeichnisses das Namensformat der 
Kamera-ID festgelegt wurde, kann der Name des 
Stammverzeichnisses nicht mit dieser Einstellung auf 
„XDROOT“ zurückgesetzt werden.
ˎˎ Wenn Medien formatiert werden, wird der 

Stammordner auf „XDROOT“ gesetzt.
ˎˎ Wenn Medien, die mit einem 

Stammverzeichnisnamen im Kamera-ID-
Namensformat aufgezeichnet wurden, in ein 
Gerät eingelegt werden, das das Kamera-ID-
Namensformat nicht unterstützt (einschließlich 
Venice V2.0 oder früher), wird ein XDROOT-Ordner 
erstellt und als Stammverzeichnis erkannt (weil ein 
Stammverzeichnis im Namensformat der Kamera-ID 
nicht erkannt werden kann).

TC/Media > Format Media
Formatiert Medien.

Menüoption Einstellungen Beschreibung

AXS Slot A
(nur wenn ein AXS-R7 
angeschlossen ist)

Execute/Cancel Initialisiert die AXS-Speicherkarte in Einschub A 
(Ausführen durch Auswählen von Execute).

TC/Media > Format Media
Formatiert Medien.

Menüoption Einstellungen Beschreibung

AXS Slot B
(nur wenn ein AXS-R7 
angeschlossen ist)

Execute/Cancel Initialisiert die AXS-Speicherkarte in Einschub B 
(Ausführen durch Auswählen von Execute).

SxS Slot A Execute/Cancel Initialisiert die SxS-Speicherkarte in Einschub A 
(Ausführen durch Auswählen von Execute).

SxS Slot B Execute/Cancel Initialisiert die SxS-Speicherkarte in Einschub B 
(Ausführen durch Auswählen von Execute).

SD Card Execute/Cancel Formatiert die SD-Karte (Ausführen durch 
Auswählen von Execute).

TC/Media > Update Media
Aktualisiert die Verwaltungsdatei des Mediums.

Menüoption Einstellungen Beschreibung

AXS Slot A
(nur wenn ein AXS-R7 
angeschlossen ist)

Execute/Cancel Aktualisiert die Verwaltungsdatei auf der AXS-
Speicherkarte in Einschub A des AXS-R7 
(Ausführen durch Auswählen von Execute).

AXS Slot B
(nur wenn ein AXS-R7 
angeschlossen ist)

Execute/Cancel Aktualisiert die Verwaltungsdatei auf der AXS-
Speicherkarte in Einschub B des AXS-R7 
(Ausführen durch Auswählen von Execute).

SxS Slot A Execute/Cancel Aktualisiert die Verwaltungsdatei auf der SxS-
Speicherkarte in Einschub A (Ausführen durch 
Auswählen von Execute).

SxS Slot B Execute/Cancel Aktualisiert die Verwaltungsdatei auf der SxS-
Speicherkarte in Einschub B (Ausführen durch 
Auswählen von Execute).
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Monitoring-Menü

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.
Monitoring > Output Format

Einstellungen in Bezug auf das Ausgangsformat.

Menüoption Einstellungen Beschreibung

SDI 1/2 Die verfügbaren Einstellungen 
variieren je nach Imager-Modus, 
Projektbildrate und SxS-Aufzeich-
nungsformateinstellungen.

Wählt das SDI 1/2-Ausgangsformat aus.
Einstellungen variieren je nach Einstellung des 
Aufzeichnungsformats (Seite 97).

SDI 3/4 Die verfügbaren Einstellungen 
variieren je nach Einstellung für 
SDI 1/2.

Wählt das SDI 3/4-Ausgangsformat aus.
Einstellungen variieren je nach Einstellung des 
Aufzeichnungsformats (Seite 97).

Monitor Die verfügbaren Einstellungen 
variieren je nach Einstellung für 
SDI 1/2.

Wählt das Monitor-Ausgangsformat aus.
Einstellungen variieren je nach Einstellung des 
Aufzeichnungsformats (Seite 101).

HDMI Die verfügbaren Einstellungen 
variieren je nach Einstellung für 
SDI 1/2.

Wählt das HDMI-Ausgangsformat.
Einstellungen variieren je nach Einstellung des 
Aufzeichnungsformats (Seite 101).

Monitoring > OSD Appearance
Einstellungen bezüglich der den einzelnen Ausgangssignalen überlagerten Informationen und 
Rahmenlinien.
Die Einstellung On/Off wird über ein Kontrollkästchen ausgewählt (außer Frame Line on Playback).
On: Kontrollkästchen ausgewählt
Off: Kontrollkästchen deaktiviert

Menüoption Einstellungen Beschreibung

VF Status Info (On/Off,  
Info. A/Info. B)

Wählt die dem Ausgangsbild des Suchers/
Monitorbildschirms zu überlagernden 
Informationen aus.

Frame Line (On/Off, 
Line A/Line B)

Wählt die dem Ausgangsbild des Suchers/
Monitorbildschirms zu überlagernden 
Rahmenlinien aus.

SDI
SDI 1/2
SDI 3/4

[Hinweis]
Die Anzeige ändert 
sich entsprechend den 
Einstellungen für Output 
Format > SDI 1/2 und 
SDI 3/4.

Status Info (On/Off,  
Info. A/Info. B)

Wählt die dem SDI 3/4-Ausgangssignal zu 
überlagernden Informationen aus.

Frame Line (On/Off,  
Line A/Line B)

Wählt die dem SDI 3/4-Ausgangssignal zu 
überlagernden Rahmenlinien aus.

Monitoring > OSD Appearance
Einstellungen bezüglich der den einzelnen Ausgangssignalen überlagerten Informationen und 
Rahmenlinien.
Die Einstellung On/Off wird über ein Kontrollkästchen ausgewählt (außer Frame Line on Playback).
On: Kontrollkästchen ausgewählt
Off: Kontrollkästchen deaktiviert

Menüoption Einstellungen Beschreibung

Monitor Status Info (On/Off,  
Info. A/Info. B)

Wählt die dem SDI 3/4-Ausgangssignal zu 
überlagernden Informationen aus.

Frame Line (On/Off,  
Line A/Line B)

Wählt die dem SDI 3/4-Ausgangssignal zu 
überlagernden Rahmenlinien aus.

HDMI Same as SDI/Same as Monitor Wählt aus, ob die dem HDMI-Ausgangssignal 
überlagerten Informationen die gleichen für den 
SDI-Ausgang oder den Monitorausgang sein 
sollen.

Status Info A/B Setup Project
Info. A (On/Off )
Info. B (On/Off )

Legt fest, ob das Projekt in den 
Ausgabeinformationen für Status Info A und 
Status Info B angezeigt wird.

Timecode
Info. A (On/Off)
Info. B (On/Off )

Legt fest, ob der Zeitcode in den 
Ausgabeinformationen für Status Info A und 
Status Info B angezeigt wird.

Audio Level Meter
Info. A (On/Off)
Info. B (On/Off)

Legt fest, ob ein Tonpegelmesser in den 
Ausgabeinformationen für Status Info A und 
Status Info B angezeigt wird.

Look Status
Info. A (On/Off)
Info. B (On/Off)

Legt fest, ob der Typ des ausgewählten Looks in 
den Ausgabeinformationen für Status Info A und 
Status Info B angezeigt wird.

Output LUT
Info. A (On/Off)
Info. B (On/Off )

Legt fest, ob die Ausgangs-LUT in den 
Ausgabeinformationen für Status Info A und 
Status Info B angezeigt wird.

Recording LUT
Info. A (On/Off)
Info. B (On/Off )

Legt fest, ob die Aufzeichnungs-LUT in den 
Ausgabeinformationen für Status Info A und 
Status Info B angezeigt wird.

VF Status
Info. A (On/Off )
Info. B (On/Off)

Legt fest, ob der Sucherstatus in den 
Ausgabeinformationen für Status Info A und 
Status Info B angezeigt wird.

Lens Status
Info. A (On/Off )
Info. B (On/Off )

Legt fest, ob der Objektivstatus in den 
Ausgabeinformationen für Status Info A und 
Status Info B angezeigt wird.

Remote Control Status
Info. A (On/Off )
Info. B (On/Off)

Legt fest, ob der Fernbedienungsstatus in den 
Ausgabeinformationen für Status Info A und 
Status Info B angezeigt wird.
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Monitoring > OSD Appearance
Einstellungen bezüglich der den einzelnen Ausgangssignalen überlagerten Informationen und 
Rahmenlinien.
Die Einstellung On/Off wird über ein Kontrollkästchen ausgewählt (außer Frame Line on Playback).
On: Kontrollkästchen ausgewählt
Off: Kontrollkästchen deaktiviert

Menüoption Einstellungen Beschreibung

Frame Line A/B Setup Center Marker
Line A (On/Off )
Line B (On/Off )
Option (Cross/Open Cross/
Dot)

Legt fest, ob die Mittenmarkierung in den 
Ausgabeinformationen für Frame Line A und 
Frame Line B angezeigt wird.
Wählt die Anzeigeform der Mittenmarkierung 
(Cross/Open Cross/Dot) aus.

Aspect Ratio
Line A (On/Off )
Line B (On/Off )
Option (17:9/16:9/15:9/14:9/ 
13:9/4:3/1.66:1/1.85:1/2:1/ 
2.35:1/2.39:1)

Legt fest, ob die Seitenverhältnismarkierung in 
den Ausgabeinformationen für Frame Line A und 
Frame Line B angezeigt wird.
Wählt den Modus (17:9/16:9/15:9/14:9/13:9/4:3/ 
1.66:1/1.85:1/2:1/2.35:1/2.39:1) bei der Anzeige 
der Seitenverhältnismarkierung.

Aspect Safety Zone
Line A (On/Off)
Line B (On/Off)
Option 
(80%/90%/92.5%/95%)

Legt fest, ob die Bildformat-Sicherheitszone in 
den Ausgabeinformationen für Frame Line A und 
Frame Line B angezeigt wird.
Wählt die Größe (Prozentsatz des gesamten 
Bildschirms) der Bildformat-
Sicherheitszonenmarkierung.

Picture Area
Line A (On/Off )
Line B (On/Off )

Legt fest, ob der Bildbereich in den 
Ausgabeinformationen für Frame Line A und 
Frame Line B angezeigt wird.

Safety Zone
Line A (On/Off)
Line B (On/Off)
Option 
(80%/90%/92.5%/95%)

Legt fest, ob die Sicherheitszone in den 
Ausgabeinformationen für Frame Line A und 
Frame Line B angezeigt wird.
Wählt den Bereich der Sicherheitszone 
(80%/90%/92.5%/95%) aus.

User Frame Line
Line A (On/Off)
Line B (On/Off)

Legt fest, ob die benutzerdefinierten 
Rahmenlinien in den Ausgabeinformationen für 
Frame Line A und Frame Line B angezeigt wird.

Color
Option (White/Yellow/Cyan/
Green/Magenta/Red/Blue)

Legt die Anzeigefarbe der Rahmenlinien fest.

Surround View Type
Option (Line/Mask/
Line&Mask)

Wählt die Anzeigeform der Surround View-
Markierung aus.
Line: Zeigt den Aufnahmebereich mithilfe von 

Linien an.
Mask: Zeigt den Aufnahmebereich an, indem der 

Videosignalpegel außerhalb des Bereichs 
maskiert (reduziert) wird.

Line&Mask: Zeigt den Aufnahmebereich mithilfe 
von Linien an und indem der 
Videosignalpegel außerhalb des Bereichs 
maskiert (reduziert) wird.

Monitoring > OSD Appearance
Einstellungen bezüglich der den einzelnen Ausgangssignalen überlagerten Informationen und 
Rahmenlinien.
Die Einstellung On/Off wird über ein Kontrollkästchen ausgewählt (außer Frame Line on Playback).
On: Kontrollkästchen ausgewählt
Off: Kontrollkästchen deaktiviert

Menüoption Einstellungen Beschreibung

Aspect Ratio Type
Option (Line/Mask/
Line&Mask)

Wählt die Anzeigeform der 
Seitenverhältnismarkierung aus.
Line: Zeigt Linien in der durch Color festgelegten 

Farbe an.
Mask: Zeigt Bereiche außerhalb des 

Markierungsbereichs mit niedrigerem 
Videosignalpegel an.

Line&Mask: Zeigt Linien in der mit Color 
festgelegten Farbe und Bereiche außerhalb 
des Markierungsbereichs mit niedrigerem 
Videosignalpegel an.

Mask Level
Option (0 bis 15 (12))

Wählt die Helligkeit des Bilds außerhalb der 
Markierung aus, wenn für Aspect Ratio Type oder 
Surround View Type die Einstellung Mask 
festgelegt ist.

Frame Line on Playback
Option (On/Off )

Schaltet die Funktion zum Überlagern von 
Rahmenlinien während der Wiedergabe ein/aus.

Monitoring > Monitor Display
Einstellungen bezüglich der Monitoranzeige.

Menüoption Einstellungen Beschreibung

Focus Distance Format Meter/Feet Wählt die Anzeigeeinheiten für die Fokusposition 
aus.

Monitoring > Frame Line
Einstellungen bezüglich der auf dem Ausgabebild angezeigten Linien und Markierungen.

Menüoption Einstellungen Beschreibung

Center Marker Cross/Open Cross/Dot Wählt die Anzeigeform der Mittenmarkierung aus.

Aspect Ratio 17:9/16:9/15:9/14:9/13:9/4:3/1.66:
1/1.85:1/2:1/2.35:1/2.39:1

Wählt den Modus beim Anzeigen der 
Seitenverhältnismarkierung.

Aspect Safety Zone 80%/90%/92.5%/95% Wählt die Größe (Prozentsatz des gesamten 
Bildschirms) der Bildformat-
Sicherheitszonenmarkierung.

Safety Zone 80%/90%/92.5%/95% Wählt den Sicherheitszonenbereich aus.

Color White/Yellow/Cyan/Green/
Magenta/Red/Blue

Wählt die Anzeigefarbe der Rahmenlinien aus.
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Monitoring > Frame Line
Einstellungen bezüglich der auf dem Ausgabebild angezeigten Linien und Markierungen.

Menüoption Einstellungen Beschreibung

Surround View Type Line/Mask/Line&Mask Wählt die Anzeigeform der Surround View-
Markierung aus.
Line: Zeigt den Aufnahmebereich mithilfe von 

Linien an.
Mask: Zeigt den Aufnahmebereich an, indem der 

Videosignalpegel außerhalb des Bereichs 
maskiert (reduziert) wird.

Line&Mask: Zeigt den Aufnahmebereich mithilfe 
von Linien an und indem der 
Videosignalpegel außerhalb des Bereichs 
maskiert (reduziert) wird.

Aspect Ratio Type Line/Mask/Line&Mask Wählt die Anzeigeform der 
Seitenverhältnismarkierung aus.
Line: Zeigt Linien in der durch Color festgelegten 

Farbe an.
Mask: Zeigt Bereiche außerhalb des 

Markierungsbereichs mit niedrigerem 
Videosignalpegel an.

Line&Mask: Zeigt Linien in der mit Color 
festgelegten Farbe und Bereiche außerhalb 
des Markierungsbereichs mit niedrigerem 
Videosignalpegel an.

Mask Level 0 bis 15 (12) Wählt die Helligkeit des Bilds außerhalb der 
Markierung aus, wenn für Aspect Ratio Type oder 
Surround View Type die Einstellung Mask 
festgelegt ist.

Frame Line on Playback On/Off Schaltet die Funktion zum Überlagern von 
Rahmenlinien während der Wiedergabe ein/aus.

Monitoring > User Frame Line
Einstellungen bezüglich der benutzerdefinierten Rahmenlinien.

Menüoption Einstellungen Beschreibung

Width 3 bis 479 (240) Legt die Breite der benutzerdefinierten 
Rahmenlinien fest (Abstand von der Mitte zu den 
linken und rechten Kanten).

Height 3 bis 269 (135) Legt die Höhe der benutzerdefinierten 
Rahmenlinien fest (Abstand von der Mitte zu den 
oberen und unteren Kanten).

H Position max. –476 bis 476 (±0) Legt die horizontale Position der Mitte der 
benutzerdefinierten Rahmenlinien fest.
Der Einstellbereich wird kleiner, wenn die 
Einstellung für Width über 3 steigt.

Monitoring > User Frame Line
Einstellungen bezüglich der benutzerdefinierten Rahmenlinien.

Menüoption Einstellungen Beschreibung

V Position max. –266 bis 266 (±0) Legt die vertikale Position der Mitte der 
benutzerdefinierten Rahmenlinien fest.
Der Einstellbereich wird kleiner, wenn die 
Einstellung für Height über 3 steigt.

Monitoring > False Color
Einstellungen bezüglich der Falschfarbenanzeige.

[Hinweis]
False Color ist abgeblendet und kann nicht verändert werden, wenn im vollständigen Menü Technical > System 
Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

Menüoption Einstellungen Beschreibung

Level Preset/Manual Legt fest, ob in der Sucher- bzw. Monitorausgabe 
die voreingestellte Ein-/Aus-Einstellung und der 
Schwellenwert für die einzelnen Falschfarben 
verwendet wird oder die Farben manuell 
eingestellt werden.
Wenn Manual aktiviert ist, können die folgenden 
Optionen konfiguriert werden.

Red On/Off Schaltet die Anzeige von Rot ein/aus.

Red Upper Limit 0.0% bis 109.0% (96.1%) 
(in Schritten von 0.1%)

Legt die Obergrenze für die Anzeige in Rot fest.

Red Lower Limit 0.0% bis 109.0% (93.4%) 
(in Schritten von 0,1 %)

Legt die Untergrenze für die Anzeige in Rot fest.

Yellow On/Off Schaltet die Anzeige von Gelb ein/aus.

Yellow Upper Limit 0.0% bis 109.0% (93.4%) 
(in Schritten von 0,1 %)

Legt die Obergrenze für die Anzeige in Gelb fest.

Yellow Lower Limit 0.0% bis 109.0% (91.3%) 
(in Schritten von 0,1 %)

Legt die Untergrenze für die Anzeige in Gelb fest.

Orange On/Off Schaltet die Anzeige von Orange ein/aus.

Orange Upper Limit 0.0% bis 109.0% (90.6%) 
(in Schritten von 0,1 %)

Legt die Obergrenze für die Anzeige in Orange 
fest.

Orange Lower Limit 0.0% bis 109.0% (87.7%) 
(in Schritten von 0,1 %)

Legt die Untergrenze für die Anzeige in Orange 
fest.

Pink On/Off Schaltet die Anzeige von Rosa ein/aus.

Pink Upper Limit 0.0% bis 109.0% (58.0%) 
(in Schritten von 0,1 %)

Legt die Obergrenze für die Anzeige in Rosa fest.

Pink Lower Limit 0.0% bis 109.0% (54.3%) 
(in Schritten von 0,1 %)

Legt die Untergrenze für die Anzeige in Rosa fest.

Light Pink On/Off Schaltet die Anzeige von Hellrosa ein/aus.
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Monitoring > False Color
Einstellungen bezüglich der Falschfarbenanzeige.

[Hinweis]
False Color ist abgeblendet und kann nicht verändert werden, wenn im vollständigen Menü Technical > System 
Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

Menüoption Einstellungen Beschreibung

Light Pink Upper Limit 0.0% bis 109.0% (50.8%) 
(in Schritten von 0,1 %)

Legt die Obergrenze für die Anzeige in Hellrosa 
fest.

Light Pink Lower Limit 0.0% bis 109.0% (47.8%) 
(in Schritten von 0,1 %)

Legt die Untergrenze für die Anzeige in Hellrosa 
fest.

Cyan On/Off Schaltet die Anzeige von Zyan ein/aus.

Cyan Upper Limit 0.0% bis 109.0% (46.5%) 
(in Schritten von 0,1 %)

Legt die Obergrenze für die Anzeige in Zyan fest.

Cyan Lower Limit 0.0% bis 109.0% (43.8%) 
(in Schritten von 0,1 %)

Legt die Untergrenze für die Anzeige in Zyan fest.

Green On/Off Schaltet die Anzeige von Grün ein/aus.

Green Upper Limit 0.0% bis 109.0% (42.2%) 
(in Schritten von 0,1 %)

Legt die Obergrenze für die Anzeige in Grün fest.

Green Lower Limit 0.0% bis 109.0% (38.9%) 
(in Schritten von 0,1 %)

Legt die Untergrenze für die Anzeige in Grün fest.

Light Blue On/Off Schaltet die Anzeige von Hellblau ein/aus.

Light Blue Upper Limit 0.0% bis 109.0% (34.4%) 
(in Schritten von 0,1 %)

Legt die Obergrenze für die Anzeige in Hellblau 
fest.

Light Blue Lower Limit 0.0% bis 109.0% (24.6%) 
(in Schritten von 0,1 %)

Legt die Untergrenze für die Anzeige in Hellblau 
fest.

Blue On/Off Schaltet die Anzeige von Blau ein/aus.

Blue Upper Limit 0.0% bis 109.0% (5.6%) 
(in Schritten von 0.1%)

Legt die Obergrenze für die Anzeige in Blau fest.

Blue Lower Limit 0.0% bis 109.0% (3.5%) 
(in Schritten von 0,1 %)

Legt die Untergrenze für die Anzeige in Blau fest.

Purple On/Off Schaltet die Anzeige von Magenta ein/aus.

Purple Upper Limit 0.0% bis 109.0% (3.5%) 
(in Schritten von 0,1 %)

Legt die Obergrenze für die Anzeige in Magenta 
fest.

Purple Lower Limit –7.3% bis 109.0% (–7.3%) 
(in Schritten von 0,1 %)

Legt die Untergrenze für die Anzeige in Magenta 
fest.

Reset Execute/Cancel Setzt die Ein/Aus-Einstellung und den 
Schwellenwert aller Farben zurück (Ausführen 
durch Auswahl von Execute).

Monitoring > VF Display
Einstellungen bezüglich der Sucheranzeige.

Menüoption Einstellungen Beschreibung

VF LUT Log/s709/R709(800%) Wählt die auf das Ausgangsbild des Suchers/
Monitorbildschirms anzuwendende LUT aus.

Status Info Info. A/Info. B/Off Wählt die dem Ausgangsbild des Suchers/
Monitorbildschirms zu überlagernden 
Informationen aus.

Frame Line Frame Line A/Frame Line B/Off Wählt die dem Ausgangsbild des Suchers/
Monitorbildschirms zu überlagernden 
Rahmenlinien aus.

VF Magnifier Ratio ×2.0 / ×4.0 / ×2.0/×4.0 Wählt die Fokusvergrößerung für den Sucher aus.

Color –99 bis ±0 bis +99 Stellt die Farbtiefe des Sucherbilds ein.

Monitoring > VF Function
Einstellungen bezüglich der Sucherfunktionen.

Menüoption Einstellungen Beschreibung

Double Speed Scan On/Off Schaltet die Double Speed Scan-Funktion des 
Suchers ein/aus.

Peaking Frequency Normal/High Wählt aus, ob die Peaking-Frequenz während des 
Peaking normal oder hoch ist.

[Hinweis]
Der Peaking-Pegel wird über das Suchermenü 
eingestellt.

Zebra On/Off Schaltet die Streifenfunktion ein bzw. aus.

Zebra Select 1/2/Both Wählt die Art des Zebramusters aus (Zebra 1, 
Zebra 2, beide).

Zebra1 Level 0% bis 107% (41%) Stellt den Anzeigepegel für Zebra 1 ein.

Zebra1 Aperture Level 1% bis 20% (10%) Stellt den Blendenwert für Zebra 1 ein.

Zebra2 Level 0% bis 109% (61%) Stellt den Anzeigepegel für Zebra 2 ein.

Assign<VF A> Seite 39 Weist der belegbaren Funktionstaste A am Sucher 
(DVF-EL200) eine Funktion zu.

Assign<VF B> Seite 39 Weist der belegbaren Funktionstaste B am Sucher 
(DVF-EL200) eine Funktion zu.

Assign<VF C> Seite 39 Weist der belegbaren Funktionstaste C am Sucher 
(DVF-EL200) eine Funktion zu.
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Audio-Menü

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.
Audio > Audio Input

Einstellungen bezüglich der Audio-Aufzeichnungspegel.

[Hinweis]
Bei Auswahl von AES/EBU-Signalen ist der Audio-Aufzeichnungspegel fest eingestellt.

Menüoption Einstellungen Beschreibung

CH-1 Audio Select Auto/Manual Der Audio-Aufzeichnungspegel wird bei 
Einstellung auf Auto automatisch eingestellt.

CH-2 Audio Select Auto/Manual Der Audio-Aufzeichnungspegel wird bei 
Einstellung auf Auto automatisch eingestellt.

CH-1 Audio Level –99 bis ±0 bis +99 Passt den Audio-Aufzeichnungspegel an, wenn 
CH-1 Audio Select auf Manual eingestellt ist.

CH-2 Audio Level –99 bis ±0 bis +99 Passt den Audio-Aufzeichnungspegel an, wenn 
CH-2 Audio Select auf Manual eingestellt ist.

MIC Reference –60dB/–50dB/–40dB Wählt den Referenzeingangspegel des Mikrofons 
aus.

Audio > Audio Monitor
Einstellungen bezüglich der Audioüberwachung.

Menüoption Einstellungen Beschreibung

Monitor CH Wenn Monitor Output CH Pair 
auf CH-1/CH-2 gesetzt ist

CH-1/CH-2, CH-1, CH-2
Wenn Monitor Output CH Pair 
auf CH-3/CH-4 gesetzt ist

CH-3/CH-4, CH-3, CH-4

Zum Auswählen des an die Kopfhörer und den 
Lautsprecher ausgegebenen Audiokanals.
CH-1/CH-2 (CH-3/CH-4): Kanal 1+2 (Kanal 3+4)
CH-1 (CH-3): nur Kanal 1 (Kanal 3)
CH-2 (CH-4): nur Kanal 2 (Kanal 4)

Monitor Level 0 bis 99 Passt den Monitortonpegel an.

Audio > Audio Configuration
Einstellungen bezüglich des Audio-Ein/Ausgangs.

Menüoption Einstellungen Beschreibung

Alarm Level 0 bis 99 Passt den Alarmtonpegel an.

[Hinweis]
Hiermit wird auch der Pegel des Signaltons eingestellt, 
der bei Start/Stopp der Aufnahme abgegeben wird, 
wenn im vollständigen Menü Technical > Switch & Rec 
Light > Rec Start/Stop Beep auf On eingestellt ist.

Audio > Audio Configuration
Einstellungen bezüglich des Audio-Ein/Ausgangs.

Menüoption Einstellungen Beschreibung

Input Limiter Mode Off/–6dB/–9dB/–12dB/–15dB/ 
–17dB

Wählt die Begrenzercharakteristik 
(Sättigungspegel) für große Eingangssignale beim 
manuellen Anpassen des Audio-Eingangspegels 
aus. Falls Sie den Begrenzer nicht verwenden, 
wählen Sie Off aus.

AGC Level –6dB/–9dB/–12dB/–15dB/–17dB Wählt die AGC-Charakteristik (Sättigungspegel) 
aus.

AGC Mono/Stereo Mono/Stereo Passt den Eingangspegel von auf den Kanälen 1 
und 2 aufgezeichneten analogen Audiosignalen 
automatisch an und wählt aus, ob die 
Einstellungen einzeln für jeden Kanal (Mono) oder 
im Stereomodus (Stereo) vorgenommen werden 
sollen.

MIC Input Mono/
Stereo

Mono/Stereo Wählt aus, ob das Frontmikrofon ein Mono- oder 
Stereomikrofon ist.

Phantom Power +48V On/Off Schaltet die Funktion zur Phantomspeisung des 
Mikrofons mit einer externen +48-V-Quelle ein/
aus.

Monitor Output CH 
Pair

CH-1/CH-2, CH-3/CH-4 Legt die Kanäle für die Tonausgabe fest; entweder 
die Kanäle 1 und 2 oder die Kanäle 3 und 4.

Headphone Mono/ST Mono/Stereo Legt fest, ob der Kopfhörerausgang Mono- oder 
Stereosignale liefert.
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Technical-Menü

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.
Technical > Test Signals

Einstellungen bezüglich der Farbbalken.

Menüoption Einstellungen Beschreibung

Color Bars On/Off Schaltet Farbbalken ein/aus.

[Hinweis]
Wenn eine RM-B170 oder andere Fernbedienung 
angeschlossen ist, wird deren Einstellung angezeigt und 
abgeblendet dargestellt.

Color Bars Type ARIB/SMPTE Wählt die Art der Farbbalken aus.

1KHz Tone on Color 
Bars

On/Off Schaltet die Ausgabe eines 1-kHz-Testsignals im 
Farbbalkenmodus ein/aus.

Test Saw On/Off Schaltet das Testsignal ein bzw. aus.

Technical > Switch & Rec Light
Einstellungen bezüglich der Taste REC.

Menüoption Einstellungen Beschreibung

Lock Operator Side without Rec Button/with Rec 
Button

Legt fest, ob beim Sperren der Tasten mit dem 
LOCK-Schalter auf der Operator-Seite auch die 
Taste REC gesperrt werden soll.

Lock Assistant Side without Rec Button/with Rec 
Button

Legt fest, ob beim Sperren der Tasten mit dem 
LOCK-Schalter auf der Assistant-Seite auch die 
Taste REC gesperrt werden soll.

Rec Light On/Off Schaltet die Anzeigeleuchte REC ein/aus.

Rec Start/Stop Beep On/Off Schaltet die Funktion zur Abgabe eines Signaltons 
bei Beginn und Ende der Aufzeichnung ein/aus.

Technical > System Configuration
Einstellungen bezüglich der Gerätesteuerung.

Menüoption Einstellungen Beschreibung

Fan Control Auto / Max / Off in Rec/Auto /  
Off in Rec/Max

Wählt den Gebläsesteuermodus aus.
Auto: Das Gebläse wird automatisch anhand der 

internen Temperatur gesteuert.
Max: Das Gebläse läuft mit maximaler Drehzahl.
Off in Rec/Auto: Das Gebläse ist während der 

Aufzeichnung leise und wird ansonsten 
automatisch anhand der internen Temperatur 
gesteuert.

Off in Rec/Max: Das Gebläse ist während der 
Aufzeichnung leise und läuft ansonsten mit 
maximaler Drehzahl.

Technical > System Configuration
Einstellungen bezüglich der Gerätesteuerung.

Menüoption Einstellungen Beschreibung

RM/RCP Paint Control On/Off Aktiviert/deaktiviert die 
Farbregulierungsfunktionen einer RM-B170 oder 
anderen Fernbedienung.
[Hinweis]
Wenn die Einstellung für RM/RCP Paint Control geändert 
wird, so werden alle Einstellungen am Gerät initialisiert. 
Die Einstellung für RM/RCP Paint Control wird jedoch 
nicht geändert.

SDI Rec Remote Trigger Off / HD SDI Remote I/F / Parallel 
Rec

Wählt die SDI-Fernbedienungsmethode aus.
Off: Fernbedienung deaktiviert.
HD SDI Remote I/F: Verwendet HD-SDI-

Fernbedienungsmethode.
Parallel Rec: Verwendet die Methode der gültigen 

Flags.

SD HDMI On/Off Schaltet die Funktion zum Umsetzen des HDMI-
Ausgangssignals ins SD-Format ein/aus.

Shutter Mode Speed/Angle Wählt den Betriebsmodus für den elektronischen 
Verschluss aus.

Technical > Special Configuration
Einstellungen bezüglich der Bildschirmspiegelung und der Rauschunterdrückung.

Menüoption Einstellungen Beschreibung

Flip Image Normal/Horizontal Flip Schaltet die Bildschirmspiegelung ein/aus.
[Hinweis]
AXS-Aufnahmebilder werden ohne Spiegelung gespeichert.

NR(4K 17:9/16:9 AXS) On/Off Schaltet die Bildrauschunterdrückung bei 4K 
17:9/16:9 AXS-Aufnahmen ein/aus.
[Hinweis]
Ist (unveränderlich) auf Off gesetzt, wenn die folgenden 
Funktionen aktiviert sind.
ˎˎ Select FPS
ˎˎ SxS/Output De-Squeeze: Andere Einstellungen als 

Off(1.0×)
ˎˎ Flip Image: Horizontal Flip

Technical > Lens Configuration
Einstellungen bezüglich Objektiven.

Menüoption Einstellungen Beschreibung

PL-Mt Interface 
Position

Top/Side/Off Legt vor dem Anbringen eines Objektivs die 
Objektivschnittstelle gemäß dem 
anzubringenden Objektiv fest.
[Hinweis]
Wenn Sie diese Einstellung ändern, während das 
Objektiv am Gerät angebracht ist, schalten Sie das Gerät 
aus und dann wieder ein.
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Technical > Lens Configuration
Einstellungen bezüglich Objektiven.

Menüoption Einstellungen Beschreibung

Lens 12pin On/Off Schaltet die 12-polige Objektivschnittstelle ein/
aus.

[Hinweis]
Wenn Sie diese Einstellung ändern, während das 
Objektiv am Gerät angebracht ist, schalten Sie das Gerät 
aus und dann wieder ein.

E-Mount Shading 
Comp.

Auto/Off Legt fest, ob ein Abfall der 
Umgebungsbeleuchtung kompensiert werden 
soll, wenn ein kompatibles Objektiv angebracht 
ist.

E-Mt Chro. Aber. Comp. Auto/Off Legt fest, ob eine Farbabweichung der 
Umgebungsbeleuchtung kompensiert werden 
soll, wenn ein kompatibles Objektiv angebracht 
ist.

Technical > Authentication
Zum Vornehmen grundlegender Einstellungen bezüglich der Netzwerkauthentifizierung.

Menüoption Einstellungen Beschreibung

User Name (Zeigt den aktuellen 
Benutzernamen an.)

Legt den für die Zugriffsauthentifizierung zu 
verwendenden Benutzernamen fest.
Werkseitig auf „admin“ eingestellt.

Password (*******) Legt das für die Zugriffsauthentifizierung zu 
verwendende Kennwort fest.
Werkseitig auf „mpc3610“ eingestellt.

Technical > Network
Zum Vornehmen von Einstellungen bezüglich des Netzwerks.

Menüoption Einstellungen Beschreibung

Setting LAN/Wireless/Off Schaltet die Netzwerkverbindung ein/aus.

LAN DHCP (On/Off ) Aktiviert/deaktiviert DHCP.
Bei Einstellung auf [On] wird dem Gerät 
automatisch eine IP-Adresse zugewiesen. Um die 
IP-Adresse des Geräts manuell festzulegen, stellen 
Sie [Off ] ein.

IP Address (DHCP/On: 
automatisch abrufen, DHCP/Off: 
192.168.2.50)

Geben Sie die IP-Adresse des Geräts ein.
Ist nur aktiviert, wenn für DHCP [Off ] eingestellt 
ist.

Subnet Mask (DHCP/On: 
automatisch abrufen, DHCP/Off: 
255.255.255.0)

Geben Sie die Subnetzmaske des Geräts ein.
Ist nur aktiviert, wenn für DHCP [Off ] eingestellt 
ist.

Technical > Network
Zum Vornehmen von Einstellungen bezüglich des Netzwerks.

Menüoption Einstellungen Beschreibung

Wireless Network Mode (Access Point/
Station)

Legt den Netzwerkmodus für kabellose 
Verbindungen fest.

Scan Networks (Execute/Cancel) Sucht nach Zugangspunkten für Verbindungsziele 
(Ausführen durch Auswählen von Execute).

[Hinweis]
Nur konfigurierbar, wenn Network Mode auf Station 
eingestellt ist.

SSID Wenn Network Mode auf Access Point eingestellt 
ist

Zeigt die SSID für die drahtlose Verbindung 
zum Gerät an.

Wenn Network Mode auf Station eingestellt ist
Zeigt die SSID des Ziel-Access-Points der 
Verbindung an bzw. konfiguriert diese.

[Hinweis]
Gültige Zeichen für Anzeige und Eingabe:
Alphabetisch (A bis Z, a bis z)
Numerisch (0 bis 9 -.@—_())
Sonderzeichen (!"#$%&'*+,/:;<=>?[\]^`{|}~)

Password Wenn Network Mode auf Access Point eingestellt 
ist

Zeigt das Kennwort für die drahtlose 
Verbindung zum Gerät an.

Wenn Network Mode auf Station eingestellt ist
Zeigt das Kennwort des Ziel-Access-Points 
der Verbindung an bzw. konfiguriert dieses.

[Hinweis]
Gültige Zeichen für Anzeige und Eingabe:
Alphabetisch (A bis Z, a bis z)
Numerisch (0 bis 9 -.@—_())
Sonderzeichen (!"#$%&'*+,/:;<=>?[\]^`{|}~)

WPS (Execute/Cancel) Startet den Verbindungsaufbau mit WPS 
(Ausführen durch Auswählen von Execute).

Channel (Auto(5GHz)/Auto/CH1/ 
CH2/CH3/CH4/CH5/CH6/CH7/ 
CH8/CH9/CH10/CH11)

Legt den Kanal des Access Points fest.

[Hinweise]
ˎˎ Nur konfigurierbar, wenn Network Mode auf Access 

Point eingestellt ist.
ˎˎ Auto(5GHz) wird je nach dem verwendeten 

WLAN-Modul nicht angezeigt. Prüfen Sie, ob die 
Verwendung des WLAN-Moduls in Ihrem Land/Ihrer 
Region unterstützt wird. Einzelheiten finden Sie in der 
Bedienungsanleitung des WLAN-Moduls.



3. Kamerabedienung: Vollständige Menüliste00070

Technical > Network
Zum Vornehmen von Einstellungen bezüglich des Netzwerks.

Menüoption Einstellungen Beschreibung

DHCP (On/Off ) Aktiviert/deaktiviert DHCP.
Bei Einstellung auf [On] wird dem Gerät 
automatisch eine IP-Adresse zugewiesen. Um die 
IP-Adresse des Geräts manuell festzulegen, stellen 
Sie [Off ] ein.

[Hinweis]
Nur konfigurierbar, wenn Network Mode auf Station 
eingestellt ist.

IP Address (DHCP/On: 
automatisch abrufen, DHCP/Off: 
192.168.1.50)

Geben Sie die IP-Adresse des Geräts ein.
Ist nur aktiviert, wenn für DHCP [Off ] eingestellt 
ist.

[Hinweis]
Nur konfigurierbar, wenn Network Mode auf Station 
eingestellt ist.

Subnet Mask (DHCP/On: 
automatisch abrufen, DHCP/Off: 
255.255.255.0)

Geben Sie die Subnetzmaske des Geräts ein.
Ist nur aktiviert, wenn für DHCP [Off ] eingestellt 
ist.

[Hinweis]
Nur konfigurierbar, wenn Network Mode auf Station 
eingestellt ist.

MAC Address Zeigt die MAC-Adresse des an das Gerät 
angeschlossenen WLAN-Adapters an.

Regenerate Password (Execute/
Cancel)

Erstellt das Kennwort neu (Ausführen durch 
Auswählen von Execute).

[Hinweis]
Nur ausführbar, wenn Network Mode auf Access Point 
eingestellt ist.

Technical > APR
Führt die APR-Funktion (Auto Pixel Restoration: automatische Anpassung des Bildsensors) aus.

Menüoption Einstellungen Beschreibung

APR Execute/Cancel Führt die Funktion zur automatischen Reduktion 
von Pixelrauschen aus (Ausführen durch 
Auswählen von Execute).

Reset Execute/Cancel Löscht weiße Flecken, die durch Ausführen der 
APR-Funktion hinzugefügt wurden (Ausführen 
durch Auswählen von Execute).

Technical > Battery
Einstellungen bezüglich der Akkus.

Menüoption Einstellungen Beschreibung

Near End:Info Battery 5% bis 100% (5%-Schritte) Legt den Schwellenwert bei Verwendung eines 
InfoLithium-Akkus fest, ab dem die Anzeige für 
verbleibende Akkuladung zu blinken beginnt.

End:Info Battery 0% bis 5% Legt den Schwellenwert für die Anzeige der 
Warnung „Battery End“ bei Verwendung eines 
InfoLithium-Akkus fest.

Near End:Sony Battery 11.5V bis 17V (0.1V-Schritte) Legt den Schwellenwert bei Verwendung eines 
Sony-Akkus (nicht InfoLithium) fest, ab dem die 
Anzeige für verbleibende Akkuladung zu blinken 
beginnt.

End:Sony Battery 11.0V bis 11.5V (0.1V-Schritte) Legt den Schwellenwert für die Anzeige der 
Warnung „Battery End“ bei Verwendung eines 
Sony-Akkus (nicht InfoLithium) fest.

Near End:Other Battery 11.5V bis 17V (11.8V) 
(0.1V-Schritte)

Legt den Schwellenwert bei Verwendung eines 
nicht von Sony hergestellten Akkus fest, ab dem 
die Anzeige für verbleibende Akkuladung zu 
blinken beginnt.

End:Other Battery 11.0V bis 14V (0.1V-Schritte) Legt den Schwellenwert für die Anzeige der 
Warnung „Battery End“ bei Verwendung eines 
nicht von Sony hergestellten Akkus fest.

Detected Battery Sony Info Battery/Sony Battery/
Other Battery/DC IN (12V)/DC IN 
(24V)

Zeigt das Ergebnis der automatischen 
Akkuerkennung an.

Technical > DC Voltage Alarm
Legt Alarme bezüglich der externen Versorgungsgleichspannung fest.

Menüoption Einstellungen Beschreibung

DC Low Voltage1 11.5V bis 17V (0.1V-Schritte) Legt den Schwellenwert für die Anzeige einer 
Warnung vor niedriger Spannung bei 
Verwendung einer mit dem Anschluss DC IN 
verbundenen externen Stromquelle fest.

DC Low Voltage2 11.0V bis 14V (0.1V-Schritte) Legt den Schwellenwert für die Anzeige einer 
Warnung vor Unterspannung bei Verwendung 
einer mit dem Anschluss DC IN verbundenen 
externen Stromquelle fest.

DC(24V) Low Voltage1 22.5V bis 34.0V (0.1V-Schritte) Legt den Schwellenwert für die Anzeige einer 
Warnung vor niedriger Spannung bei 
Verwendung einer mit dem Anschluss DC IN 
verbundenen externen 24-V-Stromquelle fest.
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Technical > DC Voltage Alarm
Legt Alarme bezüglich der externen Versorgungsgleichspannung fest.

Menüoption Einstellungen Beschreibung

DC(24V) Low Voltage2 22.0V bis 28.0V (0.1V-Schritte) Legt den Schwellenwert für die Anzeige einer 
Warnung vor Unterspannung bei Verwendung 
einer mit dem Anschluss DC IN verbundenen 
externen 24-V-Stromquelle fest.

Technical > Control Display
Einstellungen bezüglich der Anzeigen.

Menüoption Einstellungen Beschreibung

Brightness level High/Mid/Low/Minimum Stellt die Helligkeit des Subdisplays und des 
Minidisplays ein.

Technical > Genlock
Einstellungen bezüglich Genlock.

Menüoption Einstellungen Beschreibung

Input Source HD SDI/Analog Wählt das Genlock-Eingangssignal aus.
HD SDI: Digital
Analog: Analog

Reference Lock Type Internal/External(HD)/
External(SD)

Zeigt den Genlock-Status an. Zeigt den Signaltyp 
im Genlock-Zustand an.
Internal: Kein Genlock.
External(HD): Genlock durch das HD-Signal.
External(SD): Genlock durch das SD-Signal.

Maintenance-Menü

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.
Maintenance > Clock Set

Einstellungen bezüglich der integrierten Uhr.

Menüoption Einstellungen Beschreibung

Time Zone UTC + 14:00 bis UTC Greenwich 
bis UTC – 12:00 (Schritte von 
30 Minuten)

Wählt den Zeitunterschied zu UTC (Greenwich 
Mean Time) in Schritten von 30 Minuten aus.

Date Mode YYMMDD/MMDDYY/DDMMYY Wählt das Anzeigeformat für das Datum aus.
YYMMDD: Jahr, Monat, Tag
MMDDYY: Monat, Tag, Jahr
DDMMYY: Tag, Monat, Jahr

Date Stellt das aktuelle Datum ein (Übernahme durch 
Drücken von Set).

Time Stellt die aktuelle Uhrzeit ein (Übernahme durch 
Drücken von Set).

Maintenance > Language
Wählt die Anzeigesprache für Menüs und Meldungen aus.

Menüoption Einstellungen Beschreibung

Select English/中文(简) Wählt die Anzeigesprache für das vollständige 
Menü und Meldungen aus.

Maintenance > Hours Meter
Zeigt die aufgelaufene Betriebsdauer an.

Menüoption Einstellungen Beschreibung

Camera(System) Zeigt die aufgelaufene Betriebsdauer des Geräts 
an (kann nicht zurückgesetzt werden).

R7 Recorder 
(System)
(nur wenn ein AXS-R7 
angeschlossen ist)

Zeigt die aufgelaufene Betriebsdauer eines mit 
dem Gerät verbundenen AXS-R7 an (kann nicht 
zurückgesetzt werden).

Camera(Resettable) Zeigt die aufgelaufene Betriebsdauer des Geräts 
an (kann zurückgesetzt werden).

R7 Recorder 
(Resettable)
(nur wenn ein AXS-R7 
angeschlossen ist)

Zeigt die aufgelaufene Betriebsdauer eines mit 
dem Gerät verbundenen AXS-R7 an (kann 
zurückgesetzt werden).

Reset-Cam 
(Resettable)

Execute/Cancel Stellt die Anzeige von Camera(Resettable) zurück 
auf 0 (Ausführen durch Auswählen von Execute).
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Maintenance > Hours Meter
Zeigt die aufgelaufene Betriebsdauer an.

Menüoption Einstellungen Beschreibung

Reset-R7 
(Resettable)
(nur wenn ein AXS-R7 
angeschlossen ist)

Execute/Cancel Stellt die Anzeige R7 Recorder(Resettable) für den 
mit dem Gerät verbundenen AXS-R7-Recorder 
zurück auf 0 (Ausführen durch Auswählen von 
Execute).

Maintenance > Reset to Default
Bringt das Gerät zurück in den Zustand bei Auslieferung.

Menüoption Einstellungen Beschreibung

Reset Execute/Cancel Initialisiert alle Geräteeinstellungen (Ausführen 
durch Auswählen von Execute).

Maintenance > License Options
Installiert Softwareoptionen.

Menüoption Einstellungen Beschreibung

Install: <target_
license>

Execute/Cancel Installiert Softwareoptionen (Ausführen durch 
Auswählen von Execute).

Anamorphic Permanent License Installed/XX 
days Remaining (YY keys)/
Expired/Not Installed

Zeigt an, ob die Anamorphotische Option 
aktiviert ist.
Permanent License Installed: Permanente Lizenz 
ist installiert
XX days Remaining (YY keys): Ablauf der zeitlich 
beschränkten Lizenz
Expired: Zeitlich beschränkte Lizenz ist abgelaufen
Not Installed: Nicht installiert

Full-Frame Permanent License Installed/XX 
days Remaining (YY keys)/
Expired/Not Installed

Zeigt an, ob die Vollformat-Option aktiviert ist.
Permanent License Installed: Permanente Lizenz 
ist installiert
XX days Remaining (YY keys): Ablauf der zeitlich 
beschränkten Lizenz
Expired: Zeitlich beschränkte Lizenz ist abgelaufen
Not Installed: Nicht installiert

High Frame Rate Permanent License Installed/XX 
days Remaining (YY keys)/
Expired/Not Installed

Zeigt an, ob die High Frame Rate-Option aktiviert 
ist.
Permanent License Installed: Permanente Lizenz 
ist installiert
XX days Remaining (YY keys): Ablauf der zeitlich 
beschränkten Lizenz
Expired: Zeitlich beschränkte Lizenz ist abgelaufen
Not Installed: Nicht installiert

Unique Device ID Zeigt die zum Ausstellen des Lizenzschlüssels für 
die Softwareoption verwendete ID an.

Maintenance > Firmware
Zeigt die Version des Geräts und des AXS-R7 an und aktualisiert das Gerät.

Menüoption Einstellungen Beschreibung

Camera Zeigt die Firmwareversion des Geräts an (Vx.xx).

AXS
(nur wenn ein AXS-R7 
angeschlossen ist)

Zeigt die Firmwareversion des mit dem Gerät 
verbundenen AXS-R7 an (Vx.xx).

FW Update-camera Execute/Cancel Aktualisiert das Gerät (Ausführen durch 
Auswählen von Execute).

FW Update-AXS-R7 Execute/Cancel Aktualisiert die Firmwareversion des mit dem 
Gerät verbundenen AXS-R7 (Ausführen durch 
Auswählen von Execute).
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Clipfunktionen auf dem Subdisplay
Clipfunktionen werden mithilfe der Bildschirme Clip List und Playback durchgeführt. Sie können einen 
Clip wiedergeben, indem Sie ihn in dem auf dem Subdisplay angezeigten Bildschirm Clip List auswählen.
Wenn in der Project-Kategorie im Menü für AXS Rec Format nicht Rec Off eingestellt ist, sind AXS-
Medien abspielbar. In gleicher Weise sind SxS-Medien abspielbar, wenn SxS Rec Format nicht auf Rec Off 
eingestellt ist.

Bildschirm Clip List

Drücken Sie die Taste CLIPS (Seite 10) auf der Assistentenseite, um den Bildschirm Clip List mit 
abspielbaren Medien auf dem Subdisplay aufzurufen.

5

4

13
12
11
10

9
8
7
6

1.	 Schaltfläche Medienauswahl
Zeigt „SxS/AXS“ an, wenn sowohl SxS- als auch 
AXS-Medien abspielbar sind. Drücken Sie die 
Taste ITEM 1, um zum Wiedergabemedium zu 
wechseln.

2.	 Schaltfläche Cursor aufwärts
Drücken Sie die Taste ITEM 2, um den 
wiederzugebenden Clip aus der Clipliste 
auszuwählen.

3.	 Schaltfläche Wiedergabestart
Drücken Sie die Taste ITEM 3, um den 
Bildschirm Playback (Seite 15) anzuzeigen 
und die Wiedergabe zu starten.

4.	 Clipliste
Zeigt eine Liste der Clips auf dem aktiven 
Wiedergabemedium an. Es wird auch der 
Status der Clips mithilfe von Symbolen 
angezeigt.

Symbol Bedeutung

Clip mit erstelltem Unterclip

gesperrter Clip (Schreibschutz)

5.	 Schaltfläche Cursor abwärts
Drücken Sie die Taste ITEM 5, um den 
wiederzugebenden Clip aus der Clipliste 
auszuwählen.

6.	 Position des Clips auf Wiedergabemedium
Zeigt die Nummer des mit dem Cursor 
gekennzeichneten Clips und die Gesamtanzahl 
der Clips an.

7.	 Erstellungsdatum und -uhrzeit
Zeigt Erstellungsdatum und -uhrzeit des mit 
dem Cursor gekennzeichneten Clips an.

8.	 Format (Codec)
Zeigt das Aufzeichnungsformat (den Codec) 
des mit dem Cursor gekennzeichneten Clips 
an.

9.	 Anzeige der Bildgröße
Zeigt die effektive Bildgröße bei der Aufnahme 
des mit dem Cursor gekennzeichneten Clips 
an.

[Hinweis]
Wird nicht angezeigt, wenn das Wiedergabemedium 
eine SxS-Speicherkarte ist.

10.	 Anzeige von Projektbildrate/
Spezialaufnahmemodus
Zeigt die Projektbildrate und den 
Spezialaufnahmemodus des mit dem Cursor 
gekennzeichneten Clips an.

11.	 Dauer (Dur)
Zeigt die Dauer des mit dem Cursor 
gekennzeichneten Clips an.

12.	 Timecode (TCR)
Zeigt den Timecode des ersten Einzelbilds des 
mit dem Cursor gekennzeichneten Clips an.

13.	 Aktives Wiedergabemedium
Zeigt das aktive Wiedergabemedium der 
angezeigten Liste an.
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Bildschirm Playback

Der Bildschirm Playback wird angezeigt, wenn Sie einen wiederzugebenden Clip auf dem Bildschirm Clip 
List auswählen und auf den Regler MENU oder die Wiedergabetaste (Taste ITEM 3) drücken.

Funktionsanzeigebereich

1 2 3

4 5 6

1.	 Schaltfläche F Rev
Mit hoher Geschwindigkeit rückwärts 
wiedergeben.

2.	 Schaltfläche Play/Pause
Clip wiedergeben oder Wiedergabe anhalten.

3.	 Schaltfläche F Fwd
Mit hoher Geschwindigkeit vorwärts 
wiedergeben.

4.	 Schaltfläche Prev
Zum Start des vorhergehenden Clips springen.

5.	 Schaltfläche Stop/Clips
Wiedergabe stoppen und zum 
Cliplistenbildschirm zurückkehren.

6.	 Schaltfläche Next
Zum Start des nächsten Clips springen.

Statusanzeigebereich

1 2 3 4

8 7

510

6

9

1.	 Zeitdatenanzeige
Zeigt den Zeitcode der Wiedergabeposition 
an.

2.	 Clipnummer
Zeigt die Nummer des gegenwärtig 
wiedergegebenen Clips/die Gesamtanzahl 
abspielbarer Clips an.

3.	 Anzeige von Bildrate/Imager-Modus
Zeigt die Projektbildrate und Bildgröße an.

[Hinweis]
Die Bildgröße wird nicht angezeigt, wenn das 
Wiedergabemedium eine SxS-Speicherkarte ist.

4.	 Anzeige des Spezialaufnahmemodus
Zeigt Informationen zum 
Spezialaufnahmemodus des Wiedergabeclips 
an.

5.	 Tonpegelmesser
Zeigt den Wiedergabetonpegel an.

6.	 Anzeige des Wiedergabeclip-Formats 
(Codec)
Zeigt das Format (den Codec) des 
Wiedergabeclips an.

7.	 Symbolanzeige
Zeigt den Status der Clips mithilfe von 
Symbolen an.

Symbol Bedeutung

Clip mit erstelltem Unterclip

gesperrter Clip (Schreibschutz)

8.	 Clipnamenanzeige
Zeigt den Namen des Clips an.

9.	 Medienanzeige
Zeigt das aktuell wiedergegebene Medium an.

10.	 Anzeige des Wiedergabestatus
Zeigt den Wiedergabestatus an.
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Wiedergabe
Sie können aufgezeichnete Clips wiedergeben, 
während sich das Gerät im Standby-Modus 
befindet.

[Hinweis]
Auf den Tasten ITEM 1 bis 6 (Seite 9) erscheinen die 
Elemente zur Wiedergabesteuerung. Drücken Sie auf eine 
Taste ITEM, um die entsprechende Option auszuwählen.

1	 Setzen Sie die wiederzugebende SxS-
Speicherkarte ein.

2	 Drücken Sie die Taste CLIPS (Seite 10) auf der 
Assistentenseite.
Die Liste der Clips auf dem aktiven 
Wiedergabemedium wird auf dem Subdisplay 
angezeigt.

3	 Verwenden Sie die Taste  (Taste ITEM 2), 
Taste  (Taste ITEM 5) oder den Regler MENU, 
um einen wiederzugebenden Clip 
auszuwählen.

4	 Drücken Sie den Regler MENU oder die Taste 
Play (Taste ITEM 3).
Das Wiedergabebild erscheint im Sucher bzw. 
auf dem Monitorbildschirm.

Wiedergabefunktionen

Die Wiedergabe erfolgt mithilfe der Schaltflächen 
auf dem Subdisplay (Seite 74).
Schaltfläche Play/Pause: Wiedergabe anhalten. 

Drücken Sie diese Schaltfläche erneut, um die 
Wiedergabe fortzusetzen.

Schaltfläche F Fwd/Schaltfläche F Rev: Schneller 
Vorlauf/Rücklauf. Drücken Sie die Schaltfläche 
Play/Pause, um zur normalen Wiedergabe 
zurückzukehren.

Schaltfläche Stop/Clips: Wiedergabe stoppen und 
zum Cliplistenbildschirm zurückkehren.

Überwachung von Audiosignalen

Im normalen Wiedergabemodus können 
Sie den aufgezeichneten Ton über den 
integrierten Lautsprecher (Seite 8) oder den 
angeschlossenen Kopfhörer überwachen.
Wenn der Kopfhörer am Kopfhöreranschluss 
angeschlossen wird (Seite 8), so wird der 
integrierte Lautsprecher ausgeschaltet.
Mit der Audio-Kategorie > Monitor CH und 
Monitor Level (Seite 46) im Menü können Sie 
den zu überwachenden Audiokanal auswählen 
und die Lautstärke einstellen.

Aufrufen

Um einen Clip von Beginn an wiederzugeben, 
drücken Sie die Schaltfläche Prev auf dem 
Subdisplay (Seite 74).
Sie können Clips überspringen und zu einem Clip 
springen, indem Sie wiederholt die Schaltfläche 
Prev oder Next drücken.

Umschalten zwischen SxS-Speicherkarten

Wenn zwei SxS-Speicherkarten eingesetzt sind, 
drücken Sie die Taste SLOT SELECT (Seite 9), 
um von der einen zur anderen Speicherkarte 
umzuschalten.

[Hinweis]
Während der Wiedergabe ist das Umschalten von einer 
SxS-Speicherkarte zur anderen nicht möglich. Eine 
kontinuierliche Wiedergabe von Karten im Einschub A oder B 
ist nicht möglich.

Wechseln zu einer AXS-Speicherkarte

Sie können Videoaufnahmen auf einer AXS-
Speicherkarte im AXS-R7 schnell wiedergeben.
Um auf eine AXS-Speicherkarte umzuschalten, 
drücken Sie die Taste ITEM 1 (Seite 73) auf dem 
Subdisplay.

Fälle, in denen Wiedergabe auf dem Gerät nicht 
unterstützt wird

Clips, die unter den folgenden Bedingungen auf 
AXS-Medien aufgezeichnet wurden, können nicht 
auf dem Gerät wiedergegeben werden. Geben 
Sie die Clips mithilfe einer Anwendung wie RAW 
Viewer auf dem Computer wieder.
ˎˎ Wenn Imager Mode auf 6K 3:2 und Project 
Frame Rate auf 59.94P oder 50P eingestellt ist
ˎˎ Wenn Imager Mode auf 4K 4:3 und Project 
Frame Rate auf 59.94P oder 50P eingestellt ist
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Funktionen auf dem Bildschirm Home des Minidisplays
Über den Bildschirm Home des Minidisplays 
können Sie den Status des Geräts prüfen und 
grundlegende Einstellungen für das Gerät 
vornehmen.

1
2
3
4
5

1.	 FPS
Legt die Aufnahmebildrate fest.

2.	 Shutter
Dient zum Anzeigen und Einstellen von 
Verschlusszeit/Verschlusswinkel des 
elektronischen Verschlusses.

3.	 ND Filter
Dient zum Anzeigen und Einstellen der Dichte 
des ND-Filters.

4.	 Exposure Index/Gain
Zeigt den Belichtungsindex (Exposure Index, 
EI) oder den von einer RM-B170 oder einer 
anderen Fernbedienung eingestellten 
Verstärkungswert (dB-Einheiten) an.

	 [Hinweis]
Der Verstärkungswert wird nur angezeigt, wenn im 
vollständigen Menü Technical > System Configuration > 
RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

5.	 WB (White Balance)
Dient zum Anzeigen und Einstellen des 
Weißwerts.

Anzeige und Betrieb, wenn RM/RCP Paint Control 
aktiviert ist

ˎˎ Der Verstärkungswert wird anstelle des 
Belichtungsindex angezeigt, wenn im 
vollständigen Menü Technical > System 
Configuration > RM/RCP Paint Control 

(Seite 68) auf On eingestellt ist. In diesem 
Modus kann der EI-Wert nicht geändert werden.
ˎˎ Die folgenden Elemente können nicht 
bedient werden, wenn eine RM-B170 oder 
andere Fernbedienung angeschlossen ist 
und im vollständigen Menü Technical > 
System Configuration > RM/RCP Paint Control 
(Seite 68) auf On eingestellt ist. Nehmen Sie 
diese Einstellungen mit der Fernbedienung vor 
(Seite 88).
ˎˎ Shutter
ˎˎ WB (White Balance)

Bedienelemente

Taste HOME (Seite 8)
Zur Rückkehr zum Bildschirm Home drücken. 
Unbestätigte Änderungen werden verworfen.

Taste ITEM 1 ( ) (Seite 8)
Zum Auswählen von Optionen auf dem Bildschirm 
Home.

Taste ITEM 2 ( ) (Seite 8)
Zum Übernehmen der ausgewählten Option 
drücken.

Taste ITEM 3 ( ) (Seite 8)
Zum Auswählen von Optionen auf dem Bildschirm 
Home.

Basisfunktionen

1	 Drücken Sie die Taste ITEM 1, 2 oder 3.
Der Cursor wird angezeigt.

2	 Wählen Sie mithilfe der Taste  (Taste ITEM 1) 
oder  (Taste ITEM 3) die einzustellende 
Option aus.

3	 Drücken Sie die Taste  (Taste ITEM 2).
Für die ausgewählte Option wird der 
Bildschirm zum Auswählen des Einstellwerts 
angezeigt.

	 [Hinweis]

Die Markierung  zeigt die aktuelle Einstellung an.

4	 Bewegen Sie den Cursor mithilfe der Taste  
(Taste ITEM 1) oder  (Taste ITEM 3) auf die 
Option oder den Einstellwert.

5	 Drücken Sie die Taste  (Taste ITEM 2), um die 
Einstellung zu übernehmen.

6	 Drücken Sie die Taste HOME, um den Cursor 
auszublenden.
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Optionen des Bildschirms Home auf dem Minidisplay

Die Namen von Optionen und entsprechenden Einstellwerten werden nachfolgend aufgeführt.
Die Voreinstellungswerte sind unterstrichen und in Fettdruck.

Option Beschreibung

FPS Legt die Aufnahmebildrate fest.
Variable/Fixed: Umschalten zwischen Aufnahme mit variabler und konstanter 
Geschwindigkeit auf dem Bildschirm Home (Seite 37) des Subdisplays.
Wenn „Fixed“ ausgewählt ist, wird die Einstellung von der Einstellung für Kategorie 
Project > Project Frame Rate (Seite 44) im Menü bestimmt.

Project Frame Rate Display

23.98 Fixed 24

24 Fixed 24

25 Fixed 25

29.97 Fixed 30

47.95 Fixed 48

50 Fixed 50

59.94 Fixed 60

Wenn „Variable“ ausgewählt ist, wechselt die Einstellung abhängig von der 
Einstellung für Kategorie Project > Imager Mode (Seite 58) im Menü wie folgt.

Imager Mode Einstellung

3.8K 16:9
4K 17:9

1 bis 60 FPS

4K 17:9 1) 1 bis 60, 66, 72, 75, 88, 90, 96, 
100, 110 FPS

3.8K 16:9 Surround View
4K 17:9 Surround View
4K 4:3

1 bis 48 FPS

4K 4:3 1) 1 bis 60, 66, 72, 75 FPS

4K 2.39:1 1) 120 FPS

Option Beschreibung

Imager Mode Einstellung

4K 4:3 Surround View
4K 6:5
5.7K 16:9
6K 2.39:1
6K 17:9
6K 1.85:1

1 bis 30 FPS

6K 3:2 1 bis 25 FPS

6K 3:2 1) 1 bis 60 FPS

Exposure Index Stellt den EI-Wert ein. Die Einstellung wechselt abhängig von der Einstellung für 
Project > Basic Setting > Base ISO (Seite 58) im vollständigen Menü wie folgt.
ISO 500:

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI

ISO 2500:
640EI/800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/10000EI

Shutter Stellt den Verschlusswinkel/die Verschlussgeschwindigkeit des elektronischen 
Verschlusses ein.
Wählen Sie aus den für den Verschluss registrierten Voreinstellungswerten.

[Hinweis]
Nicht verfügbar, wenn der Betrieb des elektronischen Verschlusses auf Continuous eingestellt 
ist.

Zeigt je nach Einstellung für Technical > System Configuration > Shutter Mode 
(Seite 68) im vollständigen Menü die folgenden Auswahloptionen an.
Angle (Δ): Anzeige des Verschlusswinkels

360.0/180.0/172.8/144.0/90.0/45.0/22.5/11.2/5.6 2)

Speed (SS): Anzeige der Verschlussgeschwindigkeit
1/24, 1/25, 1/30, 1/48, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000 2)

ND Filter Legt die Dichte des ND-Filters fest. Die folgenden Einstellungen sind verfügbar.
Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

WB (White Balance) Stellt die Farbtemperatur des Weißwerts ein.
Wählen Sie aus den für den Weißwert registrierten Voreinstellungswerten.

3200K+00/4300K+00/5500K+00 2)

1)	 Nur wenn eine High Frame Rate-Lizenz aktiviert ist.
2)	 Die Auswahloptionen können mithilfe von Step Edit auf dem Bildschirm Home des Subdisplays geändert werden.
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Clipfunktionen auf dem Minidisplay
Sie können einen Clip wiedergeben, indem Sie ihn 
in dem auf dem Minidisplay angezeigten Clip-
Bildschirm auswählen.
Wenn in der Project-Kategorie im Menü für AXS 
Rec Format nicht Rec Off eingestellt ist, sind AXS-
Medien abspielbar. In gleicher Weise sind SxS-
Medien abspielbar, wenn SxS Rec Format nicht auf 
Rec Off eingestellt ist.
Wenn die Wiedergabe von sowohl AXS- als auch 
SxS-Medien aktiviert ist, können Sie das aktive 
Medium auf dem Bildschirm Clip List (Seite 73) 
des Subdisplays auswählen.

Clip-Bildschirm

Drücken Sie die Taste CLIPS (Seite 8) auf 
der Bedienerseite, um den Clip-Bildschirm 
mit abspielbaren Medien auf dem Minidisplay 
aufzurufen.

7

6

5

1
2
3
4

1.	  Anzeige des Wiedergabestatus
Zeigt den Wiedergabestatus des Clips an.

2.	 Aktives Wiedergabemedium
Zeigt das aktive Wiedergabemedium des 
ausgewählten Clips an.

3.	 Clipname
Zeigt den Namen des ausgewählten Clips an.

4.	 Position des Clips auf Wiedergabemedium
Zeigt die Nummer des ausgewählten Clips 
und die Gesamtanzahl an.

5.	 Schaltfläche F Fwd/Next
Springt zum nächsten Clip, wenn die Taste 
ITEM 3 ( ) gedrückt wird, während die 
Wiedergabe angehalten ist.
Lässt den Clip schnell vorlaufen, wenn die 
Taste ITEM 3 ( ) während der Wiedergabe 
gedrückt wird.

6.	 Schaltfläche Play/Pause
Gibt den Clip wieder bzw. hält die Wiedergabe 
an, wenn die Taste ITEM 2 ( ) gedrückt wird.

7.	 Schaltfläche F Rev/Prev
Springt zum vorhergehenden Clip, wenn die 
Taste ITEM 1 ( ) gedrückt wird, während die 
Wiedergabe angehalten ist.
Lässt den Clip schnell zurücklaufen, wenn die 
Taste ITEM 1 ( ) während der Wiedergabe 
gedrückt wird.

Wiedergabe

Sie können aufgezeichnete Clips wiedergeben, 
während sich das Gerät im Standby-Modus 
befindet.

1	 Setzen Sie die wiederzugebende SxS-
Speicherkarte ein.

2	 Drücken Sie die Taste CLIPS (Seite 8) auf der 
Bedienerseite.
Der aktive Wiedergabeclip wird auf dem 
Minidisplay angezeigt.

3	 Verwenden Sie die Schaltflächen Prev (Taste 
ITEM 1) oder Next (Taste ITEM 3), um einen 
wiederzugebenden Clip auszuwählen.

4	 Drücken Sie die Schaltfläche Play/Pause (Taste 
ITEM 2).
Das Wiedergabebild erscheint im Sucher bzw. 
auf dem Monitorbildschirm.

Wiedergabefunktionen

Die Wiedergabe erfolgt mithilfe der Schaltflächen 
auf dem Minidisplay (Seite 78).
Schaltfläche Play/Pause: Wiedergabe anhalten. 
Drücken Sie diese Schaltfläche erneut, um die 
Wiedergabe fortzusetzen.
Schaltfläche F Fwd/Schaltfläche F Rev: Schneller 
Vorlauf/Rücklauf. Drücken Sie die Schaltfläche 
Play/Pause, um zur normalen Wiedergabe 
zurückzukehren.

Überwachung von Audiosignalen

Im normalen Wiedergabemodus können 
Sie den aufgezeichneten Ton über den 
integrierten Lautsprecher (Seite 8) oder den 
angeschlossenen Kopfhörer überwachen.
Wenn der Kopfhörer am Kopfhöreranschluss 
angeschlossen wird (Seite 8), so wird der 
integrierte Lautsprecher ausgeschaltet.
Mit der Audio-Kategorie > Monitor CH und 
Monitor Level (Seite 46) im Menü können Sie 
den zu überwachenden Audiokanal auswählen 
und die Lautstärke einstellen.

Umschalten zwischen SxS-Speicherkarten

Wenn zwei SxS-Speicherkarten eingesetzt sind, 
drücken Sie die Taste SLOT SELECT (Seite 9), 
um von der einen zur anderen Speicherkarte 
umzuschalten.

[Hinweis]
Während der Wiedergabe ist das Umschalten von einer 
SxS-Speicherkarte zur anderen nicht möglich. Eine 
kontinuierliche Wiedergabe von Karten im Einschub A oder B 
ist nicht möglich.
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Einrichtung und Funktionen des Netzwerks
Wenn Sie das Gerät mit einem Netzwerk 
verbinden, können Sie diverse Einstellungen des 
Geräts von einem Computer, Smartphone, Tablet-
Computer oder einem anderen Gerät aus steuern 
und Informationen zum Gerät anzeigen.

Übersicht der Netzwerkfunktionen

Wenn Sie das Gerät über ein verkabeltes LAN 
oder WLAN mit einem anderen Gerät verbinden, 
können Sie mithilfe eines Browsers auf dem 
anderen Gerät auf das Gerät zugreifen, die Web-
Fernbedienung aufrufen und die folgenden 
Funktionen aktivieren.
ˎˎ Aufnahme am Gerät steuern (Seite 82)
ˎˎ Wiedergabe am Gerät steuern (Seite 82)
ˎˎ Aufnahmeeinstellungen am Gerät konfigurieren 
(Seite 83)
ˎˎ Objektiv am Gerät steuern (Seite 83)
ˎˎ Belegbare Funktionstasten am Gerät 
konfigurieren und bedienen (Seite 83)

Mithilfe der Web-Fernbedienung können Sie 
die Aufnahme fernbedient starten/stoppen 
sowie Einstellungen konfigurieren. Dies ist bei 
Anwendungen nützlich, bei denen das Gerät an 
einer fernen Stelle oder beispielsweise auf einem 
Kran montiert ist.

Kompatible Geräte

Um das Gerät zu konfigurieren und zu bedienen, 
können Sie einen Computer, ein Smartphone 
oder einen Tablet-Computer verwenden. Die 
unterstützten Geräte, Betriebssysteme und 
Browser sind in der folgenden Tabelle aufgeführt.

Gerät Betriebssystem Browser

Computer Microsoft Windows 8.1/
Microsoft Windows 10

Chrome

macOS 10.13/10.14 Safari

Gerät Betriebssystem Browser

Smartphone Android 8.x/9.0 Chrome

iOS 11.x/12.x Safari

Tablet-
Computer

Android 6.x/7.x Chrome

iOS 11.x/12.x Safari

[Hinweis]
Je nach Version des verwendeten Browsers werden die 
Steuerelemente möglicherweise nicht normal angezeigt. 
Der Betrieb in den folgenden Versionen der Browser wurde 
geprüft.
Safari: 11, 12
Chrome: V69

Verbinden des Geräts mit einem 
anderen Gerät über ein 
kabelgebundenes LAN
Sie können das Gerät mithilfe seines 
Netzwerkanschlusses über eine LAN-
Kabelverbindung oder über einen Router mit 
einem anderen Gerät verbinden.

1	 Verbinden Sie den Netzwerkanschluss 
(Seite 8) des Geräts und des Computers mit 
einem LAN-Kabel. Oder verbinden Sie den 
Netzwerkanschluss des Geräts und des Routers 
mit einem LAN-Kabel.

2	 Stellen Sie Technical > Network > Setting 
(Seite 69) im vollständigen Menü auf LAN.

3	 Konfigurieren Sie das Gerät.
Um die IP-Adresse des Geräts automatisch zu 
beziehen:
Stellen Sie Technical > Network > LAN > DHCP 
(Seite 69) im vollständigen Menü auf On, 
und wählen Sie dann Set aus, um die 
Einstellung zu übernehmen.
Um die IP-Adresse des Geräts manuell 
einzugeben:

Stellen Sie Technical > Network > LAN > DHCP 
im vollständigen Menü auf Off, geben Sie die 
Adresse mithilfe von LAN > IP Address ein, und 
wählen Sie dann Set aus, um die Einstellung zu 
übernehmen.

[Hinweis]
Wählen Sie Set auf dem Einrichtungsbildschirm 
Technical > Network > LAN im vollständigen Menü 
aus. Wenn Sie nicht Set auswählen, werden die 
konfigurierten Einstellungen nicht übernommen.

Wenn die Verbindung zu einem verkabelten 
Netzwerk aktiviert ist, erscheint das Symbol 
LAN der Statusanzeige der 
Netzwerkverbindung (Seite 14) im Sucher 
bzw. auf dem Monitorbildschirm.

Verbinden des Geräts mit einem 
anderen Gerät über ein WLAN

Wenn der WLAN-Adapter CBK-WA02 (Option) an 
das Gerät angeschlossen wird, kann das Gerät mit 
anderen Geräten über eine WLAN-Verbindung 
verbunden werden.

Anschließen des CBK-WA02

[Hinweis]
Schalten Sie das Gerät stets aus, bevor Sie den CBK-WA02 
anschließen.

1	 Befestigen Sie den USB-Erweiterungsadapter 
an der in der folgenden Abbildung gezeigten 
Stelle, und sichern Sie ihn, indem Sie die 
Halteschraube im Uhrzeigersinn drehen.

Halteschraube

USB-Erweiterungsadapter

Sie können die Position des USB-
Erweiterungsadapters innerhalb des in der 
folgenden Abbildung gezeigten Bereichs 
anpassen.

2	 Bringen Sie die Schutzkappe (mitgeliefert) am 
USB-Anschluss des USB-Erweiterungsadapters 
an.
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3	 Öffnen Sie die Abdeckung des 
Anschlussblocks für externe Geräte und 
stecken Sie den USB-Anschluss des USB-
Erweiterungsadapters in den Anschluss für 
externe Geräte.

4	 Stecken Sie den CBK-WA02 in den USB-
Anschluss des USB-Erweiterungsadapters.

Herstellen der Verbindung im Access-Point-
Modus

Das Gerät kann an Geräte angeschlossen werden, 
die als Access Point eingerichtet sind.

Smartphone/
Tablet-Computer

Computer

Herstellen der Verbindung zu WPS-Geräten
Geräte, die WPS unterstützen, können über WPS 
angeschlossen werden.

1	 Stellen Sie Technical > Network > Setting 
(Seite 69) im vollständigen Menü auf 
Wireless.

2	 Stellen Sie Technical > Network > Wireless > 
Network Mode (Seite 69) im vollständigen 
Menü auf Access Point.

3	 Wählen Sie Technical > Network > Wireless > 
WPS (Seite 69) im vollständigen Menü.

4	 Wählen Sie Execute aus, indem Sie den Regler 
MENU drehen. Drücken Sie dann den Regler 
MENU.

5	 Öffnen Sie die Netzwerkeinstellungen oder 
WLAN-Einstellungen des Geräts und aktivieren 
Sie WLAN.

6	 Drücken Sie die WPS-Taste in den 
Voreinstellungen für Netzwerkeinstellungen 
oder Wi-Fi-Einstellungen.

[Hinweis]
Die Schritte sind vom verwendeten Gerät abhängig.

Herstellen der Verbindung unter Verwendung von SSID und 
Kennwort auf dem Gerät
Stellen Sie die Verbindung her, indem Sie die SSID 
und das Kennwort auf dem Gerät eingeben.

1	 Stellen Sie Technical > Network > Setting 
(Seite 69) im vollständigen Menü auf 
Wireless.

2	 Stellen Sie Technical > Network > Wireless > 
Network Mode (Seite 69) im vollständigen 
Menü auf Access Point.

3	 Öffnen Sie die Netzwerkeinstellungen oder 
WLAN-Einstellungen des Geräts und aktivieren 
Sie WLAN.

4	 Wählen Sie die SSID des Geräts aus der Liste 
Wi-Fi network SSID aus und geben Sie ein 
Kennwort ein, um eine Verbindung 
herzustellen.
Die SSID und das Kennwort des Geräts finden 
Sie unter Technical > Network > Wireless > 
SSID und Password (Seite 69) im 
vollständigen Menü.

[Hinweis]
Die Schritte sind vom verwendeten Gerät abhängig.

Herstellen der Verbindung im Stationsmodus

Das Gerät kann als Client eine Verbindung zu 
vorhandenen WLAN-Access-Points herstellen.
Das Gerät stellt eine Verbindung über den Access 
Point her.

Smartphone/
Tablet-Computer

Computer

Access 
Point

Herstellen der Verbindung zu einem Access Point mit WPS
Wenn ein Access Point die WPS-Funktion 
unterstützt, können Sie eine Verbindung mit einer 
Grundeinstellung herstellen.

1	 Schalten Sie den Access Point ein.

2	 Schalten Sie das Gerät ein.

3	 Stellen Sie Technical > Network > Setting 
(Seite 69) im vollständigen Menü auf 
Wireless.
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4	 Stellen Sie Technical > Network > Wireless > 
Network Mode (Seite 69) im vollständigen 
Menü auf Station.

5	 Wählen Sie Technical > Network > Wireless > 
WPS (Seite 69) im vollständigen Menü.

6	 Wählen Sie Execute aus, indem Sie den Regler 
MENU drehen. Drücken Sie dann den Regler 
MENU.

7	 Drücken Sie die WPS-Taste des Access Points.
Einzelheiten zur Bedienung der WPS-Taste 
finden Sie in der Bedienungsanleitung des 
Access Points.

[Hinweis]
Wenn die Verbindung fehlschlägt, führen Sie das Verfahren 
ab Schritt 1 erneut aus.

Herstellen der Verbindung durch Eingabe einer SSID und 
eines Kennworts
Stellen Sie die Verbindung her, indem Sie die SSID 
und das Kennwort auf dem Gerät eingeben.

1	 Stellen Sie Technical > Network > Setting 
(Seite 69) im vollständigen Menü auf 
Wireless.

2	 Stellen Sie Technical > Network > Wireless > 
Network Mode (Seite 69) im vollständigen 
Menü auf Station.

3	 Stellen Sie die folgenden Elemente in 
Technical> Network> Wireless (Seite 69) im 
vollständigen Menü ein.
ˎˎ SSID
ˎˎ Password
ˎˎ DHCP
ˎˎ IP Address
ˎˎ Subnet Mask

4	 Wählen Sie zur Bestätigung Set.

[Hinweis]
Verwenden Sie zur Bestätigung stets Set. Wenn die 
Einstellungen nicht mit Set bestätigt werden, werden die 
konfigurierten Einstellungen nicht übernommen.

Herstellen der Verbindung unter Verwendung der 
automatischen Access-Point-Erkennung
Das Gerät kann eine Verbindung herstellen, indem 
es automatisch Access Points erkennt, ohne dass 
die SSID manuell eingegeben werden muss.

1	 Stellen Sie Technical > Network > Setting 
(Seite 69) im vollständigen Menü auf 
Wireless.

2	 Stellen Sie Technical > Network > Wireless > 
Network Mode (Seite 69) im vollständigen 
Menü auf Station.

3	 Wählen Sie Technical > Network > Wireless > 
Scan Networks (Seite 69) im vollständigen 
Menü.

4	 Wählen Sie Execute aus, indem Sie den Regler 
MENU drehen. Drücken Sie dann den Regler 
MENU.
Das Gerät startet die automatische Erkennung 
von Access Points für die Verbindung. Wenn 
die automatische Erkennung abgeschlossen 
ist, werden die für die Verbindung verfügbaren 
Netzwerke in einer Liste angezeigt.

5	 Wählen Sie durch Drehen des Reglers MENU 
das Netzwerk aus, zu dem eine Verbindung 
hergestellt werden soll, und drücken Sie dann 
den Regler MENU.

6	 Wählen Sie zur Bestätigung Set.
Ein Bildschirm zur Kennworteingabe wird 
angezeigt.

7	 Geben Sie das Kennwort ein und wählen Sie 
Done.

Der Bildschirm Wireless preferences wird 
angezeigt.

8	 Stellen Sie die folgenden Elemente in Technical 
> Network > Wireless im vollständigen Menü 
ein und wählen Sie dann zur Bestätigung Set.
ˎˎ DHCP
ˎˎ IP Address
ˎˎ Subnet Mask

[Hinweis]
Verwenden Sie zur Bestätigung stets Set. Wenn die 
Einstellungen nicht mit Set bestätigt werden, werden die 
konfigurierten Einstellungen nicht übernommen.

Aufrufen der Web-Fernbedienung

Die Web-Fernbedienung wird angezeigt, 
wenn Sie vom Browser auf einem anderen 
Gerät aus auf das Gerät zugreifen. Der Web-
Fernbedienungsbildschirm wird automatisch der 
Größe des Bildschirms vom verbundenen Gerät 
angepasst.

1	 Verbinden Sie das Gerät wie unter „Verbinden 
des Geräts mit einem anderen Gerät über ein 
kabelgebundenes LAN“ oder „Verbinden des 
Geräts mit einem anderen Gerät über ein 
WLAN“ beschrieben mit dem anderen Gerät.

2	 Starten Sie auf dem Gerät einen Browser und 
geben Sie in die Adresszeile „http://IP-Adresse 
des Geräts/rm.html“ ein.
Sie können die IP-Adresse des Geräts mithilfe 
von Info-Kategorie > System > IP Address 
(Seite 46) im Menü überprüfen.
Wenn die IP-Adresse beispielsweise 192.168.1.1 
lautet, geben Sie „http://192.168.1.1/rm.html“ 
in die Adresszeile ein.

3	 Geben Sie Benutzername und Kennwort 
(Technical > Authentication (Seite 69) im 
vollständigen Menü) auf dem Browser-
Bildschirm ein.
Wenn die Verbindung erfolgreich hergestellt 
ist, wird auf dem Gerät der Web-
Fernbedienungsbildschirm angezeigt.

[Hinweis]
Die Seite wird auf Smartphones oder ähnlichen Geräten 
möglicherweise nicht korrekt angezeigt, wenn die 
Mobilansicht eingestellt ist. Stellen Sie die Desktop-Ansicht 
ein.

Web-Fernbedienungsbildschirm

Menü Global

Wählen Sie oben links auf dem Web-
Fernbedienungsbildschirm , um das 
Menü Global anzuzeigen. Wählen Sie die zu 
konfigurierende Option.

Bildschirm Camera Control

Der Bildschirm Camera Control enthält die 
Bildschirme Camera und Lens. Wählen Sie die 
Registerkarte Camera, um den Bildschirm Camera 
anzuzeigen und die Registerkarte Lens, um den 
Bildschirm Lens anzuzeigen.
Auf dem Bildschirm Camera Control werden 
verschiedene Anzeigeelemente und 
Bedienschaltflächen angezeigt (gemeinsam 
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für die Bildschirme Camera, Lens und den 
Wiedergabebildschirm).
ˎˎ Status der Netzwerkverbindung (Connected/
Disconnected)
ˎˎ Camera ID*
ˎˎ Schaltfläche Rec
ˎˎ Belegbare Funktionstasten (1 bis 4, A bis C)

*	 Die Textfarbe der Camera ID ist die mit Frame Line A/B 
Setup > Color eingestellte Farbe.

Bildschirm Camera

Sie können auf dem Bildschirm Camera die 
gleichen Optionen wie auf dem Bildschirm Home 
des Subdisplays konfigurieren.

[Hinweis]
Wie beim Subdisplay-Bildschirm wechselt der EI- 
zum Verstärkungs-Anzeigebereich, und es gelten 
Einschränkungen für die Elemente (Seite 33), die bedient 
werden können, wenn im vollständigen Menü Technical > 
System Configuration > RM/RCP Paint Control (Seite 68) 
auf On eingestellt ist.

ˎˎ Aufnahmeeinstellungen (Seite 31) 
FPS, EI, Shutter, ND, LUT, WB
ˎˎ Kamerastatusanzeige (Seite 31) 
Betriebsstatus, Zeitdaten, Tonpegelmesser, 
Clipname, Aufnahmeformat, Medienstatus/freier 
Speicherplatz, Akkuspannung/verbleibende 
Akkukapazität

Bildschirm Lens

Auf dem Bildschirm Lens werden 
Objektivsteuerelemente für Zoom, Fokus und 
Blende angezeigt.

Bildschirm Full Menu

Wählen Sie im Menü Global die Option Full Menu 
aus, um das vollständige Menü zum Konfigurieren 
von Elementen anzuzeigen (Seite 55).

[Hinweis]
Einige Elemente können möglicherweise nicht über die 
Web-Fernbedienung konfiguriert werden.

Bildschirm OSS (Open Source Software) 
Information

Wählen Sie im Menü Global die Option OSS 
Information, um die Informationen zu quelloffener 
Software anzuzeigen.

Bildschirm Playback

Auf dem Bildschirm Playback können Sie Clips 
abspielen. Informationen zum Wiedergabeclip 
werden auch im Statusanzeigebereich des 
Bildschirms angezeigt.
ˎˎ Funktionsanzeige (Seite 74) 
F Rev, Play/Pause, F Fwd, Prev, Stop/Clips, Next
ˎˎ Wiedergabestatusanzeige (Seite 74) 
Zeitdaten, Clipnummer, Bildrate/
Bildgröße des Wiedergabeclips (nur AXS), 
Spezialaufnahmemodus, Audiopegelanzeige, 
Format des Wiedergabeclips (Codec), 
Symbol (Schutz, Unterclip), Name des Clips, 
Wiedergabemedium und Wiedergabestatus.

Taste HOME

Drücken Sie die Taste HOME, um zum Bildschirm 
Camera zurückzukehren.
Wenn Sie die Kamera im Wiedergabemodus 
befindet, kehren Sie durch Drücken der 
Taste HOME zum Kamera-Aufnahmestatus 
auch dann zurück, wenn auf dem 
Web-Fernbedienungsbildschirm der 
Wiedergabebildschirm angezeigt wird.

Taste CLIPS

Drücken Sie die Taste CLIPS, um zum Bildschirm 
Playback zurückzukehren. (Das Gerät wechselt zum 
Bildschirm Clip List (Seite 73).)

Aufnahme

Drücken Sie auf dem Bildschirm Camera Control 
auf die Schaltfläche Rec, um die Aufnahme zu 
starten. Die Anzeige REC wird rot dargestellt. 
Klicken Sie erneut darauf, um die Aufnahme zu 
stoppen.
Die Schaltfläche Rec ist aktiviert, wenn die Leuchte 
REC ACTIVE unten und rechts von der Schaltfläche 
Rec grün ist.

Sperren der Schaltfläche Rec

Bewegen Sie den Schieber Lock unterhalb der 
Schaltfläche Rec nach rechts, um die Betätigung 
der Schaltfläche Rec zu sperren.

Wiedergabe

Drücken Sie auf dem Bildschirm Camera die 
Taste CLIPS, um zum Bildschirm Playback im 
Wiedergabestatus zurückzukehren. (Im Subdisplay 
des Geräts wird der Bildschirm Clip List angezeigt 
(Seite 73).)
Wählen Sie auf dem Bildschirm Playback den 
Clip aus, den Sie wiedergeben möchten, und 
verwenden Sie die Wiedergabesteuerung, um den 
Clip abzuspielen.

Wechseln zwischen Wiedergabemedien

Die Medienauswahl-Schaltfläche wird angezeigt, 
wenn sich das Gerät im Wiedergabestatus 
befindet. Wenn sowohl SxS- als auch AXS-
Medien wiedergegeben werden können, ist die 
Medienauswahl-Schaltfläche aktiviert. Drücken Sie 
die Schaltfläche, um das Wiedergabemedium zu 
wechseln.
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Konfigurieren von 
Aufnahmeeinstellungen

Sie können auf dem Bildschirm Camera die 
gleichen Optionen wie auf dem Bildschirm Home 
des Subdisplays am Gerät konfigurieren und 
bedienen.

[Hinweis]
Die Step Edit-Bedienung für Shutter wird nicht unterstützt.

Die Bedienung erfolgt wie auf dem Bildschirm 
Home des Subdisplays.

„Funktionen auf dem Bildschirm Home des Subdisplays“ 
(Seite 33)

Steuern des Objektivs

Sie können den Status der Einstellungen eines 
Objektivs mit E-Fassung (Zoom, Fokus, Blende) 
auf dem Bildschirm Lens überprüfen und diese 
Einstellungen außerdem mit Schiebereglern 
steuern, falls das angebrachte Objektiv steuerbar 
ist.
Die Kommunikationssteuerung für Cooke-
Objektive mit PL-Fassung wird auf dem Bildschirm 
Lens unterstützt.
Auf dem Bildschirm Lens wird auch die 
Kommunikationssteuerung für 12-polige Objektive 
unterstützt.

[Hinweis]
Die Schieberegler sind abgeblendet und können nicht 
bedient werden, wenn eine RM-B170 oder andere 
Fernbedienung angeschlossen ist und im vollständigen 
Menü Technical > System Configuration > RM/RCP Paint 
Control (Seite 68) auf On eingestellt ist. Die Schieberegler 
für Fokus bzw. Zoom werden abgeblendet, wenn die 
Fernbedienung für Fokus bzw. Zoom aktiviert ist.

Konfigurieren/Bedienen von 
belegbaren Funktionstasten

Die belegbaren Funktionstasten 1 bis 4 und die 
belegbaren Funktionstasten A bis C am Sucher 
werden auf dem Bildschirm Camera Control 
angezeigt.
Drücken Sie die belegbaren Funktionstasten 1 
bis 4 und die belegbaren Funktionstasten A bis 
C am Sucher DVF-EL200, um die zugewiesenen 
Funktionen zu aktivieren/deaktivieren oder um 
diese auf die gleiche Weise wie die belegbaren 
Funktionstasten am Gerät selbst zu betätigen.
Wählen Sie den Funktionsnamen einer belegbaren 
Funktionstaste aus, um Auswahloptionen als 
Pulldown-Menü anzuzeigen. Wählen Sie eine 
Option aus, um die der belegbaren Funktionstaste 
zugewiesene Funktion zu ändern.

„Funktionen, die den belegbaren Funktionstasten 1 bis 4 
zugewiesen werden können“ (Seite 40)

„Funktionen, die den belegbaren Funktionstasten A bis C am 
Sucher (DVF-EL200) zugewiesen werden können“ (Seite 42)

[Hinweis]
Belegbaren Schaltern zugewiesene Funktionen, die nur 
während eine Taste gedrückt gehalten wird oder durch 
langes Drücken aktiviert werden, können nicht mit den 
belegbaren Funktionstasten der Web-Fernbedienung 
bedient werden. Dazu gehören die folgenden Funktionen.

–– Press & Hold for SDI Log
–– Press & Hold for Monitor Log
–– Press & Hold for VF Log
–– Iris Open (1/16 stop)
–– Iris Close (1/16 stop)

Sperren des Web-
Fernbedienungsbildschirms

Sie können die Bedienung des Web-
Fernbedienungsbildschirms sperren, indem Sie 
den Schieber Lock oben rechts auf dem Web-

Fernbedienungsbildschirm nach rechts bewegen.
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Basisfunktionen
Der grundlegende Aufnahmebetrieb läuft 
folgendermaßen ab.

1	 Vergewissern Sie sich, dass die benötigten 
Geräte am Gerät angebracht sind und mit 
Strom versorgt werden.

2	 Bringen Sie den Netzschalter (Seite 8) in die 
Einschaltstellung.
Der Aufnahmebildschirm erscheint auf dem 
Sucherbildschirm.

3	 Setzen Sie Speicherkarte(n) ein.
Wenn zwei AXS- oder SxS-Speicherkarten 
eingesetzt sind, wird die Aufzeichnung 
automatisch auf der zweiten Karte fortgesetzt, 
wenn die erste voll ist.

	 [Hinweis]
Die Karten werden während der gleichzeitigen 
Aufnahme nicht automatisch gewechselt.

4	 Drücken Sie die Taste REC (Seiten 8, 10).
Die Anzeigeleuchte REC leuchtet auf und die 
Aufnahme beginnt.

	 [Hinweis]
Wenn das Gerät die Aufnahme nicht unmittelbar 
nach dem Drücken der Taste REC starten kann, blinkt 
die Anzeigeleuchte REC. Wenn die Aufnahme startet, 
leuchtet die Anzeigeleuchte REC.

5	 Um die Aufzeichnung anzuhalten, drücken Sie 
wieder die Taste REC.
Die Aufzeichnung wird angehalten und das 
Gerät schaltet auf STBY (Standby).
Wenn Sie die Aufzeichnung anhalten, werden 
die Video-, Audio- und Zusatzdaten vom 
Anfang bis zum Ende der Aufzeichnung als 
einzelner Clip gespeichert.

Clipnamen

Clipnamen werden im Format „Cam ID + Reel#“ 
aufgezeichnet. Der Clipname wird nach den 
folgenden Regeln gebildet.
ˎˎ Wenn sich bereits ein im Benennungsformat 
„Cam ID + Reel#“ gespeicherter Clip auf der 
eingesetzten SxS- oder AXS-Speicherkarte 
befindet, wird für die Bildung des Namens 
der neuen Datei von der letzten vorhandenen 
ausgegangen.  
Beispiel: Wenn sich „B002C003_XXXXXXXX“ 
auf der AXS-Speicherkarte befindet, wird 
der nächste Clip mit „B002C004_XXXXXXXX“ 
benannt.
ˎˎ Wenn auf der eingesetzten AXS-Speicherkarte 
keine Datei vorhanden ist, wird „1“ zu der zuletzt 
aufgezeichneten Reel Number hinzugefügt.  
Beispiel: Wenn Sie auf Karte 1 zuletzt die Datei 
„D001CXXX_XXXXXXXX“ aufgenommen haben 
und dann auf eine leere Karte 2 aufnehmen, 
wird der nächste erstellte Clip mit „D002C001_
XXXXXXXX“ benannt. Der Clipname wird vor 
Beginn der Aufnahme unterstrichen angezeigt.
ˎˎ Wenn Sie Camera ID und Reel Number mithilfe 
der TC/Media-Kategorie > Clip Naming im Menü 
einstellen, gelten diese Angaben.  
Beispiel: Wenn Sie für eine AXS-Speicherkarte, 
auf der zuletzt die Datei „E003CXXX_XXXXXXXX“ 
aufgenommen wurde, die Camera ID in „F“ und 
Reel Number in „001“ ändern, lautet der nächste 
Clipname „F001CXXX_XXXXXXXX“. Wenn Sie 
nur die Camera ID ändern, ändert sich die Reel 
Number in „001“.

Maximale Dauer eines Clips

Die maximale Länge eines einzelnen Clips, den Sie 
auf eine SxS-Speicherkarte aufzeichnen können, 
beträgt 6 Stunden. Die maximale Aufnahmezeit 
beträgt 24 Stunden.
Die Aufzeichnung wird auf mehrere Clips 
aufgeteilt, wenn die Aufzeichnungsdauer die 
maximale Clipdauer überschreitet.

Die Aufnahme stoppt nach 24 Stunden 
Aufnahmezeit.

5. Aufnahme
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Nützliche Funktionen
Gleichzeitige Aufnahme

Sie können auf einer SxS-Speicherkarte in einem 
einzigen Einschub zwei Bildgrößen gleichzeitig 
aufnehmen. Sie können auch ein HD-Signal auf der 
SxS-Speicherkarte im Gerät aufzeichnen, während 
Sie gleichzeitig Video und Audio auf dem AXS-R7 
im RAW-Format aufzeichnen.
Die gleichzeitige Aufnahme können Sie mittels 
der Project-Kategorie > AXS Rec Format 
und SxS Rec Format oder SxS Rec Format 
und Sub Rec Format im Menü wie unter 
„Aufzeichnungsformateinstellungen“ (Seite 48) 
beschrieben durchführen.

Bei gleichzeitiger Aufnahme 1 Einschub 
wird der Clip in XAVC 4K Class480/XAVC 4K 
Class300/XAVC QFHD Class480/XAVC QFHD 
Class300 im Verzeichnis XDROOT/Clip auf der 
SxS-Speicherkarte aufgezeichnet, der MPEG2 
1920×1080-Clip jedoch im Verzeichnis XDROOT/
Sub. An den Clipnamen wird die Endung „S02“ 
angehängt.

Bildpuffer-Aufnahme

Das Gerät legt bei der Aufnahme im Speicher 
immer einen Puffer von Video- und Audiodaten 
für einen festgelegten Zeitraum (maximal 
30 Sekunden) ab, sodass Sie mehrere Sekunden 
Material vor dem Beginn der Aufnahme zur 
Verfügung haben.
Wenn bei Beginn der Aufnahme Project> Special 
Recording> Cache Rec Select (Seite 59) im 
vollständigen Menü auf On gesetzt ist, wird 
rückwirkend ein Video mit der in Project > Special 
Recording > Max Cache Rec Duration (Seite 59) 
eingestellten Dauer aufgenommen.
Sie können die Bildpuffer-Aufnahme auch mit 
einer belegbaren Funktionstaste aktivieren/
deaktivieren, der die Funktion Picture Cache Rec 
zugewiesen ist.

[Hinweise]
ˎˎ Abhängig von der Systemfrequenz, dem Aufnahmeformat 

und den Aufnahmemedien können Einschränkungen 
für die Einstellung Max Cache Rec Duration gelten. 
Einzelheiten siehe Seite 59.
ˎˎ Durch Ändern der Systemeinstellungen, z. B. des 

Aufnahmeformats, werden alle im Speicher abgelegten 
Bilder gelöscht. Bilder, die unmittelbar vor dem Ändern 
von Einstellungen gefilmt wurden, können daher nicht 
aufzeichnet werden, wenn die Aufzeichnung unmittelbar 
nach dem Ändern der Einstellungen gestartet wird. Der 
Bildpuffermodus wird automatisch ausgelöst.
ˎˎ Aufzeichnungen im Bildpuffermodus sind während 

der gleichzeitigen Aufnahme 1 Einschub oder der 
gleichzeitigen AXS-/SxS-Aufnahme nicht verfügbar.
ˎˎ Die Bildpuffereinstellungen können während der 

Aufzeichnung nicht geändert werden.
ˎˎ Beim Aufnehmen in MPEG 422 mit niedriger 

Aufzeichnungsbildrate kann es einige Zeit dauern, die 
Aufnahme zu stoppen oder zwischen Speicherkarten zu 
wechseln.

Prüfen der Aufzeichnung (Rec 
Review)

Sie können die Funktion Rec Review einer der 
belegbare Funktionstasten 1 bis 4 (Seite 39) 
zuweisen und den zuletzt aufgezeichneten Clip 
damit auf dem Bildschirm anzeigen.
Wenn Sie die Aufzeichnung anhalten und die 
mit Rec Review belegte Taste drücken, wird 
der Clip ab dem ersten Einzelbild mit normaler 
Geschwindigkeit wiedergegeben.
Der Clip wird bis zum Ende wiedergegeben, dann 
endet die Funktion Rec Review, und das Gerät 
kehrt in den STBY-Modus (Aufnahme-Standby) 
zurück.
Wenn während der Wiedergabe die Taste HOME 
auf der Bedienerseite oder Assistentenseite 
gedrückt wird, stoppt die Wiedergabe, und das 
Gerät wechselt in den Aufnahmemodus.

HD-Fokuslupenfunktion

Wenn Sie die Taste FOCUS MAG eines am Gerät 
montierten Suchers (Modell DVF-EL200, DVF-L700) 
drücken, wird die Mitte des Sucherbildes 
vergrößert angezeigt, sodass sich der Fokus 
leichter einstellen lässt.
Die vergrößerte Anzeige hat keinen Einfluss auf 
das aufgezeichnete Bild oder das Ausgangssignal.
Die normale Fokuslupe reduziert die Auflösung, 
weil sie lediglich einen Teil des angezeigten Bildes 
vergrößert. Die zweifache Fokussierung (×2) des 
Geräts bietet jedoch Fokusvergrößerung unter 
Beibehaltung der Anzeigeauflösung, indem der 
zu vergrößernde Teil aus dem 4K-Signal anstelle 
des aufgenommenen Bildes oder eines anderen 
Ausgangssignals entnommen wird. Durch die 
4K-Bildausschnittsfunktion wird auch die Auswahl 
vierfacher (×4) Fokusvergrößerung unterstützt.
Die Vergrößerungsabfolge mit der Taste FOCUS 
MAG kann mithilfe von Monitoring > VF Display > 
VF Magnifier Ratio (Seite 66) im vollständigen 
Menü geändert werden.
Wenn VF Magnifier Ratio auf ×2.0/×4.0 eingestellt 
ist, wird bei jedem Drücken der mit VF Focus 
Magnifier belegten belegbaren Funktionstasten 1 
bis 4 die Vergrößerungsabfolge ×2.0  ×4.0  
×1.0  ×2.0 durchlaufen.

[Hinweis]
Im High Frame Rate-Modus (Aufnahmebildrate von 61 fps 
oder mehr) sinkt die Auflösung des ×2-Fokusanzeigebilds, da 
die Ausschnittanzeige von einem 4K-Bild nicht unterstützt 
wird.
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Anzeige beschränkter 
Spitzlichtbereiche

Sie können beschränkte Spitzlichtbereiche in 
Rot auf dem Monitor- und Sucher-Ausgangsbild 
anzeigen.
Drücken Sie die mit Monitor Highlight Clip Ind 
und VF Highlight Clip Ind belegten belegbaren 
Funktionstasten (Seiten 39, 40), um die 
Anzeige beschränkter Spitzlichtbereiche ein- bzw. 
auszuschalten.

[Hinweis]
Die Anzeige beschränkter Spitzlichtbereiche funktioniert 
nicht, wenn im vollständigen Menü Technical > System 
Configuration > RM/RCP Paint Control (Seite 68) auf On 
eingestellt ist.

High Key / Low Key

Sie können das Monitor- und Sucher-Ausgangsbild 
auf überbelichtete Spitzlichter oder ausgeblendete 
Schatten prüfen.
Schalten Sie High Key ein, um Bereiche starker 
Helligkeit zur besseren Sichtbarkeit hervorzuheben 
und auf überbelichtete Spitzlichter zu prüfen.
Schalten Sie Low Key ein, um Bereiche geringer 
Helligkeit zur besseren Sichtbarkeit hervorzuheben 
und auf ausgeblendete Schatten zu prüfen.
Drücken Sie zum Umschalten der High Key- und 
Low Key-Einstellungen die mit Monitor High/Low 
Key und VF High/Low Key belegten belegbaren 
Funktionstasten 1 bis 4 (Seite 40), um zwischen 
den Einstellungen umzuschalten.

[Hinweis]
High/Low Key funktioniert nicht, wenn im vollständigen 
Menü Technical > System Configuration > RM/RCP Paint 
Control (Seite 68) auf On eingestellt ist.

Falschfarbenanzeige

Sie können im Sucher Falschfarben anzeigen 
lassen, indem Sie am Sucher des Geräts die Taste 
B/False Color (DVF-EL200) oder die Taste SPARE 
(DVF-L700) drücken.
Sie können Falschfarben auch in der 
Monitorausgabe anzeigen.

Anzeige-
farbe

Signalpegel

S-Log3 (Standard) S-Log2 (PMW-F55-
Referenz)

Rot 93,4% bis 96,1% 105,5% bis 109,5%

Gelb 91,3% bis 93,4% 102,5% bis 105,5%

Orange 87,7% bis 90,6% 97,4% bis 101,5%

Rosa 54,3% bis 58,0% 50,2% bis 55,2%

Hellrosa 47,8% bis 50,8% 
(18% grau + 1 Stop)

41,5% bis 45,4% 
(18% grau + 1 Stop)

Zyan 43,8% bis 46,5% 36,3% bis 39,6%

Grün 38,9% bis 42,2% 
(18% grau)

30,4% bis 34,4% 
(18% grau)

Hellblau 24,6% bis 34,4% 15,5% bis 25,2%

Blau 3,5% bis 5,6% 3,0% bis 4,0%

Magenta –7,3% bis 3,5% –7,3% bis 3,0%

ˎˎ Sie können mit Monitoring > False Color 
(Seite 65) festlegen, ob im Sucher und in 
der Monitorausgabe die voreingestellte Ein-/
Aus-Einstellung und der Schwellenwert für die 
einzelnen Falschfarben verwendet wird oder die 
Farben manuell eingestellt werden.
ˎˎ Sie können die Falschfarben-Funktionsanzeige in 
einem Sucher ein- oder ausschalten, indem Sie 
eine mit VF False Color belegte Funktionstaste 
drücken.
ˎˎ Sie können die Falschfarben-Funktionsanzeige 
auf einem Monitor ein- oder ausschalten, 
indem Sie eine mit Monitor False Color belegte 
Funktionstaste drücken.

[Hinweise]
ˎˎ Beim DVF-L700 wird die Anzeige nur unterstützt, wenn 

Gamma für das im Sucher ausgegebene Videosignal auf 
S-Log2 eingestellt ist.
ˎˎ Die Falschfarbenfunktion arbeitet nicht, wenn im 

vollständigen Menü Technical > System Configuration > 
RM/RCP Paint Control (Seite 68) auf On eingestellt ist.

Double Speed Scan-Funktion des 
Suchers

Bei einer Projektbildrate von 23.98P, 24P, 25P oder 
29.97P kann das Bild aufgrund der niedrigen 
Bildfrequenz verschwommen und nur schwer 
erkennbar sein, wenn Sie das Gerät beim 
Aufnehmen nach rechts und links schwenken.
In diesem Fall können Sie Bildunschärfen 
verringern und das Bild klarer erkennbar machen, 
wenn Sie die Double Speed Scan-Funktion des 
Suchers aktivieren.
Um die Funktion zu aktivieren, setzen Sie 
Monitoring > VF Function > Double Speed Scan 
(Seite 66) im vollständigen Menü auf On.

[Hinweise]
ˎˎ Wenn diese Funktion aktiviert ist, ist der Verschlusswinkel 

des elektronischen Verschlusses auf höchstens 180 Grad 
begrenzt.
ˎˎ Diese Funktion ist während der Aufnahme mit variabler 

Geschwindigkeit deaktiviert.
ˎˎ Diese Funktion ist für die folgenden Kombinationen von 

Bildgröße und Projektbildrate aktiviert.  
3.8K 16:9 (23.98p, 24p, 25p, 29.97p) 
4K 17:9 (23.98p, 24p, 25p, 29.97p) 
3.8K 16:9 Surround (23.98p, 24p) 
4K 17:9 Surround (23.98p, 24p) 
4K 4:3 (23.98p, 24p)

User 3D LUT

Sie können eine mit RAW Viewer oder DaVinci 
Resolve (von Blackmagic Design Pty. Ltd.) erstellte 
CUBE-Datei (*.cube) für eine 17-Punkt- oder 
33-Punkt-3D-LUT laden (Seite 35).
Stellen Sie Input Color Space übereinstimmend 
mit dem Eingabefarbraum zum Zeitpunkt der 
Erstellung der CUBE-Datei ein.
Falls die Datei mithilfe von S-Gamut3.Cine/S-Log3 
erstellt wurde, stellen Sie Project-Kategorie > Basic 
Setting > Input Color Space (Seite 58) im Menü 
auf S-Gamut3.Cine/S-Log3 ein.
Speichern Sie die User 3D LUT-Datei auf der SD-
Karte in dem folgenden Verzeichnis.
PRIVATE\SONY\PRO\LUT\

ASC CDL

Sie können mit externen Tools erstellte ASC-
CDL-Dateien (*.cdl) in das Gerät importieren 
(ASC-CDL steht für The American Society of 
Cinematographers Color Decision List, d. h. 
Farbkorrekturwertliste der Vereinigung US-
amerikanischer bildgestaltender Kameraleute).
Hierdurch können Sie Aufnahmen erstellen, 
bei denen ASC-CDL-Parameter auf den Look 
angewendet werden.
Speichern Sie die ASC-CDL-Datei auf der SD-Karte 
in dem folgenden Verzeichnis.
PRIVATE\SONY\PRO\CDL\



00087 6. Anschließen externer Geräte

Anschließen einer Fernbedienung
Wenn eine der Fernbedienungen RM-B170, 
RCP-1001/1501 oder eine andere Fernbedienung 
angeschlossen ist, können mit dieser einige 
Funktionen gesteuert werden.

Anschließen einer Fernbedienung

Verbinden Sie den Kameraanschluss der 
Fernbedienung über ein Fernbedienungskabel mit 
dem Anschluss REMOTE (8-polig) des Geräts.
Wenn Sie danach das Gerät einschalten, 
wechselt es in den Fernbedienungsmodus 
und erlaubt die Verwendung von Menü- und 
Aufnahmefunktionen.

[Hinweise]
ˎˎ Schließen Sie die Fernbedienung nicht an und trennen Sie 

diese nicht, während das Gerät eingeschaltet ist.
ˎˎ Zur Fernbedienung RCP-1001/1501 wird kein 

Fernbedienungskabel mitgeliefert.

Verlassen des Fernbedienungsmodus

Schalten Sie das Gerät aus und trennen Sie die 
Fernbedienung.

Einstellen der Funktion zur 
Farbregulierung

Um die Funktion zur Farbregulierung zu aktivieren, 
muss im vollständigen Menü Technical > System 
Configuration > RM/RCP Paint Control (Seite 68) 
auf On eingestellt sein.
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Über RCP-1001/1501 oder RM-B170/B750 steuerbare Hauptfunktionen

Tabellenerklärung
Auf der Anzeige wird wie folgt signalisiert, ob Fernbedienung unterstützt wird.
Ja: wird unterstützt
–: wird nicht unterstützt
Option Unteroption Unteroption Auswahloption RCP-1001 RCP-1501 RM-B170 RM-B750

Shooting FPS Fixed/Variable Select On/Off – Ja Ja 1) Ja

FPS Select 1FPS bis 110FPS – Ja Ja 1) Ja

Shutter Select 2) Shutter ON/OFF On/Off – Ja Ja Ja

ECS ON/OFF On/Off – Ja Ja Ja

Shutter Speed Die für Step registrierten Werte.
Die folgenden Werte können angezeigt werden.
1/32
1/33
1/48
1/50
1/60
1/96
1/100
1/120
1/125
1/250
1/500
1/1000
1/2000
1/3000
1/4000
1/5000

– Ja Ja Ja

ECS Frequency – – Ja Ja Ja

ND ND Position 1: (CLEAR)
2: (0.3 density)
3: (0.6 density)
4: (0.9 density)
5: (1.2 density)
6: (1.5 density)
7: (1.8 density)
8: (2.1 density)
9: (2.4 density)

Ja Ja Ja Ja
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Option Unteroption Unteroption Auswahloption RCP-1001 RCP-1501 RM-B170 RM-B750

White Balance 2) Color Temp 2000K bis 15000K 3) – Ja – Ja

Color Temp Balance (Tint equivalent) –99 bis ±0 bis +99 4) – Ja – Ja

R Gain –99 bis ±0 bis +99 Ja Ja Ja Ja

B Gain –99 bis ±0 bis +99 Ja Ja Ja Ja

Auto White Balance – Ja Ja Ja Ja

Paint 2) Switch Status Gamma On/Off – Ja Ja 1) Ja

Black Gamma 5) On/Off – Ja Ja 1) Ja

Flare On/Off – Ja Ja 1) Ja

Black Master Black –99 bis ±0 bis +99 Ja Ja Ja Ja

R Black –99 bis ±0 bis +99 Ja Ja Ja Ja

B Black –99 bis ±0 bis +99 Ja Ja Ja Ja

Flare Setting On/Off – Ja Ja 1) Ja

Master Flare –99 bis ±0 bis +99 – Ja Ja 1) –

R Flare –99 bis ±0 bis +99 – Ja – Ja

G Flare –99 bis ±0 bis +99 – Ja – Ja

B Flare –99 bis ±0 bis +99 – Ja – Ja

Gamma Setting On/Off – Ja Ja 1) Ja

Black Gamma Setting On/Off – Ja Ja 1) Ja

Range Low/L.Mid/H.Mid – Ja – Ja

Master Black Gamma –99 bis ±0 bis +99 – Ja Ja 1) Ja

Technical Test Signals Color Bars On/Off On/Off Ja Ja Ja Ja

Rec – – – – – Ja Ja

Play – – – – – Ja Ja

Stop – – – – – Ja Ja

F.Rev – – – – – Ja Ja

F.Fwd – – – – – Ja Ja

Rec Review – – – – – Ja Ja

Next – – – – – Ja –

Prev. – – – – – Ja –

Gain 2) Gain(Step) – –6dB/–3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB Ja Ja Ja Ja

White Mode 2) Preset ON/OFF – On/Off – – Ja Ja

Iris Iris Level – (Steuerbereich des Zielobjektivs) Ja Ja Ja Ja

Close – On/Off Ja Ja – Ja

Zoom 6) Remote – On/Off – Ja 1) Ja 1) –

Speed – – – – – –

Tele to Wide – – – Ja 1) Ja 1) –

Zoom Value[%] – – – Ja 1) Ja 1) –

Focal Length[mm] – – – Ja 1) Ja 1) –
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Option Unteroption Unteroption Auswahloption RCP-1001 RCP-1501 RM-B170 RM-B750

Focus 6) Remote – On/Off – Ja 1) Ja 1) –

Focus Position – – – Ja 1) Ja 1) –

Focus Value[%] – – – Ja 1) Ja 1) –

Focus Length[m] – – – Ja 1) Ja 1) –

1)	 Steuerbar, sofern dem Bedienblock der Fernbedienung zugewiesen.
2)	 Nur steuerbar, wenn im vollständigen Menü Technical > System Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist.
3)	 Da Color Temp Balance während dem R/B Gain-Vorgang bei 2000K und 15000K begrenzt wird, ist es ggf. nicht möglich, den korrekten Color Temp-Wert für den Wert von R/B Gain anzuzeigen.
4)	 Da Color Temp Balance bei ±99 begrenzt wird, ist es ggf. nicht möglich, den korrekten Color Temp Balance-Wert für den Wert von R/B Gain anzuzeigen.
5)	 Nur konfigurierbar, wenn im Menü Project > Basic Setting > Input Color Space (Seite 58) auf Rec.2020/HLG_Rec.2100 eingestellt ist.
6)	 Die Verfahrbefehle für Zoom und Fokus von einer Fernbedienung werden deaktiviert, wenn ein Objektiv mit E-Fassung angebracht ist.
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Anschließen externer Monitore und Aufnahmegeräte
Für die Wiedergabe des Aufnahmebilds bzw. von 
Aufzeichnungen auf einem externen Monitor 
wählen Sie das Ausgangssignal aus und schließen 
den Monitor mit einem geeigneten Kabel an.
Das Ausgangssignal des Geräts kann 
aufgezeichnet werden, indem ein Aufnahmegerät 
wie ein Videorecorder angeschlossen wird.
Auf dem externen Monitor können die gleichen 
Statusinformationen und Menüs wie auf dem 
Sucherbildschirm angezeigt werden. Legen Sie 
mithilfe des Menüs Monitoring (Seite 63) fest, 
welcher Inhalt je nach Ausgangssignal für den 
Monitor angezeigt werden soll.

[Hinweis]
Wenn FPS auf Variable eingestellt ist, kommt es ggf. nur 
bei 4K-Ausgabe zu einer horizontalen Bildverschiebung. 
Dieses Phänomen kann sich bei schnelleren Bildraten (FPS) 
bemerkbar machen. Dies beeinträchtigt jedoch nicht das 
aufgenommene Bild und das Wiedergabebild wird korrekt 
angezeigt.

Anschluss SDI OUT (Typ BNC)

Legen Sie das Ausgangsformat mit dem Menü 
Monitoring (Seite 63) fest.
Verwenden Sie für den Anschluss ein 
handelsübliches 75-Ohm-Koaxialkabel.

[Hinweis]
Stellen Sie vor dem Einschalten sicher, dass eine 
Erdungsverbindung zwischen dem Gerät und dem externen 
Gerät besteht. (Wir empfehlen, vor dem Einschalten 
des Geräts und des externen Geräts erst ein 75-Ohm-
Koaxialkabel anzuschließen.)
Wenn Sie ein externes Gerät an das Gerät anschließen 
möchten, während es eingeschaltet ist, schließen Sie erst ein 
75-Ohm-Koaxialkabel an das externe Gerät an und stellen Sie 
die Verbindung zum Gerät danach her.

Synchronisierte Aufnahme auf einem externen 
Gerät starten

Wenn der SDI-Signalausgang ausgewählt wurde, 
ist eine synchrone Aufnahme möglich, indem 

einem externen Aufnahmegerät, das an den 
Anschluss SDI OUT angeschlossen ist, ein REC-
Auslösersignal zugeleitet wird. Setzen Sie zum 
Aktivieren der synchronisierten Aufnahme im 
Menü Technical > System Configuration > SDI Rec 
Remote Trigger (Seite 68) auf HD SDI Remote I/F 
oder Parallel Rec.

[Hinweis]
Wenn ein angeschlossenes externes Gerät kein REC-
Auslösesignal unterstützt, kann das Gerät nicht bedient 
werden.

Anschluss MONITOR OUT (Typ BNC)

Gibt ein HD-SDI-Signal aus.
Legen Sie das Ausgangsformat mit dem Menü 
Monitoring (Seite 63) fest.
Verwenden Sie für den Anschluss ein 
handelsübliches 75-Ohm-Koaxialkabel.

[Hinweis]
An diesem Ausgang werden Audio und Zeitcode nicht 
überlagert.

Anschluss HDMI OUT (Anschluss Typ 
A)

Legen Sie das Ausgangsformat mit dem Menü 
Monitoring (Seite 63) fest.
Verwenden Sie für den Anschluss ein 
handelsübliches HDMI-Kabel.
Wenn das Ausgangsformat die gleiche Auflösung 
wie das Signal am Anschluss MONITOR OUT 
besitzt, wird das gleiche Videosignal ausgegeben.

Anschluss 12V OUT 
(Gleichspannungsausgang 12 V, 
4-polig, Hirose)

Versorgt ein Zubehörgerät mit 12 V DC, solange 
der Netzschalter auf ON steht. Über den Anschluss 
12V OUT können Sie ein REC-Tally-Signal ausgeben 
und ein REC-Trigger-Signal einspeisen.

Nr. Signal IN/
OUT

Spezifikation

1 UNREG GND – GND für UNREG

2 REC TALLY OUT offener 
Kollektorausgang
(max. 50 mA)
Niedrig: REC

3 REC TRIGGER IN Offen oder +5 V DC: 
Normal
GND: Aktiv (REC)

4 UNREG +12 V 
OUT

OUT DC-Ausgang, +11 V 
bis 17 V
Eingang 11 V bis 
17 V
Ausgangsspannung: 
wie 
Eingangsspannung
maximaler 
Ausgangsstrom: 1,0 A
Eingang 22 V bis 32 
V
Ausgangsspannung: 
15 V
maximaler 
Ausgangsstrom: 0,8 A

Anschluss 24V OUT 
(Gleichspannungsausgang 24 V, 
3-polig, Fischer)

Versorgt ein Zubehörgerät mit 24 V DC, solange 
der Netzschalter auf ON steht. Über den Anschluss 
24V OUT können Sie ein REC-Tally-Signal ausgeben 
und ein REC-Trigger-Signal einspeisen.

Nr. Signal Spezifikation

1 GND

2 24V-AUX Eingang 11 V bis 17 V
Ausgangsspannung: 24 V
maximaler Ausgangsstrom: 
1,0 A
Eingang 22 V bis 32 V
Ausgangsspannung: wie 
Eingangsspannung
maximaler Ausgangsstrom: 
2,0 A

3 R/S
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Anschluss AUX (5-polig, LEMO)

Gibt das Zeitcodesignal aus.

Nr. Signal

1 Factory Use

2 NC

3 –

4 TC OUT

5 GND
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Beim Aufnehmen mit mehreren Geräten kann die 
Aufnahme mithilfe eines speziellen Referenzsignals 
für den Zeitcode an allen Geräten synchronisiert 
werden.

Synchronisieren der Videosignalphase 
(Genlock)

Der Genlock-Betrieb wird aktiviert, indem am 
Anschluss GENLOCK IN (Seite 11) des Geräts 
eines der folgenden Referenzsignale eingespeist 
wird.
ˎˎ HDSDI 1.5G digital (interlaced oder PsF)
ˎˎ HD Y analog
ˎˎ SD VBS analog

Legen Sie das Genlock-Eingangssignal mithilfe von 
Technical > Genlock > Input Source (Seite 71) im 
vollständigen Menü fest.
Gültige Eingangsreferenzsignale variieren je nach 
der Einstellung für die Projektbildrate.
Projektbildrate Gültiges Referenzsignal

23.98P 1920×1080 47.95i (23.98PsF)

24P 1920×1080 48i (24PsF)

25P 1920×1080 50i
720×576 50i

29.97P 1920×1080 59.94i
720×486 59.94i

47.952 1920×1080 47.95i (23.98PsF)

50i 1920×1080 50i
720×576 50i

50P 1920×1080 50i
720×576 50i

59.94i 1920×1080 59.94i
720×486 59.94i

59.94P 1920×1080 59.94i
720×486 59.94i

Sie können den Genlock-Status im Menü mithilfe 
von Technical > Genlock > Reference Lock Type 
(Seite 71) prüfen.

[Hinweise]
ˎˎ Wenn das Referenzsignal nicht stabil ist, ist Genlock nicht 

anwendbar.
ˎˎ Der Subträger ist nicht synchronisiert.

Synchronisieren des Zeitcodes mit 
einem anderen Gerät

Setzen Sie das Gerät, das den Zeitcode liefert, in 
einen Modus, in dem der Zeitcode weiterläuft 
(Free Run-Modus).

1	 Setzen Sie im Menü TC/Media > Timecode > 
Mode (Seite 61) auf Preset F-Run (Ext-Lk).

2	 Speisen Sie ein HD- oder SD-
Referenzvideosignal am Anschluss GENLOCK 
IN (Seite 11) ein und einen damit 
synchronisierten Referenzzeitcode am 
Anschluss TC IN (Seite 9).

Der eingebaute Zeitcodegenerator Ihres Geräts 
verbindet sich mit dem Referenzzeitcode, und die 
Meldung „Ext-Lk“ erscheint auf dem Bildschirm.
Etwa zehn Sekunden nach erfolgreicher 
Synchronisation des Zeitcodes wird der Status der 
externen Synchronisation beibehalten, auch wenn 
die externe Quelle des Zeitcodes getrennt wird.

[Hinweise]
ˎˎ Prüfen Sie, ob sich der Referenzzeitcode und das 

Referenzvideosignal in einer Phasenbeziehung befinden, 
das den SMPTE-Zeitcodestandards entspricht.
ˎˎ Nach Abschluss des oben beschriebenen Vorgangs 

wird der Zeitcode sofort mit dem externen Zeitcode 
synchronisiert, und die Zeitdatenanzeige zeigt den 
Wert des externen Zeitcodes. Sie müssen vor der 
Aufzeichnung jedoch einige Sekunden warten, bis sich 
der Zeitcodegenerator stabilisiert hat.
ˎˎ Wenn die Frequenz des Referenzvideosignals und die 

Bildfrequenz nicht gleich sind, kann keine Synchronisation 
erreicht werden, sodass das Gerät nicht einwandfrei 
funktioniert. In diesem Fall kann der Zeitcode nicht 
erfolgreich mit dem externen Zeitcode synchronisiert 
werden.
ˎˎ Wenn die Verbindung getrennt wird, kann sich der 

Zeitcodelauf im Verhältnis zum Referenzzeitcode um ein 
Einzelbild pro Stunde verschieben.

Aufheben der externen Synchronisation

Ändern Sie im Menü die Einstellung TC/Media > 
Timecode > Mode (Seite 61).

Externe Synchronization
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Vorsichtsmaßnahmen bei der Verwendung
Lesen Sie diesen Abschnitt in Verbindung mit den 
Informationen im mitgelieferten Dokument „Vor 
Verwendung dieses Gerät“.

Verwendung und Lagerung

Schützen Sie das Gerät vor starken Stößen

Durch Stöße können mechanische Komponenten 
im Gerät beschädigt werden oder das Gehäuse 
kann sich verziehen.

Das Gerät darf während des Betriebs nicht bedeckt 
sein

Abdecken mit einem Tuch kann beispielsweise 
Überhitzen des Geräts zur Folge haben.

Nach der Verwendung

Stellen Sie den Schalter POWER auf OFF.

Wenn Sie das Gerät für längere Zeit nicht mehr 
verwenden

Entfernen Sie den Akku.

Das Objektiv des Geräts sollte nicht direkt auf die 
Sonne gerichtet sein

Direkte Sonneneinstrahlung kann durch das 
Objektiv eindringen, im Gerät gebündelt werden 
und einen Brand verursachen.

Transport

ˎˎ Entnehmen Sie die Speicherkarten, bevor Sie 
das Gerät transportieren.

ˎˎ Wenn Sie das Gerät per Lkw, Schiff, Flugzeug 
oder einem anderen Transportsystem 
versenden, sollten Sie es in dem ursprünglich 
verwendeten Material verpacken.

Pflege des Geräts

Wenn das Gehäuse verschmutzt ist, wischen 
Sie es mit einem weichen, trockenen Tuch ab. 
Verwenden Sie in extremen Fällen ein leicht 
mit Reinigungsmittel angefeuchtetes Tuch und 
trocknen Sie das Gehäuse anschließend ab.
Verwenden Sie keine Lösungsmittel wie Alkohol 
oder Verdünner, da diese Entfärbungen oder 
andere Schäden an der Geräteoberfläche 
hervorrufen können.
Verwenden Sie keine Druckluftreiniger wie Air 
Duster, da die optischen Komponenten hierdurch 
beschädigt werden können.

Bei Betriebsproblemen

Wenden Sie sich an Ihren Sony-Kundendienst, 
wenn Probleme mit dem Gerät auftreten.

Regelmäßiges Ersetzen von Lüfter 
und Batterie

Lüfter und Batterie des Geräts sind 
Verbrauchsmaterialien, die regelmäßig ersetzt 
werden müssen.
Wenn das Gerät bei Raumtemperatur betrieben 
wird, sollten die Teile ca. alle 5 Jahre ersetzt 
werden. Diese Ersatzfristen stellen jedoch nur 
eine allgemeine Richtlinie und keine Garantie 
der Lebensdauer dieser Teile dar. Weitere 
Informationen zum Austausch von Komponenten 
erhalten Sie bei Ihrem Händler.

Lebensdauer des 
Elektrolytkondensators

Die Lebensdauer des Elektrolytkondensators 
beträgt bei normalen Betriebstemperaturen und 
normaler Verwendung etwa 5 Jahre (8 Stunden 
pro Tag; 25 Tage pro Monat).
Falls die Nutzung die normale Nutzungshäufigkeit 
überschreitet, ist die Lebensdauer ggf. 
entsprechend geringer.

Hinweis zum Batterieanschluss

Der Batteriekontakt dieses Geräts (der Anschluss 
für Akkus und Netzteile) ist ein Verbrauchsteil.
Das Gerät wird möglicherweise nicht richtig 
mit Strom versorgt, wenn die Stifte des 
Batteriekontakts durch Stöße oder Vibrationen 
verbogen oder deformiert sind, oder wenn 
sie aufgrund längerer Verwendung im Freien 
korrodiert sind.
Regelmäßige Kontrollen werden empfohlen, um 
richtige Funktion und lange Lebensdauer des 
Geräts sicherzustellen. Wenden Sie sich für weitere 
Auskünfte über Kontrollen am Gerät an Ihren 
Sony-Kundendienst oder -Händler.

Verwendungs- und Lagerort

Der Camcorder sollte waagerecht und gut belüftet 
aufbewahrt werden.
Folgende Bedingungen sind für die Verwendung 
und Lagerung des Geräts nicht geeignet.
ˎˎ Starke Hitze oder Kälte (Betriebstemperatur: 0 °C 
bis 40 °C)  
Beachten Sie, dass in heißem Klima die 
Temperatur in Fahrzeugen bei geschlossenen 

Fenstern schnell 50 °C überschreiten kann.
ˎˎ In feuchter oder staubiger Umgebung
ˎˎ Einwirkung von Regen
ˎˎ Starke Erschütterungen
ˎˎ Nähe zu starken Magnetfeldern
ˎˎ Nähe von Radio- oder TV-Übertragungsgeräten, 
die starke elektromagnetische Felder erzeugen.
ˎˎ Direkte Sonneneinstrahlung oder Nähe zu 
Heizkörpern für einen längeren Zeitraum

So verhindern Sie elektromagnetische 
Interferenzen durch tragbare 
Kommunikationsgeräte

Die Verwendung von Mobiltelefonen und 
anderen Kommunikationsgeräten in der Nähe 
des Camcorders kann zu Fehlfunktionen und 
Interferenzen mit den Audio- und Videosignalen 
führen.
Es wird empfohlen, tragbare 
Kommunikationsgeräte in der Nähe des 
Camcorders auszuschalten.

Hinweis zu Laserstrahlen

Laserstrahlen können den CMOS-Bildsensor 
beschädigen. Wenn Sie eine Szene aufnehmen, 
in der Laserstrahlen zur Anwendung kommen, 
achten Sie darauf, dass die Laserstrahlen nicht 
direkt auf das Objektiv des Geräts gerichtet sind. 
Insbesondere Laserstrahlen hoher Energie von 
medizinischen oder anderen Geräten können 
Schäden durch reflektiertes oder gestreutes Licht 
verursachen.

Informationen zu den Bildschirmen

ˎˎ Die Bildschirme dürfen nicht über längere Zeit 
dem Sonnenlicht zugewandt sein, da dies die 
Bildschirme beschädigen kann.
ˎˎ Drücken/wischen Sie die Bildschirme nicht 
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mit übermäßiger Kraft und lassen Sie keine 
Gegenstände auf Bildschirmen liegen, da dies zu 
Störungen im Bild usw. führen kann.
ˎˎ Die Bildschirme können sich während der 
Verwendung erwärmen. Dies ist keine Störung.

LCD-Anzeigen

Die LCD-Anzeige in diesem Gerät wird mit 
Hochpräzisionstechnologie hergestellt und 
erzielt so eine effektive Pixelrate von mindestens 
99,99%. Ein sehr geringer Anteil von Pixeln kann 
jedoch eventuell „hängenbleiben“, entweder 
immer aus (schwarz), immer an (rot, grün oder 
blau), oder blinkend. Außerdem können nach sehr 
langem Gebrauch diese „hängengebliebenen“ 
Pixel spontan auftreten aufgrund der äußeren 
Eigenschaften der Flüssigkristallanzeige.
Diese Probleme stellen keine Fehlfunktion dar.
Bitte beachten Sie, dass solche Probleme keinen 
Einfluss auf aufgezeichnete Daten haben.

OLED-Anzeigen

Der OLED-Bildschirm in diesem Gerät wird mit 
Hochpräzisionstechnologie hergestellt und 
erzielt so eine effektive Pixelrate von mindestens 
99,99%. Ein sehr geringer Anteil von Pixeln kann 
jedoch eventuell „hängenbleiben“, entweder 
immer aus (schwarz), immer an, oder blinkend. 
Außerdem können nach sehr langem Gebrauch 
diese „hängengebliebenen“ Pixel spontan 
auftreten aufgrund der äußeren Eigenschaften 
der organischen Leuchtdioden. Diese Probleme 
stellen keine Fehlfunktion dar. Bitte beachten 
Sie, dass solche Probleme keinen Einfluss auf 
aufgezeichnete Daten haben.
Aufgrund der Eigenschaften des Materials, das zur 
Erzeugung von Hochpräzisionsbildern im OLED-

Bildschirm eingesetzt wird, kann es zu einem 
dauerhaften Einbrennen oder einer Reduktion der 
Helligkeit kommen.
Diese Probleme stellen keine Fehlfunktion dar.

Hinweise zu Kondensation

Wenn das Gerät aus einer kalten Umgebung in 
einen warmen Raum gebracht wird oder die 
Umgebungstemperatur schnell ansteigt, kann sich 
auf der Oberfläche des Geräts bzw. im Inneren des 
Geräts Feuchtigkeit ansammeln (Kondensation). 
Schalten Sie in diesem Fall das Gerät aus, und 
warten Sie, bis die Kondensation verdunstet ist, 
ehe Sie das Gerät verwenden. Die Verwendung 
des Gerätes bei gebildetem Kondenswasser kann 
zu Beschädigungen führen.

Typischerweise bei CMOS-
Bildsensoren auftretende Phänomene

Folgende, evtl. auf den Bildern erscheinende 
Phänomene sind typisch bei CMOS 
(Complementary Metal Oxide Semiconductor)- 
Bildsensoren. Sie stellen keine Fehlfunktion dar.

Weiße Flecken

Obwohl CMOS-Bildsensoren mit 
Hochpräzisionstechnologie hergestellt werden, 
können in seltenen Fällen winzige weiße Flecken 
auf der Anzeige erscheinen, die von kosmischer 
Strahlung o. Ä. herrühren. Dies liegt an der 
generellen Beschaffenheit von CMOS-Bildsensoren 
und stellt keine Fehlfunktion dar.
Diese weißen Flecken treten vor allem in 
folgenden Fällen auf.

ˎˎ beim Betrieb unter hohen 
Umgebungstemperaturen

Treppeneffekt (Aliasing)

Bei der Aufnahme von Streifen- oder 
Linienmustern erscheinen diese möglicherweise 
treppenförmig oder flimmern.

Fokusebene

Je nach den Eigenschaften der 
Aufnahmeelemente (CMOS-Sensoren) zum 
Lesen von Videosignalen können Objekte, die 
sich schnell über den Bildschirm bewegen, leicht 
verzerrt erscheinen.

Blitzstreifen

Die Luminanz im oberen und unteren 
Bildschirmbereich kann sich ändern, wenn ein Blitz 
oder eine andere Lichtquelle schnell aufleuchtet.

Flimmern

Falls bei Licht von Gasentladungslampen 
wie Leuchtstoffröhren, Natrium- oder 
Quecksilberdampflampen aufgenommen wird, 
kann der Bildschirm flimmern, Farben können 
variieren, und horizontale Streifen können verzerrt 
erscheinen.

Hinweise zur Anzeige

ˎˎ Möglicherweise wird das Bild auf dem 
Sucherbildschirm durch Folgendes verzerrt.

–– Ändern des Videoformats
ˎˎ Wenn Sie im Sucher die Blickrichtung ändern, 
sehen Sie möglicherweise die Primärfarben 
Rot, Grün und Blau. Hierbei handelt es sich 
nicht um einen Defekt des Geräts. Diese 
Primärfarben werden grundsätzlich nicht auf 
Aufzeichnungsmedien aufgezeichnet.

Fragmentierung

Lassen sich Bilder nicht ordnungsgemäß 
aufzeichnen bzw. wiedergeben, versuchen 
Sie zunächst, das Aufzeichnungsmedium zu 
formatieren. Wird über einen längeren Zeitraum 
ein und dasselbe Medium wiederholt für 
Aufzeichnung bzw. Wiedergabe verwendet, 
werden die auf dem Medium gespeicherten 
Dateien möglicherweise fragmentiert. Dies führt 
zu Problemen beim Aufzeichnen und Abspeichern. 
Erstellen Sie in diesem Fall eine Sicherungskopie 
der auf dem Medium gespeicherten Clips und 
formatieren Sie das Medium anschließend mit der 
Funktion TC/Media > Format Media (Seite 62) 
im Menü.

Ausgangsspannungen des Geräts

Die Gesamtausgangsleistung, die 
Peripheriegeräten vom Gerät aus zur Verfügung 
gestellt werden kann, variiert je nach der 
Eingangsspannung des Geräts und dem 
Zustand der angeschlossenen Peripheriegeräte. 
Je nach den Umständen werden die 
maximalen Nennleistungen der folgenden 
Stromversorgungsanschlüsse ggf. nicht erreicht.

Anschluss LENS: max. 1 A
Anschluss 12V OUT (4-polig):

max. 0,8 A (Eingangsspannung: 22 V bis 
32 V)
max. 1 A (Eingangsspannung: 11 V bis 17 V)

Anschluss 24V OUT (3-polig):
max. 2 A (Eingangsspannung: 22 V bis 32 V)
max. 1 A (Eingangsspannung: 11 V bis 17 V)

Die Nenn-Leistungsabgabe für Zubehör (AXS-R7, 
DVF-EL200 und CBK-3610XS) und Peripheriegeräte 
ist in Abhängigkeit von der Eingangsspannung des 
Geräts begrenzt.
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Spannung der Stromversorgung des Geräts: X 
[V]
Gesamtnennleistung von Peripheriegeräten: Y 
[W]
Leistungsaufnahme des Geräts: ca. 60 W
	Leistungsaufnahme der AXS-R7: ca. 24 W
	Leistungsaufnahme der DVF-EL200: ca. 2,5 W
	Leistungsaufnahme der CBK-3610XS: ca. 

3,9 W

Y [W] = X [V] × 9,0 [A]1) – (60 +  +  + )2) [W]

Stellen Sie bei der Stromversorgung der oben 
aufgeführten angeschlossenen Zubehör- und der 
Peripheriegeräte sicher, dass der durch die obige 
Gleichung angegebene Wert Y nicht negativ wird.
(Beachten Sie, dass die Gleichung nicht gilt, 
wenn das berechnete Ergebnis Y die Summe der 
maximal zulässigen Ausgangsleistungen jedes 
Stromversorgungsanschlusses übersteigt.)
1)	 6,0 [A] bei Verwendung des AC-DN10A.
2)	 Verwenden Sie bei Nutzung eines AC-DN10A nicht 

gleichzeitig die Geräte  und . Abhängig von 
der Nutzungsumgebung können die Werte der 
Stromversorgung überschritten werden.

Sicherheitshinweise

ˎˎ SONY KANN KEINE HAFTUNG FÜR SCHÄDEN 
JEDER ART DURCH UNTERLASSENE 
GEEIGNETE SICHERHEITSMASSNAHMEN 
AN ÜBERTRAGUNGSGERÄTEN, DURCH 
UNVERMEIDBARE DATENPREISGABE AUFGRUND 
DER ÜBERTRAGUNGSSPEZIFIKATIONEN ODER 
DURCH SICHERHEITSPROBLEME JEGLICHER ART 
ÜBERNEHMEN.
ˎˎ Je nach Betriebsumgebung können unbefugte 
Dritte im Netzwerk unter Umständen auf dieses 
Gerät zugreifen. Achten Sie beim Verbinden 
des Geräts mit dem Netzwerk darauf, dass das 
Netzwerk gut abgesichert ist.
ˎˎ Vom Sicherheitsstandpunkt sollten Sie 
unbedingt über einen Webbrowser auf 

das Steuerfenster zugreifen und die 
werkseitig eingestellten Werte für die 
Zugriffseinschränkung ändern, wenn das Gerät 
mit dem Netzwerk verbunden ist (Seite 69).  
Es wird auch empfohlen, das Passwort 
regelmäßig zu ändern.
ˎˎ Rufen Sie keine andere Website im Webbrowser 
auf, während Sie Einstellungen vornehmen 
oder nachdem Sie Einstellungen vorgenommen 
haben. Da der Anmeldestatus beim 
Webbrowser gespeichert bleibt, schließen Sie 
den Webbrowser, wenn Sie die Einstellungen 
abgeschlossen haben, um zu verhindern, dass 
unautorisierte Dritte das Gerät nutzen oder 
schädliche Programm ausführen.
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Ausgangsformate am Anschluss SDI OUT

Das serielle Digitalsignal eines Anschlusses SDI OUT wird gemäß den Einstellungen der Project Kategorie und der Monitoring-Kategorie im Menü ausgegeben.
Einzelheiten zu den Kombinationen der Einstellungen in der Project-Kategorie siehe „Aufzeichnungsformateinstellungen“ (Seite 48).

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.
Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

59.94/50 6K 3:2/ 
4K 2.39:1 1)/ 
4K 4:3/ 
4K 17:9

XAVC-I 4K Class300/ 
Rec Off

4096×2160P 12G – 4096×2160P YPbPr 12G 4096×2160P YPbPr 12G Keine Ausgabe Keine Ausgabe

4096×2160P Square 
Level B

4096×2160P Square 
Level B

4096×2160P YPbPr 3G Level B-DL

4096×2160P 2SI Level 
B

4096×2160P 2SI Level 
B

4096×2160P YPbPr 3G Level B-DL

2048×1080P
1920×1080P Level B 2048×1080P  

YPbPr 3G Level B-DL
2048×1080P  

YPbPr 3G Level B-DL

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

1920×1080P Level B
1920×1080P Level B 1920×1080P  

YPbPr 3G Level B-DL
1920×1080P  

YPbPr 3G Level B-DL

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

3.8K 16:9 XAVC-I QFHD Class300/
Rec Off

3840×2160P 12G – 3840×2160P YPbPr 12G 3840×2160P YPbPr 12G Keine Ausgabe Keine Ausgabe

3840×2160P Square 
Level B

3840×2160P Square 
Level B

3840×2160P YPbPr 3G Level B-DL

3840×2160P 2SI Level 
B

3840×2160P 2SI Level 
B

3840×2160P YPbPr 3G Level B-DL

1920×1080P Level B
1920×1080P Level B 1920×1080P  

YPbPr 3G Level B-DL
1920×1080P  

YPbPr 3G Level B-DL

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

6K 3:2/ 
4K 4:3/ 
4K 17:9/ 
3.8K 16:9

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P Level B
1920×1080P Level B 1920×1080P  

YPbPr 3G Level B-DL
1920×1080P  

YPbPr 3G Level B-DL

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

MPEG 1920×1080i/ProRes 
422 HQ HD i/ 
ProRes 422 HD i/ 
ProRes 422 Proxy HD i 

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

Aufzeichnungsformate und Ausgangssignale
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Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode AXS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

47.95 4K 4:3/4K 17:9 RAW SQ/ 
X-OCN XT/ 
X-OCN ST/ 
X-OCN LT/ 
Rec Off

4096×2160P Square 
Level B

4096×2160P Square 
Level B

4096×2160P YPbPr 3G Level B

4096×2160P 2SI Level 
B

4096×2160P 2SI Level 
B

4096×2160P YPbPr 3G Level B

2048×1080P Level B 1920×1080P 2048×1080P YPbPr 3G Level B 1920×1080P YPbPr 1.5G

1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P YPbPr 1.5G

Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

29.97/25 6K 1.85:1/ 
6K 2.39:1/ 
6K 3:2/ 
6K 17:9/ 
5.7K 16:9/ 
4K 2.39:1 1)/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off

4096×2160P 6G – 4096×2160P YPbPr 6G 4096×2160P YPbPr 6G Keine Ausgabe Keine Ausgabe

4096×2160P 2SI – 4096×2160P YPbPr 3G Level B-DS Keine Ausgabe Keine Ausgabe

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G

2048×1080PsF
1920×1080P

2048×1080PsF 
YPbPr 1.5G

2048×1080PsF 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

3.8K 16:9 XAVC-I QFHD Class480/
XAVC-I QFHD Class300/
Rec Off

3840×2160P 6G – 3840×2160P YPbPr 6G 3840×2160P YPbPr 6G Keine Ausgabe Keine Ausgabe

3840×2160P 2SI – 3840×2160P YPbPr 3G Level B-DS Keine Ausgabe Keine Ausgabe

3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

6K 1.85:1/ 
6K 2.39:1/ 
6K 3:2/ 
6K 17:9/ 
5.7K 16:9/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920×1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
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Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

24 6K 1.85:1/ 
6K 2.39:1/ 
6K 3:2/ 
6K 17:9/ 
4K 2.39:1 1)/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off

4096×2160P 6G – 4096×2160P YPbPr 6G 4096×2160P YPbPr 6G Keine Ausgabe Keine Ausgabe

4096×2160P 2SI – 4096×2160P YPbPr 3G Level B-DS Keine Ausgabe Keine Ausgabe

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G

2048×1080P 1920×1080P
2048×1080PsF 

YPbPr 1.5G
2048×1080PsF 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P
1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P  
YPbPr 1.5G 1920×1080P 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P
1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G 1920×1080P 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

3.8K 16:9 Rec Off 3840×2160P 6G – 3840×2160P YPbPr 6G 3840×2160P YPbPr 6G Keine Ausgabe Keine Ausgabe

3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 1.5G

3840×2160P 2SI –
3840×2160P 

 YPbPr 3G Level-B
3840×2160P  

YPbPr 3G Level-B
Keine Ausgabe Keine Ausgabe

1920×1080P

1920×1080P

1920×1080P YPbPr 1.5G 1920×1080P YPbPr 1.5G

1920×1080P YPbPr 1.5G 1920×1080P YPbPr 1.5G
1920×1080PsF

1920×1080PsF  
YPbPr 1.5G

1920×1080PsF  
YPbPr 1.5G
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Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

23.98 6K 1.85:1/ 
6K 2.39:1/ 
6K 3:2/ 
6K 17:9/ 
5.7K 16:9/ 
4K 2.39:1 1)/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off

4096×2160P 6G – 4096×2160P YPbPr 6G 4096×2160P YPbPr 6G Keine Ausgabe Keine Ausgabe

4096×2160P 2SI – 4096×2160P YPbPr 3G Level B-DS Keine Ausgabe Keine Ausgabe

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G

2048×1080P –
2048×1080PsF 

YPbPr 1.5G
2048×1080PsF 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P
1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G 1920×1080P 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

3.8K 16:9 XAVC-I QFHD Class480/
XAVC-I QFHD Class300/ 
Rec Off

3840×2160P 6G – 3840×2160P YPbPr 6G 3840×2160P YPbPr 6G Keine Ausgabe Keine Ausgabe

3840×2160P 2SI – 3840×2160P YPbPr 3G Level B-DS Keine Ausgabe Keine Ausgabe

3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 1.5G

1920×1080P
1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G 1920×1080P 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

6K 1.85:1/ 
6K 2.39:1/ 
6K 3:2/ 
6K 17:9/ 
5.7K 16:9/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920×1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P

1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

1)	 SxS Rec Format wird auf Rec Off eingestellt, wenn Imager Mode auf 4K 2.39:1 eingestellt wird.
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Ausgangsformate an den Anschlüssen MONITOR OUT/HDMI OUT

Das Digitalsignal von den Anschlüssen MONITOR OUT und HDMI OUT wird gemäß den Einstellungen der Project- und Monitoring-Kategorie im Menü ausgegeben.
Einzelheiten zu den Kombinationen der Einstellungen in der Project-Kategorie siehe „Aufzeichnungsformateinstellungen“ (Seite 48).

Die Voreinstellungswerte sind unterstrichen und in Fettdruck.
Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

59.94/50 6K 3:2/ 
4K 2.39:1/ 
4K 4:3/ 
4K 17:9

XAVC-I 4K Class300/ 
Rec Off

4096×2160P 12G –

1920×1080P Level A 
4096×2160P

1920×1080P YPbPr 3G Level A
4096×2160P

1920×1080P 1920×1080P

1920×1080i
4096×2160P

1920×1080i YPbPr 1.5G
4096×2160P

1920×1080i 1920×1080i 

4096×2160P 2SI 4096×2160P 2SI

1920×1080P Level A
4096×2160P

1920×1080P YPbPr 3G Level A
4096×2160P

1920×1080P 1920×1080P

1920×1080i
4096×2160P

1920×1080i YPbPr 1.5G
4096×2160P

1920×1080i 1920×1080i

4096×2160P Square 4096×2160P Square
1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i 

2048×1080P
1920×1080P Level B 1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P

1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

1920×1080P
1920×1080P Level B 1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P

1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i
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Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

3.8K 16:9 XAVC-I QFHD Class300/
Rec Off

3840×2160P 12G –

1920×1080P Level A
3840×2160P

1920×1080P YPbPr 3G Level A
3840×2160P

1920×1080P 1920×1080P

1920×1080i
3840×2160P

1920×1080i YPbPr 1.5G
3840×2160P

1920×1080i 1920×1080i 

3840×2160P 2SI 3840×2160P 2SI

1920×1080P Level A
3840×2160P

1920×1080P YPbPr 3G Level A
3840×2160P

1920×1080P 1920×1080P

1920×1080i
3840×2160P

1920×1080i YPbPr 1.5G
3840×2160P

1920×1080i 1920×1080i

3840×2160P Square 3840×2160P Square
1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i 

1920×1080P
1920×1080P Level B 1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P

1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

6K 3:2/ 
4K 2.39:1/ 
4K 4:3/ 
4K 17:9/ 
3.8K 16:9

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P
1920×1080P Level B 1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P

1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

ProRes 422 HQ HD i/
ProRes 422 HD i/
ProRes 422 Proxy HD i 

1920×1080i 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

MPEG 1920×1080i 

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

–
720×480P 1) 2) Keine Ausgabe 720×480P

720×576P 1) 3) Keine Ausgabe 720×576P

Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode AXS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

47.95 4K 4:3/4K 17:9 RAW SQ/ 
X-OCN XT/ 
X-OCN ST/ 
X-OCN LT/ 
Rec Off

4096×2160P Square Level B 4096×2160P Square Level B 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

4096×2160P 2SI Level B 4096×2160P 2SI Level B

2048×1080P 1920×1080P

1920×1080P 1920×1080P
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Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

29.97/25 6K 1.85:1/ 
6K 2.39:1/ 
6K 3:2/ 
6K 17:9/ 
5.7K 16:9/ 
4K 2.39:1/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off 4096×2160P 6G –

1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

1920×1080PsF
4096×2160P 

1920×1080PsF YPbPr 1.5G
4096×2160P

1920×1080PsF 1920×1080PsF

4096×2160P 2SI –

1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

1920×1080PsF
4096×2160P

1920×1080PsF YPbPr 1.5G
4096×2160P

1920×1080PsF 1920×1080PsF

4096×2160P Square 4096×2160P Square
1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

2048×1080PsF
1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

1920×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

3.8K 16:9 XAVC-I QFHD Class480/
XAVC-I QFHD Class300/
Rec Off 3840×2160P 6G –

1920×1080P
3840×2160P

1920×1080P YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

1920×1080PsF
3840×2160P

1920×1080PsF YPbPr 1.5G
3840×2160P

1920×1080PsF 1920×1080PsF

3840×2160P 2SI –

1920×1080P
3840×2160P

1920×1080P YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

1920×1080PsF
3840×2160P

1920×1080PsF YPbPr 1.5G
3840×2160P

1920×1080PsF 1920×1080PsF

3840×2160P Square 3840×2160P Square
1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

1920×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

6K 1.85:1/ 
6K 2.39:1/ 
6K 3:2/ 
6K 17:9/ 
5.7K 16:9/ 
4K 2.39:1/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920×1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF
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Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

24 6K 1.85:1/ 
6K 2.39:1/ 
6K 3:2/ 
6K 17:9/ 
4K 2.39:1/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off

4096×2160P 6G – 1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080 1920×1080P

4096×2160P 2SI – 1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

4096×2160P Square 4096×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

2048×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080P
1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P
1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF

3.8K 16:9 Rec Off
3840×2160P 6G – 1920×1080P

3840×2160P
1920×1080PsF YPbPr 1.5G

3840×2160P

1920×1080P 1920×1080PsF

3840×2160P Square 3840×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

3840×2160P 2SI – 1920×1080P
3840×2160P

1920×1080P YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

1920×1080P
1920×1080P 1920×1080PsF 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF
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Project Monitoring > Output Format Ausgangsformat

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

23.98 6K 1.85:1/ 
6K 2.39:1/ 
6K 3:2/ 
6K 17:9/ 
5.7K 16:9/ 
4K 2.39:1/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off

4096×2160P 6G – 1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

4096×2160P 2SI – 1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

4096×2160P Square 4096×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

2048×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080P
1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF

3.8K 16:9 XAVC-I QFHD Class480/
XAVC-I QFHD Class300/
Rec Off

3840×2160P 6G – 1920×1080P
3840×2160P

1920×1080 YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

3840×2160P 2SI – 1920×1080P
3840×2160P

1920×1080P YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

3840×2160P Square 3840×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080P
1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF

6K 1.85:1/ 
6K 2.39:1/ 
6K 3:2/ 
6K 17:9/ 
5.7K 16:9/ 
4K 2.39:1/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920×1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF

1)	 Wenn für AXS Rec Format die Einstellung Rec Off festgelegt wurde, wird dieser Ausgang ausgewählt, wenn Technical > System Configuration > SD HDMI im Menü auf On gesetzt wird.
2)	 Wenn Project Frame Rate den Wert 59.94 besitzt.
3)	 Wenn Project Frame Rate den Wert 50.0 besitzt.
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Fehler-/Warnanzeigen
Falls am Gerät eine Warnung, eine Vorsichtsmeldung oder ein Betriebszustand auftritt, wozu eine 
Bestätigung erforderlich ist, wird auf dem Subdisplay eine Meldung angezeigt, die Leuchte REC blinkt, 
und es wird ein Warnton ausgegeben.
Der Warnton wird über den integrierten Lautsprecher oder den an die Kopfhörerbuchse angeschlossenen 
Kopfhörer ausgegeben.
Beim Einschalten des Geräts erscheint eine Meldung zum Durchführen der APR-Funktion auf dem 
Subdisplay-Bildschirm, wenn seit einer bestimmten Zeit keine automatische Einstellung des Bildsensors 
(APR) mehr durchgeführt wurde. Gehen Sie in diesem Fall nach den auf dem Bildschirm angezeigten 
Anweisungen vor, um APR auszuführen (Seite 70).

Fehleranzeige

Wenn die folgende Art Anzeige auftritt, stellt das Gerät seinen Betrieb ein.
Fehleranzeigen Summer REC-Leuchte Ursache und Maßnahmen

E + Error code Zeitweilig Schnell 
blinkend

Das Gerät ist möglicherweise defekt. Die 
Aufzeichnung wird angehalten, obwohl REC im 
Sucher bzw. auf dem Monitorbildschirm angezeigt 
wird.
Schalten Sie das Gerät aus und prüfen Sie die 
angeschlossenen Geräte, Kabel und Datenträger. Falls 
der Fehler nach erneutem Einschalten des Geräts 
weiterhin auftritt, wenden Sie sich an das Sony-
Servicepersonal. (Wenn die Spannungsversorgung 
durch Schalten des Netzschalters in Stellung OFF nicht 
ausgeschaltet werden kann, entfernen Sie den Akku, 
oder trennen Sie die an DC IN angeschlossene 
Spannungsquelle.)

Warnanzeige

Wenn eine der folgenden Meldungen auftritt, gehen Sie zur Lösung des Problems nach der folgenden 
Tabelle vor.
Warnanzeigen Summer  REC-Leuchte Ursache und Maßnahmen

Media Full 1) Kontinuier-
lich

Schnell 
blinkend

Aufzeichnen, Kopieren und Teilen von Clips ist nicht 
möglich, weil auf der SxS-Speicherkarte kein freier 
Speicherplatz mehr vorhanden ist.
Tauschen Sie diese umgehend aus.

Warnanzeigen Summer  REC-Leuchte Ursache und Maßnahmen

Battery End 1) Kontinuier-
lich

Schnell 
blinkend

Der Akku ist entladen. Aufzeichnen ist nicht möglich.
Halten Sie den Camcorder an, und laden Sie den Akku 
auf.

Temperature High 1) Zeitweilig Blinkt Die Innentemperatur ist hoch.
Schalten Sie das Gerät aus, und lassen Sie es abkühlen, 
bevor Sie es erneut betreiben.

Insufficient Voltage 1) Kontinuier-
lich

Schnell 
blinkend

Die DC IN-Spannung ist zu niedrig. Aufzeichnen ist 
nicht möglich.
Schließen Sie eine weitere Spannungsquelle an.

EXT. I/F Signal Error Zeitweilig Schnell 
blinkend

Am Anschluss für ein Erweiterungsgerät wurde ein 
Signalfehler erkannt.
Prüfen Sie die Verbindung zum AXS-R7 oder anderen 
Gerät.

AXS Firmware 
Mismatch

Kontinuier-
lich

Schnell 
blinkend

Der AXS-R7 kann nicht ordnungsgemäß betrieben 
werden.
Aktualisieren Sie die Firmwareversion des AXS-R7.

AXS Recorder Temp. 
High 1)

Zeitweilig Schnell 
blinkend

Die Innentemperatur des AXS-R7 ist hoch.
Schalten Sie das Gerät aus, und lassen Sie es abkühlen, 
bevor Sie es erneut betreiben.

Lens Signal Error – – Am Anschluss für ein Erweiterungsgerät wurde ein 
Signalfehler erkannt.
Prüfen Sie die Verbindung zum Objektiv oder anderen 
Gerät.

1)	 Meldung wird nicht auf dem Monitorbildschirm angezeigt.

Informationen zu Temperaturwarnungen

Beim Betrieb des Geräts innerhalb des garantierten Betriebstemperaturbereichs des Geräts können je 
nach Betriebsmodus und Verwendungsumgebung die Warnungen Temperature High und AXS Recorder 
Temp High angezeigt werden. Die Aufnahme wird nicht sofort gestoppt, wenn diese Meldungen 
angezeigt werden, aber die Vorschläge in der Spalte Ursache und Maßnahmen der Tabelle sollten 
umgehend umgesetzt werden.
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Bestätigungsanzeige für Warn- und Betriebsmeldungen

Die folgenden Warn- und Betriebsmeldungen können auf dem Monitorbildschirm oder dem Subdisplay 
angezeigt werden. Warnsymbole und Meldungen können unter der Info-Kategorie > Camera Condition 
im Menü angezeigt werden. Gehen Sie nach den gegebenen Anweisungen vor, um das Problem zu lösen.
Anzeige Ursache und Maßnahmen

Battery Error
Please Change Battery

Es wurde ein Fehler im Akku festgestellt.
Ersetzen Sie den Akku durch einen neuen.

Backup Battery End
Please Change

Die verbleibende Kapazität der Pufferbatterie reicht 
nicht aus.
Ersetzen Sie die Pufferbatterie.

Cannot Use SxS(A)*
Please Change

Eine partitionierte Speicherkarte oder eine, die eine 
höhere Anzahl aufgezeichneter Clips enthält, als 
dieses Gerät verarbeiten kann, ist eingelegt.
Diese Karte kann nicht im Gerät benutzt werden und 
muss ersetzt werden.

Cannot Use SxS(A)*
Unsupported File System

Es wurde eine Karte mit einem anderen Dateisystem 
oder eine unformatierte Karte eingelegt.
Diese Karte kann nicht im Gerät benutzt werden und 
muss ersetzt oder mit dem Gerät formatiert werden.

Media Error
SxS(A)* Needs to be Restored

An der Speicherkarte ist ein Fehler aufgetreten. Die 
Karte muss wiederhergestellt werden.
Stellen Sie die Karte wieder her.

SxS(A)* Error
Recording Stopped
Playback Stopped

Die Aufnahme oder Wiedergabe stoppte, weil an der 
Speicherkarte ein Fehler aufgetreten ist.
Wenn das Problem dauerhaft besteht, wechseln Sie 
die Speicherkarte.

Input AES/EBU is Invalid Emphasis Ein mit dem AES/EBU-Eingang nicht kompatibles 
Verstärkungssignal wurde eingespeist.
Das Gerät ist ausschließlich mit 50u-15u-Verstärkung 
kompatibel.

Input AES/EBU is not Pro Use Am AES/EBU-Eingang wurde ein Signal eingespeist, 
das nicht dem Format für den professionellen 
Gebrauch entspricht.
Das Gerät ist ausschließlich mit Signalen kompatibel, 
die dem Format für den professionellen Gebrauch 
entsprechen.

Fan Stopped Das Gebläse des Geräts läuft nicht mehr.
Vermeiden Sie es, das Gerät bei hohen Temperaturen 
zu verwenden. Schalten Sie das Gerät aus und 
wenden Sie sich an einen Sony-
Kundendienstmitarbeiter.

Anzeige Ursache und Maßnahmen

AXS Recorder Fan Stopped Das Gebläse des an das Gerät angeschlossenen 
AXS-R7 läuft nicht mehr.
Vermeiden Sie es, das Gerät bei hohen Temperaturen 
zu verwenden. Nehmen Sie den AXS-R7 vom Gerät ab 
und wenden Sie sich an einen Sony-
Kundendienstmitarbeiter.

Unsupported FPS
Change AXS(A) to AXS S48 Memory

Ein nicht unterstützter AXS-Speicher wurde erkannt.
Aufzeichnen ist nicht möglich. Ändern Sie das 
Aufnahmeformat für die AXS-Speicherkarte oder 
verwenden Sie eine Karte AXS-A512S48 oder AXS-
A1TS48.

Abnormal Lens Communication
Please Check “Lens IF” Setting

Der Typ des angeschlossenen Objektivs stimmt nicht 
mit der Einstellung am Gerät überein.
Prüfen Sie im vollständigen Menü die Einstellung 
Technical > Lens Configuration > PL-Mt Interface 
Position.

Please Execute APR Die Funktion zur automatischen Einstellung des 
Bildsensors (APR) wurde seit einer bestimmten Zeit 
nicht ausgeführt.
Drücken Sie den Regler MENU, um APR auszuführen.

XXXX License Y days Remaining 
(XXXX: Lizenzart, Y: Anzahl verbleibender Tage)

Es verbleiben zwei Tage, bis die Lizenz für die 
Softwareoption abläuft.

Lens I/F Error Bei einem angebrachten Objektiv mit E-Fassung 
wurde bei der Kommunikation über die 
Objektivschnittstelle ein Fehler diagnostiziert.
Prüfen Sie die Verbindung zum Objektiv mit 
E-Fassung.

*	 „SxS(B)“ wird für die SxS-Speicherkarte in Einschub B angezeigt, „AXS(A)“ wird für die AXS-Speicherkarte in Einschub A des 
AXS-R7 angezeigt und „AXS(B)“ für die AXS-Speicherkarte in Einschub B des AXS-R7.
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In Dateien gespeicherte Optionen
Tabellenerklärung
Ja: wird gespeichert
Nein: wird nicht gespeichert
–: Nicht gespeichert (temporäre Einstellung)

Shooting-Menü

Option Unteroption Dateityp

All

FPS Fixed/Variable Select Ja

FPS Select Ja

Shutter 1) Shutter Select Ja

Step/Cont. Select Ja

Add/Change Step Ja

Delete Step Ja

ND ND Position Ja

Exposure Index EI Select Ja

White Balance 1) Color Temp. Select Ja

Add/Change Step Ja

Delete Step Ja

Auto White Balance –

LUT Select SDI 1/2 Ja

SDI 3/4 Ja

Monitor Ja

HDMI Ja

VF LUT Ja

SxS Rec Ja

Sub Rec Ja

Look Category Ja

Preset Look Select Ja

User 3D LUT Select Ja

ASC CDL Process Ja

ASC CDL Select Ja

ASC CDL Information –

Option Unteroption Dateityp

All

Look File Load User 3D LUT –

Reset User 3D LUT –

Reset All User 3D LUTs –

Load ASC CDL –

Reset ASC CDL –

Reset All ASC CDLs –

1)	 Es werden auch von Benutzern hinzugefügte oder bearbeitete Auswahloptionen gespeichert.
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Project-Menü

Option Unteroption Dateityp

All

Basic Setting Imager Mode Ja

Project Frame Rate Ja

Input Color Space Ja

AXS Rec Format Ja

SxS Rec Format Ja

Sub Rec Format Ja

Base ISO Ja

SxS/Output De-Squeeze Nein

Special Recording Cache Rec Select Ja

Max Cache Rec Duration Ja

Assignable Button <1> Ja

<2> Ja

<3> Ja

<4> Ja

<VF A> Ja

<VF B> Ja

<VF C> Ja

<User 1> Ja

<User 2> Ja

<User 3> Ja

<User 4> Ja

<User 5> Ja

All File Load SD Card –

Save SD Card –

File ID Ja

Format SD Card –

TC/Media-Menü

Option Unteroption Dateityp

All

Timecode Mode Ja

Manual Setting –

Reset –

TC Format Ja

TC Source –

Time Data Display Ja

Clip Name Format Camera ID Ja

Reel Number Ja

Camera Position Ja

SxS Root Folder Name Ja

Format Media AXS Slot A –

AXS Slot B –

SxS Slot A –

SxS Slot B –

SD Card –

Update Media AXS Slot A –

AXS Slot B –

SxS Slot A –

SxS Slot B –
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Monitoring-Menü

Option Unteroption Dateityp

All

Output Format SDI 1/2 Ja

SDI 3/4 Ja

Monitor Ja

HDMI Ja

OSD Appearance VF Ja

SDI
SDI 1/2
SDI 3/4

Ja

Monitor Ja

HDMI –

Status Info A/B Setup Ja

Frame Line A/B Setup Ja

Monitor Display Focus Distance Format Ja

Frame Line Center Marker Ja

Aspect Ratio Ja

Aspect Safety Zone Ja

Safety Zone Ja

Color Ja

Surround View Type Ja

Aspect Ratio Type Ja

Mask Level Ja

Frame Line on Playback Ja

User Frame Line Width Ja

Height Ja

H Position Ja

V Position Ja

Option Unteroption Dateityp

All
False Color Level Ja

Red Ja
Red Upper Limit Ja
Red Lower Limit Ja
Yellow Ja
Yellow Upper Limit Ja
Yellow Lower Limit Ja
Orange Ja
Orange Upper Limit Ja
Orange Lower Limit Ja
Pink Ja
Pink Upper Limit Ja
Pink Lower Limit Ja
Light Pink Ja
Light Pink Upper Limit Ja
Light Pink Lower Limit Ja
Cyan Ja
Cyan Upper Limit Ja
Cyan Lower Limit Ja
Green Ja
Green Upper Limit Ja
Green Lower Limit Ja
Light Blue Ja
Light Blue Upper Limit Ja
Light Blue Lower Limit Ja
Blue Ja
Blue Upper Limit Ja
Blue Lower Limit Ja
Purple Ja
Purple Upper Limit Ja
Purple Lower Limit Ja
Reset –

VF Display VF LUT Ja
Status Info Ja
Frame Line Ja
VF Magnifier Ratio Ja
Color Ja
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Option Unteroption Dateityp

All

VF Function Double Speed Scan Ja

Peaking Frequency Ja

Zebra Ja

Zebra Select Ja

Zebra1 Level Ja

Zebra1 Aperture Level Ja

Zebra2 Level Ja

Assign<VF A> Ja

Assign<VF B> Ja

Assign<VF C> Ja

Audio-Menü

Option Unteroption Dateityp

All

Audio Input CH-1 Audio Select Ja

CH-2 Audio Select Ja

CH-1 Audio Level Ja

CH-2 Audio Level Ja

MIC Reference Ja

Audio Monitor Monitor CH Ja

Monitor Level Ja

Audio Configuration Alarm Level Ja

Input Limiter Mode Ja

AGC Level Ja

AGC Mono/Stereo Ja

MIC Input Mono/Stereo Ja

Phantom Power +48V Ja

Monitor Output CH Pair Ja

Headphone Mono/ST Ja
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Technical-Menü

Option Unteroption Dateityp

All

Test Signals Color Bars Ja

Color Bars Type Ja

1kHz Tone on Color Bars Ja

Test Saw Ja

Switch & Rec Light Lock Operator Side Ja

Lock Assistant Side Ja

Rec Light Ja

Rec Start/Stop Beep Ja

System Configuration Fan Control Ja

RM/RCP Paint Control Ja

SDI Rec Remote Trigger Ja

SD HDMI Ja

Shutter Mode Ja

Special Configuration Flip Image Ja

NR(4K 17:9/16:9 AXS) Ja

Lens Configuration PL-Mt Interface Position Ja

Lens 12pin Ja

E-Mount Shading Comp. Ja

E-Mt Chro. Aber. Comp. Ja

Authentication User Name Nein

Password Nein

Network Setting Ja

LAN Ja

Wireless Ja 1)

APR APR –

Reset –

Battery Near End:Info Battery Ja

End:Info Battery Ja

Near End:Sony Battery Ja

End:Sony Battery Ja

Near End:Other Battery Ja

End:Other Battery Ja

Detected Battery –

Option Unteroption Dateityp

All

DC Voltage Alarm DC Low Voltage1 Ja

DC Low Voltage2 Ja

DC(24V) Low Voltage1 Ja

DC(24V) Low Voltage2 Ja

Control Display Brightness level Ja

Genlock Input Source Ja

Reference Lock Type –

1) Die folgenden Elemente werden nicht gespeichert.
ˎˎ Scan Networks
ˎˎ SSID
ˎˎ Password
ˎˎ WPS
ˎˎ MAC Address
ˎˎ Regenerate Password
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Maintenance-Menü

Option Unteroption Dateityp

All

Clock Set Time Zone Ja

Date Mode Ja

Date –

Time –

Language Select Ja

Hours Meter Camera(System) –

R7 Recorder(System) –

Camera(Resettable) –

R7 Recorder(Resettable) –

Reset-Cam(Resettable) –

Reset-R7(Resettable) –

Reset to Default Reset –

License Options Install: xxx –

Anamorphic –

Full-Frame –

High Frame Rate –

Unique Device ID –

Firmware Camera –

AXS –

FW Update-camera –

FW Update-AXS-R7 –

[Hinweis]
Wenn im vollständigen Menü Technical > System Configuration > RM/RCP Paint Control (Seite 68) auf On eingestellt ist, 
werden die folgenden Fernbedienungselemente (Seite 88) auch in einer All-Einstellungsdatei gespeichert.
ˎˎ Black
ˎˎ Flare
ˎˎ Gamma 1)

ˎˎ Black Gamma 1)

ˎˎ Gain

1)	 Ausgenommen bei Einstellung auf S-Log3.
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Lizenzen
MPEG-4 Visual Patent Portfolio Lizenz

DIESES PRODUKT IST IM RAHMEN DER MPEG-4 
VISUAL PATENT PORTFOLIO LIZENZ LIZENZIERT. 
FÜR PERSÖNLICHE UND NICHT-KOMMERZIELLE 
ANWENDUNG DURCH EINEN VERBRAUCHER FÜR

(i) CODIERUNG VON VIDEODATEN IN 
ÜBEREINSTIMMUNG MIT DEM MPEG-4 VISUAL 
STANDARD („MPEG-4 VIDEO“) UND/ODER
(ii) DECODIERUNG VON MPEG-4 VIDEO, DAS VON 
EINEM ANWENDER ALS PERSÖNLICHEN UND 
NICHT-KOMMERZIELLE HANDLUNG CODIERT 
WURDE UND/ODER VON EINEM VIDEOANBIETER 
ERHALTEN WURDE, DER VON MPEG LA ZUR 
LIEFERUNG VON MPEG-4 VIDEO LIZENZIERT IST.

ES WIRD WEDER AUSDRÜCKLICH NOCH IMPLIZIT 
EINE LIZENZ FÜR ANDERE EINSATZZWECKE 
GEWÄHRT. WEITERE INFORMATIONEN, 
EINSCHLIESSLICH INFORMATIONEN ZUR 
VERKAUFSFÖRDERNDEN, INTERNEN UND 
GESCHÄFTLICHEN NUTZUNG UND LIZENSIERUNG 
ERHALTEN SIE VON MPEG LA, LLC. SIEHE HTTP://
WWW.MPEGLA.COM

MPEG LA bietet Lizenzen für (i) Herstellung / 
Vertrieb von allen Speichermedien, die MPEG-
4 Visual Video-Informationen enthalten (ii) 
Vertrieb / Verbreitung von MPEG-4 Visual Video-
Informationen in jeder Art und Weise (wie z. B. 
Online-Videovertriebsdienstleistungen, Internet-
Rundfunk, TV-Ausstrahlung).
Für andere Verwendungen dieses Produkts kann 
es erforderlich sein, die Lizenz von MPEGLA 
zu erlangen. Bitte wenden Sie sich für weitere 
Informationen an MPEG LA. MPEG LA. L.L.C., 250 
STEELE STREET, SUITE 300, DENVER, COLORADO 
80206
http://www.mpegla.com

MPEG-4 AVC Patent Portfolio Lizenz

DIESES PRODUKT IST LIZENSIERT IM RAHMEN 
DER AVC PATENT PORTFOLIOLIZENZ FÜR DEN 
PERSÖNLICHEN GEBRAUCH EINES VERBRAUCHERS 
ODER SONSTIGE ZWECKE, FÜR DIE KEINE 
VERGÜTUNG GEZAHLT WIRD

(i) KODIEREN VON VIDEODATEN ENTSPRECHEND 
DEM STANDARD („AVC VIDEO“) UND/ODER
(ii) DEKODIEREN VON AVC-VIDEODATEN, DIE 
VON EINEM VERBRAUCHER ZUM PERSÖNLICHEN 
GEBRAUCH KODIERT UND/ODER VON EINEM 
ZUM ANGEBOT VON AVC VIDEO ERMÄCHTIGTEN 
VIDEOANBIETER ERHALTEN WURDEN.

FÜR JEGLICHE ANDERE VERWENDUNG WIRD KEINE 
LIZENZ ERTEILT, DIES WEDER AUSDRÜCKLICH 
NOCH IMPLIZIT. WEITERE INFORMATIONEN 
ERHALTEN SIE VON MPEG LA, L.L.C. SIEHE HTTP://
WWW.MPEGLA.COM

Zugriff auf Software, für welche die 
GPL/LGPL gilt

Dieses Produkt verwendet Software, für die die 
GPL/LGPL gilt. Dies bedeutet, dass Sie berechtigt 
sind, auf Quellcode für diese Softwareprogramme 
unter den Bedingungen von GPL/LGPL 
zuzugreifen, ihn zu modifizieren und zu verbreiten.
Der Quellcode ist im Internet verfügbar. 
Verwenden Sie die folgende URL und befolgen Sie 
die Anweisungen zum Herunterladen.
http://www.sony.net/Products/Linux/common/
search.html

Bitte sehen Sie nach Möglichkeit davon ab, sich 
bezüglich des Inhalts des Quellcodes mit uns in 
Verbindung zu setzen.

Bezüglich des Inhalts dieser Lizenzen verbinden 
Sie das Gerät mit einem Netzwerk und rufen Sie 
den Bildschirm OSS Information (Seite 82) auf 
dem Bildschirm der Web-Fernbedienung auf.

Lizenzen für freie Software

Auf der Grundlage von Lizenzverträgen zwischen 
Sony und den Software-Rechteinhabern 
verwendet dieses Produkt freie Software.
Um den Anforderungen der Software-
Rechteinhaber gerecht zu werden, ist Sony 
verpflichtet, Sie über den Inhalt dieser Lizenzen 
informieren.
Bezüglich des Inhalts dieser Lizenzen verbinden 
Sie das Gerät mit einem Netzwerk und rufen Sie 
den Bildschirm OSS Information (Seite 82) auf 
dem Bildschirm der Web-Fernbedienung auf.
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Spezifikationen
Allgemeines

Gewicht	 ca. 3,9 kg (ohne Griff, Sucheraufsatz, 
untere Abdeckung)

Abmessungen
		  Siehe Seite 117.
Spannungsversorgung
		  12 V (11 V bis 17 V) Gleichspannung
		  24 V (22 V bis 32 V) Gleichspannung
Leistungsaufnahme
		  ca. 60 W (bei Aufzeichnung mit XAVC)
Betriebstemperatur
		  0 °C bis 40 °C
Lagertemperatur
		  –20 °C bis +60 °C
Durchgehende Betriebszeit
		  ca. 60 Minuten (mit BP-FLX75)
Aufzeichnungsformat (Video)
	 X-OCN XT (wenn der AXS-R7 angeschlossen 

ist)
	 RAW SQ (4K 17:9, 3.8K 16:9) (wenn der AXS-R7 

angeschlossen ist)
	 X-OCN ST (wenn der AXS-R7 angeschlossen ist)
	 X-OCN LT (wenn der AXS-R7 angeschlossen ist)
	 XAVC-I Class480 (4K, QFHD)
	 XAVC-I Class300 (4K, QFHD)
	 MPEG HD422 (HD)
	 Apple ProRes 422 HQ (HD)
	 Apple ProRes 422 (HD)
	 Apple ProRes 422 Proxy (HD)
Aufzeichnungsformat (Audio)
	 LPCM 8CH (Aufnahme/Wiedergabe mit 

2 Kanälen), 24 Bit, 48 kHz
Aufzeichnungs-Projektbildrate
	 RAW SQ (wenn der AXS-R7 angeschlossen ist):
		  4K 17:9/3.8K 16:9
			   59.94P/50P/29.97P/25P/24P/ 

23.98P
	 X-OCN (wenn der AXS-R7 angeschlossen ist):
		  6K 3:2
			   25P/24P/23.98P
		  6K 17:9/6K 1.85:1/6K 2.39:1/5.7K 

16:9/4K 6:5/4K 17:9 Surround 

View/4K 4:3/4K 4:3 Surround 
View/3.8K 16:9 Surround View

			   29.97P/25P/24P/23.98P
		  4K 17:9/4K 2.39:1/3.8K 16:9
			   59.94P/50P/29.97P/25P/24P/ 

23.98P
		  4K 4:3/4K 17:9
			   47.95P
	 XAVC-I Class480:
		  4K: 4096×2160
			   29.97P/25P/24P/23.98P
		  QFHD: 3840×2160
			   29.97P/25P/ 23.98P
	 XAVC-I Class300:
		  4K: 4096×2160
			   59.94P/50P/29.97P/25P/24P/ 

23.98P
		  QFHD: 3840×2160
			   59.94P/50P/29.97P/25P/23.98P
	 MPEG HD422 (50Mbit/s):
		  HD: 1920×1080
			   29.97P/25P/23.98P/59.94i/50i
	 Apple ProRes 422 HQ:
		  HD: 1920×1080
			   23.98P/24P/25P/29.97P/50i/59.94i/

50P/59.94P
	 Apple ProRes 422:
		  HD: 1920×1080
			   23.98P/24P/25P/29.97P/50i/59.94i/

50P/59.94P
	 Apple ProRes 422 Proxy (HD)
		  HD: 1920×1080
			   23.98P/24P/25P/29.97P/50i/59.94i/

50P/59.94P
Aufzeichnungs-/Wiedergabezeit
	 XAVC-I Class480 23.98P
		  ca. 34 Minuten bei Verwendung von  

SBP-128B/C/D
	 XAVC-I Class300 23.98P
		  ca. 54 Minuten bei Verwendung von  

SBP-128B/C/D
	 MPEG2 HD422
		  ca. 108 Minuten bei Verwendung von  

SBS-64G1A/B

	 Apple ProRes 422 HQ (HD) 23.98P
		  ca. 33 Minuten bei Verwendung von  

SBP-64A/B/C/D/E
	 Apple ProRes 422 (HD) 23.98P
		  ca. 49 Minuten bei Verwendung von  

SBP-64A/B/C/D/E
	 Apple ProRes 422 Proxy (HD) 23.98P
		  ca. 145 Minuten bei Verwendung von  

SBS-64G1A/B/C
[Hinweise]
ˎˎ Die Aufzeichnungs- und Wiedergabezeiten gelten 

für eine kontinuierliche Aufnahme als ein einziger 
Clip. Die tatsächlichen Zeiten können je nach 
Anzahl der aufgezeichneten Clips kürzer ausfallen. 
Die Aufzeichnungs-/Wiedergabezeit kann je nach 
Verwendungsbedingungen und Speichercharakteristik 
variieren.
ˎˎ 	Aufzeichnung mit 6K 3:2 50P/59.94P und 4K 4:3 

50P/59.94P X-OCN werden unterstützt, jedoch wird die 
Wiedergabe auf dem Gerät nicht unterstützt.

Kamera

Bildgebungsvorrichtung
		  Einzelchip-CMOS-Bildsensor 35-mm-

Vollformat
Anzahl Pixel
		  24,8 Mio. (gesamt)
Integrierte Filter

ND-Filter A

Clear 0.3 
(1/2)

0.6 
(1/4)

ND-Filter B Clear Clear 0.3 
(1/2)

0.6 
(1/4)

0.9  
(1/8)

0.9 
(1/8)

1.2 
(1/16)

1.5 
(1/32)

1.8  
(1/64)

1.8 
(1/64)

2.1 
(1/128)

2.4 
(1/256)

ISO-Empfindlichkeit
		  ISO 500 (D55-Lichtquelle)
		  ISO 2500 (D55-Lichtquelle)

Objektivfassung
		  PL-Fassung (mit 

Objektivfassungsadapter)
		  E-Fassung (ohne 

Objektivfassungsadapter)
Flanschbrennweite
		  PL-Fassung: 52 mm
		  E-Fassung: 18 mm
Dynamikumfang
		  15+ Stopps

Eingang/Ausgang

Audioeingang
		  CH-1/CH-2: 5-polige XLR-Buchse (1), 

LINE / AES/EBU / MIC / MIC+48V 
auswählbar

DC-Eingang
		  4-poliger XLR-Stecker, 11 V bis 17 V 

oder 22 V bis 32 V DC
DC-Ausgang (12 V)
		  Hirose 4-polig (1), 

11 V bis 17 V DC 
(Ausgangsspannung: wie 
Eingangsspannung, maximaler 
Ausgangsstrom: 1,0 A), 22 V bis 
32 V DC (Ausgangsspannung: 15 V, 
maximaler Ausgangsstrom: 0,8 A), 
mit Akkuadapter

[Hinweise]
ˎˎ Über den Anschluss 12V OUT können Sie ein REC-Tally-

Signal ausgeben und ein REC-Trigger-Signal einspeisen.
ˎˎ Verbinden Sie bei Eingangsspannung 11 V bis 17 V nur 

Geräte mit dem Anschluss 12V OUT, die max. 1,0 A Strom 
aufnehmen und bei Eingangsspannung 22 V bis 32 V nur 
Geräte, die max. 0,8 A Strom aufnehmen.

DC-Ausgang (24 V)
		  Fischer 3-polig (2), 

11 V bis 17 V DC 
(Ausgangsspannung: 24 V, 
maximaler Ausgangsstrom: 
1,0 A), 22 V bis 32 V DC 
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(Ausgangsspannung: wie 
Eingangsspannung, maximaler 
Ausgangsstrom: 2,0 A)

[Hinweis]
Verbinden Sie bei Eingangsspannung 11 V bis 17 V nur 
Geräte mit dem Anschluss 24V OUT, die max. 1,0 A Strom 
aufnehmen und bei Eingangsspannung 22 V bis 32 V nur 
Geräte, die max. 2,0 A Strom aufnehmen.

SDI-Ausgang Typ BNC (4)
		  3G-SDI: SMPTE ST424/425 Level B-DL/

DS
		  HD SDI: SMPTE ST292-konform
AUX
		  LEMO 5-polig (1)
Sucherausgang
		  LEMO 26-polig (1)
Netzwerk
		  Typ RJ45 (1)
Fernbedienung
		  8-polig (1)
MONITOR-Ausgang
		  Typ BNC (1)
		  HD SDI: SMPTE ST292-konform
Timecode-Eingang
		  TC IN: Typ BNC (1)
GENLOCK-Eingang
		  Typ BNC (1)
HDMI-Ausgang
		  Typ A (1)
Anschluss für externe Geräte
		  USB-Host: Typ A (1)
Kopfhörerausgang
		  Stereo-Minibuchse (1)
Lautsprecherausgang
		  Mono

Medieneinschübe

Typ		 ExpressCard/34-Einschub (2)
		  SD-Karteneinschub (1)

Mitgeliefertes Zubehör

Sucheraufsatz (1)
Griff (1)
Sucherkabel (A-2203-745-A) (1)
Distanzstück (rund) (4-730-328-11) (1)
Distanzstück (1/3 Bogen) (4-730-328-21) (15)
E-Objektivfassungsdeckel (1)
Vor Verwendung dieses Gerät (1)
Bedienungsanleitung (CD-ROM) (1)

Optionales Zubehör

Sucher 0,7 Zoll
		  DVF-EL200
Sucher 7 Zoll
		  DVF-L700
Sucherkabel zum Anbringen des DVF-L700
		  A-2201-632-A oder A-2201-633-A
Kamera-Erweiterungssystem
		  CBK-3610XS
WLAN-Adapter
		  CBK-WA02
Fernbedienung
		  RM-B170/B750
		  RCP-1000/1500/1530
		  RCP-1001/1501
Tragbarer Memory Recorder
		  AXS-R7
SxS-Speicherkarten (SxS Pro+/SxS-1)
		  SBP-64/128/256E,  

SBS-32/64/128G1C
Kartenlesegerät
		  SBAC-US30, SBAC-UT100, AXS-AR1
Schulteraufsatz (anzubringen an VCT-14 mit 

V-Schuh)
		  VCT-FSA5

Objektiv mit PL-Fassung
		  SCL-PK6/F (Fuß), SCL-PK6/M (Meter) 

(Satz mit sechs Objektiven: 20, 25, 
35, 50, 85, 135 mm), 
SCL-P11X15 (Zoom 11 mm bis 
16 mm)

Objektiv mit E-Fassung
		  SELP28135G, SEL1635GM, SEL2470GM, 

SEL70200GM, SEL100400GM, 
SEL1224G, SEL35F14Z, SEL50F14Z, 
SEL85F14GM, SEL90M28G, 
SEL100F28GM

Akku
		  BP-FL75, BP-FLX75
Netzteil
		  AC-DN2B, AC-DN10A
Mikrofon	 ECM-680S, ECM-678*, ECM-674* 

(*: Adapterkabel EC-0.5X3F5M 
von XLR 3-polig auf XLR 5-polig 
erforderlich)

Dual-Akkuadapter
		  BKW-L200 (Anschluss über 

Akkuadapter)
SDI/HDMI-Monitor
		  Modellreihe BVM, Modellreihe PVM, 

Modellreihe LMD
XQD-Speicherkarten (ExpressCard-Adapter QDA-

EX1 XQD auf SxS erforderlich)
		  QD-S64E, QD-S32E, QD-N64, QD-

M128A, QD-M64A, QD-M32A, QD-
G128A/E, QD-G64A/E, QD-G32A/E

Design und Spezifikationen können ohne 
Vorankündigung geändert werden.

Hinweise
ˎˎ Führen Sie immer eine Probeaufnahme 
aus, und bestätigen Sie, dass die Aufnahme 
erfolgreich war. SONY KANN KEINE HAFTUNG 
FÜR SCHÄDEN JEDER ART, EINSCHLIESSLICH 
ABER NICHT BEGRENZT AUF KOMPENSATION 
ODER ERSTATTUNG, AUFGRUND VON 
FEHLFUNKTION DIESES GERÄTS ODER SEINER 
DATENTRÄGER, EXTERNEN SPEICHERSYSTEMEN 
ODER JEGLICHEN ANDEREN DATENGRÄGERN 
ODER SPEICHERSYSTEMEN ZUR AUFNAHME 
VON INHALTEN JEDER ART ÜBERNEHMEN.
ˎˎ Bestätigen Sie vor dem Gebrauch immer, 
dass das Gerät richtig arbeitet. SONY KANN 
KEINE HAFTUNG FÜR SCHÄDEN JEDER ART, 
EINSCHLIESSLICH ABER NICHT BEGRENZT 
AUF KOMPENSATION ODER ERSTATTUNG, 
AUFGRUND VON VERLUST VON AKTUELLEN 
ODER ERWARTETEN PROFITEN DURCH 
FEHLFUNKTION DIESES GERÄTS ODER AUS 
JEGLICHEM ANDEREN GRUND, ENTWEDER 
WÄHREND DER GARANTIEFRIST ODER NACH 
ABLAUF DER GARANTIEFRIST, ÜBERNEHMEN.
ˎˎ SONY KANN KEINE HAFTUNG FÜR 
ANSPRÜCHE JEDER ART VON DEN BENUTZERN 
DIESES GERÄTS ODER VON DRITTER SEITE 
ÜBERNEHMEN.
ˎˎ SONY KANN KEINE HAFTUNG FÜR VERLUST, 
RETTUNG ODER WIEDERHERSTELLUNG VON 
DATEN IM INTERNEN SPEICHERSYSTEM, 
AUF AUFZEICHNUNGSMEDIEN, EXTERNEN 
SPEICHERSYSTEMEN ODER ANDEREN MEDIEN 
BZW. SPEICHERSYSTEMEN ÜBERNEHMEN.
ˎˎ SONY KANN KEINE HAFTUNG FÜR DIE 
BEENDIGUNG ODER EINSTELLUNG VON 
DIENSTLEISTUNGEN BEZÜGLICH DIESES 
GERÄTS GLEICH AUS WELCHEM GRUND 
ÜBERNEHMEN.
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Abmessungen

147

25
25
25
25
15,2

27,7

25

4,45

14

25

25

25
25
13

Ø5,2, Tiefe: 5
UNC 1/4-20, Tiefe: 10,5

2-UNC 3/8-16, 
Tiefe: 13,5

UNC 1/4-20, Tiefe: 11

2-UNC 3/8-16, Tiefe: 10,5
0,5
25
25
25

17

10-UNC 3/8-16, Tiefe: 10,7

10-UNC 1/4-20, 
Tiefe: 10,7

158

170 40

60

84

2-M3, 
Tiefe: 5

2-M3, 
Tiefe: 5

Einheit: mm

235 202

236

294

UNC 1/4-20, 
Tiefe: 9

UNC 3/8-16, 
Tiefe: 79,25

2-UNC 1/4-20

3-UNC 3/8-16

10-UNC 1/4-20, Tiefe: 11

8-M3, Tiefe: 5

252561,5

252525

16,5

120
165

2525

5024

2561,5

73

57,1 57,1

76

80 85,5

Marken

ˎˎ XAVC und  sind eingetragene Marken der 
Sony Corporation.
ˎˎ Die Begriffe HDMI und HDMI High-Definition 
Multimedia Interface sowie das HDMI-Logo sind 
Marken oder eingetragene Marken von HDMI 
Licensing Administrator, Inc. in den Vereinigten 
Staaten und anderen Ländern.
ˎˎ Alle System- und Produktnamen sind 
Handelsmarken oder eingetragene 
Handelsmarken ihrer jeweiligen Eigentümer. 
Geschützte Elemente werden in diesem 
Dokument nicht durch die Symbole ® oder ™ 
gekennzeichnet.
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